This book provides step-by-step process descriptions that explain how to use OrCAD Layout for Windows. Reference information is included in Layout's online help. Placing reference information in Layout's online help makes it possible for OrCAD to provide complete and late-breaking information to you. In addition, information is more easily accessible in online help because of its search capabilities.

So, use this User's Guide as a tool to help you become familiar with OrCAD Layout for Windows. As you have questions, or want to locate information about particular commands, tools, or dialog boxes, use Layout's online help. OrCAD thanks you, and the ancient forests thank you.
Contents

About this manual ................................................................. xi
Before you begin ................................................................ xi
Symbols and conventions ..................................................... xi
  The keyboard ................................................................ xi
  Text .............................................................................. xi

Part I OrCAD Layout for Windows—the basics

Chapter 1 The Layout design flow ....................................... 3
  Board-level schematic ..................................................... 4
  Component placement .................................................... 4
  Board routing ................................................................. 4
  Post processing ............................................................... 5
  Intertool communication ................................................ 5
  The OrCAD Layout for Windows product family............... 6
  Layout advanced features ............................................... 8
    Gridless shape-based autorouting .................................. 8
    Computer-aided manufacturing .................................... 8
    Computer-aided design ............................................... 9

Chapter 2 First things first .................................................. 11
  Starting Layout ............................................................... 11
  The Layout session frame .............................................. 11
<table>
<thead>
<tr>
<th>Chapter 3</th>
<th>Getting started</th>
<th>13</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Opening a design</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Resolving AutoECO errors</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Mounting holes disappear from the board when you run AutoECO</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Footprint pin names do not match schematic symbol pin numbers</td>
<td>17</td>
</tr>
<tr>
<td></td>
<td>Saving a design</td>
<td>20</td>
</tr>
<tr>
<td></td>
<td>Closing a design and quitting Layout</td>
<td>21</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 4</th>
<th>The Layout design environment</th>
<th>23</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The design window</td>
<td>23</td>
</tr>
<tr>
<td></td>
<td>The library manager</td>
<td>24</td>
</tr>
<tr>
<td></td>
<td>The session log</td>
<td>25</td>
</tr>
<tr>
<td></td>
<td>The toolbars</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>The session frame toolbar</td>
<td>26</td>
</tr>
<tr>
<td></td>
<td>The design toolbar</td>
<td>27</td>
</tr>
<tr>
<td></td>
<td>The status bar</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>Using help and the online tutorial</td>
<td>30</td>
</tr>
<tr>
<td></td>
<td>The spreadsheet windows</td>
<td>31</td>
</tr>
<tr>
<td></td>
<td>Editing spreadsheet information</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>The query window</td>
<td>33</td>
</tr>
<tr>
<td></td>
<td>Using query with spreadsheets</td>
<td>34</td>
</tr>
<tr>
<td></td>
<td>Pop-up menus</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>Selecting and deselecting objects</td>
<td>36</td>
</tr>
<tr>
<td></td>
<td>Editing objects</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>Undoing actions</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>Setting environment preferences</td>
<td>39</td>
</tr>
<tr>
<td></td>
<td>Using color in the graphical display of your design</td>
<td>41</td>
</tr>
</tbody>
</table>
## Part II

### Creating a printed circuit board layout

#### Chapter 5 Setting up the board

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using technology templates</td>
<td>48</td>
</tr>
<tr>
<td>Custom templates</td>
<td>48</td>
</tr>
<tr>
<td>Creating a board outline</td>
<td>51</td>
</tr>
<tr>
<td>Adding mounting holes to the board</td>
<td>52</td>
</tr>
<tr>
<td>Defining the layer stack</td>
<td>53</td>
</tr>
<tr>
<td>Selecting units of measurement</td>
<td>54</td>
</tr>
<tr>
<td>Setting system grids</td>
<td>55</td>
</tr>
<tr>
<td>Defining global space values</td>
<td>57</td>
</tr>
<tr>
<td>Defining padstacks</td>
<td>59</td>
</tr>
<tr>
<td>Defining vias</td>
<td>60</td>
</tr>
<tr>
<td>Setting net attributes</td>
<td>62</td>
</tr>
<tr>
<td>Enabling layers for routing</td>
<td>66</td>
</tr>
<tr>
<td>Setting net widths by layer</td>
<td>67</td>
</tr>
<tr>
<td>Setting connection order</td>
<td>68</td>
</tr>
<tr>
<td>Setting net spacing by layer</td>
<td>70</td>
</tr>
</tbody>
</table>

#### Chapter 6 Creating and editing obstacles

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using obstacles in Layout</td>
<td>71</td>
</tr>
<tr>
<td>Creating obstacles</td>
<td>72</td>
</tr>
<tr>
<td>Selecting obstacles</td>
<td>78</td>
</tr>
<tr>
<td>Editing obstacles</td>
<td>78</td>
</tr>
<tr>
<td>Copying obstacles</td>
<td>79</td>
</tr>
<tr>
<td>Moving obstacles</td>
<td>80</td>
</tr>
<tr>
<td>Rotating obstacles</td>
<td>80</td>
</tr>
<tr>
<td>Mirroring obstacles</td>
<td>81</td>
</tr>
<tr>
<td>Exchanging the ends of obstacles</td>
<td>81</td>
</tr>
<tr>
<td>Moving segments</td>
<td>81</td>
</tr>
<tr>
<td>Creating circular obstacles</td>
<td>82</td>
</tr>
<tr>
<td>Deleting obstacles</td>
<td>83</td>
</tr>
</tbody>
</table>

#### Chapter 7 Creating and editing text

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating labels</td>
<td>85</td>
</tr>
<tr>
<td>Moving text</td>
<td>89</td>
</tr>
<tr>
<td>Deleting text</td>
<td>89</td>
</tr>
</tbody>
</table>
Chapter 8  Placing and editing components .......................................... 91
Prepping the board for component placement ............................................. 92
  Checking the board, place, and insertion outlines ....................................... 92
  Checking the place grid ............................................................................... 94
  Checking mirror layers and library layers .................................................... 94
  Weighting and color-coding nets .................................................................. 95
  Checking gate and pin information ............................................................... 96
Securing pre-placed components on the board ............................................. 98
Creating height or group keep-ins and keep-outs ......................................... 100
Placing components manually ...................................................................... 101
  Loading a placement strategy file .................................................................. 101
  Disabling the power and ground nets ............................................................ 102
  Placing components using manual placement ............................................. 103
  Selecting the next components for placement ............................................. 105
  Placing component groups ........................................................................... 106
Using manual placement commands to optimize placement ............................ 107
  Minimizing connections ............................................................................... 107
  Copying, moving, and deleting components .................................................. 108
Swapping components .................................................................................... 108
  Rotating components .................................................................................... 109
  Mirroring components using the Opposite command .................................... 109
  Placing components using a matrix .............................................................. 110
Using circular placement ............................................................................... 112
Editing components ........................................................................................ 117
  Selecting an alternate footprint ...................................................................... 119
Adding components to the board .................................................................... 121
Running Place Design Check ......................................................................... 122
Viewing component placement statistics ...................................................... 122
### Chapter 9

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Routing the board</td>
<td>123</td>
</tr>
<tr>
<td>Preparing the board for routing</td>
<td>124</td>
</tr>
<tr>
<td>Checking the board outline</td>
<td>124</td>
</tr>
<tr>
<td>Checking via definitions</td>
<td>125</td>
</tr>
<tr>
<td>Checking the routing grid</td>
<td>125</td>
</tr>
<tr>
<td>Defining a DRC Box</td>
<td>127</td>
</tr>
<tr>
<td>Routing the board manually</td>
<td>128</td>
</tr>
<tr>
<td>Loading a routing strategy file</td>
<td>128</td>
</tr>
<tr>
<td>Routing power and ground</td>
<td>129</td>
</tr>
<tr>
<td>Using the Gridded Manual Route without shove tool</td>
<td>133</td>
</tr>
<tr>
<td>Using Manual Route in Mincon mode</td>
<td>134</td>
</tr>
<tr>
<td>Using the Gridless Route tool</td>
<td>135</td>
</tr>
<tr>
<td>Using the Curve Route tool</td>
<td>136</td>
</tr>
<tr>
<td>Creating duplicate connections</td>
<td>137</td>
</tr>
<tr>
<td>Optimizing routing using manual routing commands</td>
<td>138</td>
</tr>
<tr>
<td>Minimizing connections</td>
<td>138</td>
</tr>
<tr>
<td>Changing the colors of nets</td>
<td>138</td>
</tr>
<tr>
<td>Removing tracks</td>
<td>139</td>
</tr>
<tr>
<td>Copying tracks</td>
<td>140</td>
</tr>
<tr>
<td>Moving segments on tracks</td>
<td>140</td>
</tr>
<tr>
<td>Changing the widths of tracks</td>
<td>141</td>
</tr>
<tr>
<td>Forcing a net width on a layer</td>
<td>141</td>
</tr>
<tr>
<td>Inserting vias</td>
<td>141</td>
</tr>
<tr>
<td>Changing vias</td>
<td>142</td>
</tr>
<tr>
<td>Using tack points</td>
<td>143</td>
</tr>
<tr>
<td>Exchanging the ends of a track</td>
<td>144</td>
</tr>
<tr>
<td>Routing on the opposite layer of the board</td>
<td>144</td>
</tr>
<tr>
<td>Locking routed tracks</td>
<td>144</td>
</tr>
<tr>
<td>Creating and modifying nets</td>
<td>145</td>
</tr>
<tr>
<td>Creating nets</td>
<td>145</td>
</tr>
<tr>
<td>Splitting nets</td>
<td>145</td>
</tr>
<tr>
<td>Adding and deleting pins connected to nets</td>
<td>146</td>
</tr>
<tr>
<td>Disconnecting pins from nets</td>
<td>146</td>
</tr>
<tr>
<td>Generating test points interactively</td>
<td>147</td>
</tr>
<tr>
<td>Viewing routing statistics</td>
<td>148</td>
</tr>
</tbody>
</table>
Chapter 10  Using thermal reliefs and copper pour zones ............... 149
  Using thermal reliefs ................................................................. 149
  Defining thermal reliefs ............................................................. 150
  Previewing thermal reliefs .......................................................... 152
  Rules that apply to creating thermal reliefs ................................. 154
  Forced thermal reliefs and preferred thermal reliefs ..................... 155
  Using padstacks to create thermal reliefs ..................................... 156
  Creating copper pour zones ....................................................... 157
  Designating a seed point ........................................................... 157
  Creating a copper pour zone ..................................................... 158

Chapter 11  Ensuring manufacturability ............................................. 163
  Running Board Design Check .................................................... 163
  Running Window Design Check .................................................. 165
  Running Board Space Check ....................................................... 166
  Running Window Space Check ................................................... 166
  Running Board AutoCDE ............................................................ 167
  Running Window AutoCDE ......................................................... 167
  Running Board AutoDFM ........................................................... 168
  Investigating errors ................................................................. 169

Part III  Libraries

Chapter 12  About libraries ............................................................. 173
  Libraries ....................................................................................... 173
  Footprints ..................................................................................... 174

Chapter 13  Managing footprint libraries ......................................... 175
  Starting the library manager ......................................................... 176
  Making libraries available for use ............................................... 177
  Viewing footprints using the library manager ............................... 178
  Creating a new footprint library ................................................... 179
  Adding, copying, and deleting footprints ...................................... 180
### Chapter 14 Creating and editing footprints ........................................... 181
- Setting a grid for the footprint pins ...................................................... 181
- Creating a footprint .................................................................................. 182
  - Adding pins to a footprint ..................................................................... 183
  - Assigning padstacks to footprint pins .................................................. 185
  - Attaching obstacles to footprints and pins ............................................ 187
  - Adding labels to footprints ................................................................. 188
- Editing footprints and footprint pins ...................................................... 189
- Editing padstacks .................................................................................... 191
- Moving the insertion origin ................................................................. 193

### Part IV Post processing

### Chapter 15 Post processing ................................................................. 197
- Renaming components ................................................................................. 198
- Documenting board dimensions ............................................................... 199
- Opening the Post Process spreadsheet .................................................... 201
- Previewing layers ........................................................................................ 203
  - Moving the drill chart .......................................................................... 207
  - Restoring the original view of the design .............................................. 209
- Modifying the output .................................................................................. 210
- Running batch post processing ............................................................... 212
  - Editing apertures ................................................................................... 214
- Printing and plotting .................................................................................. 215
- Generating a drill tape ................................................................................ 216
- Generating reports ..................................................................................... 217

### Part V Using Layout with other applications

### Chapter 16 Using Layout with OrCAD Capture for Windows .............. 223
- Preparing your Capture design for use with Layout .................................. 224
- Creating a netlist in OrCAD Capture for Windows .................................... 226
- Using AutoECO .......................................................................................... 227
- Forward annotating Capture schematic data into Layout .......................... 230
- Back annotating board information to Capture from Layout ..................... 232
- Using cross probing ................................................................................... 233
  - Enabling ITC between Capture and Layout ........................................... 233
  - Cross probing from Capture to Layout .................................................. 234
  - Cross probing from Layout to Capture .................................................. 235
Chapter 17  Importing and exporting files .............................................. 237
    Netlist translators ....................................................................................... 238
        MAX ASCII files ....................................................................................... 238
        MAX ASCII file format .......................................................................... 239
        PCB II Netlist ......................................................................................... 244
        Futurenet Netlist .................................................................................... 245
        PCAD Netlist ............................................................................................. 246
    Board translators .......................................................................................... 247
        Layer mapping .......................................................................................... 247
        MAX Interchange ....................................................................................... 250
        PCB386+ ................................................................................................... 251
        CadStar ..................................................................................................... 252
        PADS ......................................................................................................... 253
        PCAD ......................................................................................................... 254
        Protel ......................................................................................................... 256
        Tango ......................................................................................................... 257
        DXF import and export ............................................................................ 258

Appendix  Understanding the files used with Layout ................................. 265
Appendix A  Understanding the files used with Layout ............................... 265
    System files .................................................................................................. 265
    Design files .................................................................................................. 267
        Board templates ....................................................................................... 267
        Technology templates ............................................................................. 267
        Netlist files .............................................................................................. 270
        MAX files ................................................................................................ 270
        Strategy files ............................................................................................ 271
    Library files .................................................................................................. 275
    Report files ................................................................................................... 275

Glossary ........................................................................................................... 277

Index ................................................................................................................. 287
About this manual

The OrCAD Layout for Windows User’s Guide is a comprehensive manual that contains all of the procedures you need for designing boards using OrCAD Layout for Windows. To help you learn and use Layout efficiently, this manual is organized by tasks, in a linear flow that mimics the board design process. Many of the skills described in this manual are also covered in the online help, and in the online tutorial, Learning Layout.

Before you begin

Before you can use Layout, you must install Microsoft Windows on your computer, then install Layout. For information on installing Windows, see your Windows documentation. To install Layout, follow the installation instructions that accompany Layout.

Symbols and conventions

OrCAD printed documentation uses a few special symbols and conventions.

The keyboard

- The keys on your keyboard may not be labeled exactly as they are in this manual. All key names are shown using small capital letters. For example, the Control key is shown as CTRL; the Escape key is shown as ESC.
- Keys are frequently used in combinations or sequences. For example, SHIFT+F1 means to hold down the SHIFT key while pressing F1. ALT, F, A, means to press and release each of these keys in order: first ALT, then F, then A.
- Arrow keys is the collective name for the UP ARROW, DOWN ARROW, LEFT ARROW, and RIGHT ARROW keys.
- To choose a command from a menu, you can use the mouse or press a key combination. For example: from the File menu, choose Open (ALT, F, O).
Text

- Specific text you are to type is shown in bold. For example, if the manual says to type \*_.max_, you type an asterisk, a period, and the lowercase letters "max." What you type is usually shown in lowercase letters, unless it must be typed in uppercase letters to work properly.

- Placeholders for items such as filenames that you must supply are shown in italic. For example, when the manual says to type \texttt{cd directory\_name}, you type the letters "cd" followed by a space and the name of a directory. For a directory named CIRCUITS, you would type \texttt{cd circuits}.

- Examples of syntax, netlist output, and source code are displayed in monospace font—for example, /N0001 U1(8) U2(1) ;.
OrCAD Layout for Windows—the basics

Part One contains the basic information you need to get started using OrCAD Layout for Windows. It explains the role of Layout in the printed circuit board (PCB) design flow, describes how to start Layout, and introduces the Layout work environment.

Part One includes these chapters:

Chapter 1: The Layout design flow describes where Layout fits into the printed circuit board design process, and introduces the Layout product family.

Chapter 2: First things first explains how to start Layout.

Chapter 3: Getting started explains how to open a board design, load a netlist, load a board template, save a board design, close the design, and quit Layout.

Chapter 4: The Layout design environment describes the things you need to know to find your way around in Layout. It describes the design window, the footprint manager, and introduces Layout’s spreadsheet windows. It also introduces the toolbar, and general Layout concepts such as selecting and editing objects, and using pop-up menus.

Part One
The Layout design flow

OrCAD Layout for Windows supports every phase of the design process. A typical printed circuit board design flow has five key phases:

1. Design creation
2. Component placement
3. Board routing
4. Post processing
5. Intertool communication

The printed circuit board design flow.
Chapter 1  The Layout design flow

Board-level schematic

Using a schematic capture tool such as OrCAD Capture for Windows, you can create a Layout-compatible netlist that includes preset design rules to guide logical placement and routing. This gives you the ability to specify critical design rules at the schematic level, such as component locations, net spacing criteria, component group information, net widths, and routing layers, and bring them into Layout in the netlist. If the schematic netlist changes, you can reload it; Layout’s AutoECO (automatic engineering change order) utility updates the board without destroying finished work.

Component placement

Whether you choose to use Layout’s manual placement tools or the interactive and autoplacement utilities (available in Layout Plus only), you have ultimate control of the component placement process. You can place components individually or in groups.

During autoplacement, Layout’s shove capability moves components out of your way automatically while adhering to design rules check (DRC) guidelines. You can autoplace components individually, by area, or you can autoplace the entire board.

For information on autoplacement, see the OrCAD Layout for Windows Autoplacement User’s Guide.

Board routing

With Layout, you can route your board manually, or you can use Layout’s interactive and automatic routing tools (not available with Layout Ltd.).

Using manual route, you guide the routing process and manually route each track. Then you optimize routing using a variety of manual routing commands.

In interactive routing, you still control the routing of individual tracks, but can take advantage of Layout’s automatic routing technologies, such as push-n-shove, which moves tracks to make space for the track you are currently routing.

If you choose to use Layout’s autorouter, you can interrupt routing at any time to manage and control the routing process. You can autoroute a single track, a selected area of the board, a group of nets, or the entire board.

For information on autorouting, see the OrCAD Layout for Windows Autorouter User’s Guide.
Chapter 1  The Layout design flow

Post processing

In Layout, all of your output settings are stored in a spreadsheet that you can recall and revise. You can give layer-by-layer instructions for writing to Gerber files, DXF files, or hardcopy devices.

You can generate a variety of reports including customized drill lists, part orders, and ECOs. Layout also produces more than twenty standard reports including fab drawings, assembly drawings, and pick and place reports.

Intertool communication

Layout has the capability to communicate interactively with OrCAD Capture for Windows using intertool communication (ITC).

You can use intertool communication to communicate updated schematic information to Layout—at any stage of the design process. Also, you can back annotate design data to Capture from Layout.

Intertool communication supports cross-probing to facilitate design analysis. If you select a signal or part in Capture or Layout, the corresponding signal or part is highlighted in the other application.
The OrCAD Layout for Windows product family

The OrCAD Layout for Windows product family provides three options to meet your individual design requirements. The table lists supported features for each product.

- OrCAD Layout Plus for Windows
- OrCAD Layout for Windows
- OrCAD Layout Ltd. for Windows

<table>
<thead>
<tr>
<th>Layout product family features</th>
<th>Layout Plus</th>
<th>Layout</th>
<th>Layout Ltd.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Placement</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Cluster placement</td>
<td></td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Density graph</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dynamic reconnect</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Automatic placement</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto-interactive placement</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Manual placement</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td>Floor planning</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
<tr>
<td><strong>Routing</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Online DRC</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>AutoDFM</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td>Manual routing</td>
<td>✔</td>
<td>✔</td>
<td>✔</td>
</tr>
<tr>
<td><strong>Shape-based, gridless routing (SmartRoute)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>30-layer autorouting</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Interactive routing</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sketch-a-route</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Angled directional routing</td>
<td>✔</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gridless push-n-shove</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Gridded routing</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>16-layer autorouting</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Interactive routing</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Single-layer autorouting</td>
<td>✔</td>
<td></td>
<td>✔</td>
</tr>
<tr>
<td>Gridded push-n-shove</td>
<td>✔</td>
<td>✔</td>
<td></td>
</tr>
</tbody>
</table>

Product family features (page 1 of 2).
<table>
<thead>
<tr>
<th><strong>Layout product family features</strong></th>
<th><strong>Layout Plus</strong></th>
<th><strong>Layout</strong></th>
<th><strong>Layout Ltd.</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Libraries</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Footprint libraries featuring more than 3000 components.</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Graphical browser</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td><strong>Post processing</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Full Gerber CAM tool</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Gerber view and plot</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Over 100 outputs</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Automatic aperture generation</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td><strong>General features</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Auto test point generation</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>AutoECO</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Intelligent copper pour</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>DXF in and out</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td>Standard Windows print driver</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td><strong>PCB translators</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PADS, PCAD, Tango, Protel, CadStar, OrCAD PCB 386+</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td><strong>Mechanical interfaces</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Visual CADD</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
<tr>
<td><strong>Schematic netlist interfaces</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>OrCAD SDT, OrCAD Capture, Futurenet, DATA I/O SCS</td>
<td>•</td>
<td>•</td>
<td>•</td>
</tr>
</tbody>
</table>

*Product family features (page 2 of 2).*
Layout advanced features

Layout includes advanced features that offer solutions for increasingly complex board design. All of these applications can be started from the Tools menu in the Layout session frame.

Gridless shape-based autorouting

Layout Plus includes a shape-based, gridless autorouter called SmartRoute. Accessible through the Layout session frame in Layout Plus only, SmartRoute features easy setup, fast routing speeds, high completion rates, and high router quality.

To start SmartRoute from Layout

➤ In the session frame, choose SmartRoute from the Tools menu.

See For information on SmartRoute, see the OrCAD Layout for Windows SmartRoute User's Guide.

Computer-aided manufacturing

Layout Plus includes GerbTool, a full-featured CAM tool including a Gerber editor that reads and writes all standard Gerber formats and IPC-350. This provides features for automatic tear-dropping, panelization, venting and thieving, and removal of unused pads and silkscreen on pads. These functions are all required for optimal manufacturability (Layout Ltd. includes Gerber plotting and viewing capabilities only).

To start GerbTool from Layout

➤ In the session frame, choose GerbTool from the Tools menu.

See For information on GerbTool, see the OrCAD Layout for Windows GerbTool User's Guide.
Computer-aided design

OrCAD Visual CADD is a complete two-dimensional drafting tool that is suitable for all your mechanical design needs. OrCAD Visual CADD facilitates design and drafting by providing tools for creating board outlines, height keep-ins and keep-outs, autorouter keep-outs, and similar objects. Using Visual CADD, you can easily draw single and double lines, circles, regular and irregular polygons and more. Full read and write capability supports DWG, DXF, and GCD files. Visual CADD is available with Layout and Layout Plus.

To start Visual CADD from Layout

👉 In the session frame, choose Visual CADD from the Tools menu.

📖 For information on Visual CADD, see the *OrCAD Layout for Windows Visual CADD User’s Guide.*
Chapter 2

First things first

This chapter describes how to start OrCAD Layout for Windows.

Starting Layout

The Layout installation process puts Layout in the Programs folder, and adds the OrCAD Design Desktop and Layout to the Programs menu.

Note If Windows is not running, type win at the DOS prompt before performing the steps below.

To start Layout.
1 From the Start menu, choose Programs. The program menu displays.
2 From the OrCAD Design Desktop, choose Layout.

The Layout session frame

Once you start Layout, you see the Layout session frame. You do all your schematic design and processing from within this window.

The Layout session frame.
The Layout session frame provides a starting point for any Layout task you want to perform. For example, you can open a board file. Or, you can access the footprint libraries for editing. You can also open OrCAD Capture for Windows, SmartRoute, GerbTool, and Visual CADD from the session frame.

Using the session frame, you can start multiple board files (except in Windows 3.1 and Windows for Workgroups) or advanced tools (GerbTool, SmartRoute, and so on). Each board file or advanced tool opens in its own window. You may open as many windows as your computer's resources allow.

**Note** If you open multiple copies of the same design, only the changes made to the last design file closed are saved.

**Note** If menu items appear dim, you may need to edit the LSESSION.INI file so that it recognizes the correct paths to translators and third-party applications. See the *Appendix A: Understanding the files used with Layout* for more information on the LSESSION.INI.
Getting started

Opening a design

You can open a new design or an existing design. When you open a new board design, Layout prompts you to choose a template and a schematic netlist. The board template provides the framework from which you can create a board design. The netlist describes the parts and interconnections of a schematic diagram.

A board template (file_name.TPL) contains a board outline and design rules from Layout’s default technology template, DEFAULT.TCH. DEFAULT.TCH, described in Appendix A: Understanding the files used with Layout, contains the following parameters, among others:

- 62 mils pads
- 12 mil tracks
- 12 mil spacing

The board templates offer nearly 70 unique board outlines. These board outlines are listed and illustrated in the OrCAD Layout for Windows Footprint Libraries manual. The board outline titles correspond to the file names of the board templates that contain them. The board templates are located in the LAYOUT/DATA directory. If you do not find the exact board outline that you need, you can choose one that is close and modify it by following the instructions in Creating a board outline in Chapter 5: Setting up the board.

See If you cannot use any of the board outlines provided by Layout, you can create your own board outline. In this case, load a technology template with a .TCH extension, instead of a board template (.TPL), when you open the new design. Then, create your own board outline by following the instructions in Creating a board outline in Chapter 5: Setting up the board. For a complete list of technology templates, see Appendix A: Understanding the files used with Layout.
If you choose to load one of the board templates (board outlines) provided with Layout, but DEFAULT.TCH is not suitable for your type of board, you can load a technology template to match the characteristics of your board, including manufacturing complexity, and component type. You load this technology template after you open the board.

See For more information about technology templates and for a complete list of the technology templates provided with Layout, see Appendix A: Understanding the files used with Layout.

Tip If you load a technology template on top of a board template, you can save it as a custom technology template for use in future designs. See Using technology templates in Chapter 5: Setting up the board for more information.

A Layout netlist file describes the interconnections of a schematic diagram using the names of the signals, components, and pins. It is a binary file and has a .MNL extension. You can create a Layout netlist directly from OrCAD Capture, or you can import Layout-supported netlists by selecting a translator that corresponds to your schematic program from the Import menu in the session frame. The translator creates the file design_name.MNL.

See For more information about file translation, see Chapter 17: Importing and exporting files.

The netlist file (.MNL) contains the following information:

- Footprint names
- Electrical packaging
- Component names
- Net names
- The component pin for each net
- Net, pin, and component attribute information

See For information on creating a board without importing a netlist, see Layout’s on-line help.

The AutoECO (Automatic Engineering Change Order) process combines the board template (.TPL) and the schematic netlist (.MNL) to produce the Layout board file. You then name the file, which has a .MAX extension and contains all of the board’s physical and electrical information.

See For more information on netlist files and board files, see Appendix A: Understanding the files used with Layout.
The diagram below illustrates the process for opening a new design.

Opening a new board design in Layout.
To open a new design

1. From the session frame’s File menu, choose New. The Load Template File dialog box displays.

2. From the Files of type drop list, select Template (*.TPL).

3. Select a board template, then choose the Open button.

   The Load Netlist source dialog box displays.

See  For a complete list of board templates and pictures of the board outlines they include, see the OrCAD Layout/or Windows Footprint Libraries.

See  If you do not want to load one of the board outlines provided with Layout, load a technology template instead (.TCR). For more information about technology templates and for a complete list of the technology templates provided with Layout, see Appendix A: Understanding the files used with Layout.

4. Select a netlist file, then choose the Open button.

   The Save MAX Board dialog box displays.

5. Supply a name for the output board file with a .MAX extension, then choose the Save button.

   AutoECO runs automatically. AutoECO either creates the board file and displays the board in the design window, or reports errors. If errors are present, AutoECO provides a dialog box so that you can interactively make corrections during AutoECO, and also creates an error file (design_name.ERR).

   Alternatively, you can choose to defer making corrections until after the AutoECO process is finished.

   The AutoECO report is saved as an ASCII report file. Any errors that occur during the data merge are reported in this file.

See  For information on resolving AutoECO errors, see Resolving AutoECO errors in this chapter.

6. View the AutoECO report by opening the report .LIS in an editor such as Notepad.

To open an existing design

1. From the session frame’s File menu, choose Open.

2. Select a .MAX file and choose the Open button.

   The design opens in the design window.
Resolving AutoECO errors

There are two common errors that can occur during the AutoECO process when opening a design.

- Mounting holes disappear from the board when you run AutoECO.
- The pin numbers from the schematic do not match the pad names in Layout.

Mounting holes disappear from the board when you run AutoECO

If an object, such as a mounting hole, is on the board but not in the schematic, specify it as non-electrical in the Edit Component dialog box. Otherwise, it may be deleted when you run AutoECO.

To define a component as non-electrical

1. Choose the Spreadsheets toolbar button.
2. Select Components from the drop list.
3. Locate and double-click on the component.
4. In the Edit Component dialog box, select the Non-Electric option and choose the OK button.

Footprint pin names do not match schematic symbol pin numbers

Pin numbers in the schematic must match the footprint pin names in the footprint library files. For example, a diode in the schematic might have pins called Anode and Cathode, while the actual footprint has corresponding pin names of Ano and Cath, or 1 and 2. These differences must be reconciled or the design will not load. To correct this situation, do one of two things.

- Change the symbol pin names in the schematic to match the footprint pin names in the Layout library.
- Change the footprint pin names in the library to match the symbol pin names.

Note When AutoECO finds errors, it creates and displays an .ERR file. To correct pin problems, you can return to Capture to change numbering, then repeat the forward annotation procedure. Or, you can edit the footprint in Layout’s footprint library, then recreate the board file. If you encounter footprint errors, first ensure that the footprint name in Capture matches that in Layout.
Each device in the schematic describes an electrical part. For example, a description could be 74LS00. Electrical parts are matched to footprints in one of three ways:

- The part contains a footprint attribute, such as DIP14, that matches a footprint found in the Layout footprint library.
- The part name 74LS00 is linked to a footprint in the SYSTEM.PRT file located in the LAYOUT\DATA subdirectory.
- The part name 74LS00 is linked to a footprint in the user-defined file USER.PRT located in the LAYOUT\DATA subdirectory.

If you are in the process of running AutoECO and it is unable to find a designated footprint, the Link Footprint to Component dialog box displays. Choose one of the options described in this section to resolve the error.

**The Link Footprint to Component dialog box**

![Link Footprint to Component dialog box](image)

**Link existing footprint to component** Displays the Select Footprint dialog box. Locate and select the desired footprint. Choose the Add button to add additional libraries to the Libraries window if necessary. Choose the OK button when you find the desired footprint.

![Select Footprint dialog box](image)
Create or modify footprint library  Opens the Library Manager. Create or modify the desired footprint libraries as described in Chapter 13: Managing footprint libraries and Chapter 14: Creating and editing footprints. Choose Exit from the File menu to exit the Library Manager and minimize the session frame to return to AutoECO.

Defer remaining edits until completion  Allows you to run AutoECO in batch mode, then check for errors at completion. To do so, choose Defer remaining edits until completion, then choose the OK button.
Chapter 3  Getting started

Saving a design

You can save a new or existing design.

To save a new design
1. From the File menu in the design window, choose Save. Since the design is new and hasn't been saved, Layout displays the Save MAX Board dialog box.
2. Enter a name for the file in the File Name text box. Indicate where you want to store the file.
3. Choose the Save button.
   The design is saved, and remains open in the design window.

To save an existing design
From the File menu in the design window, choose Save.
The design is saved and remains open in the design window.

To save a copy of a design
1. From the File menu in the design window, choose Save As.
2. Enter a new name for the file, and select a new location for the file if desired.
3. Choose the Save button.
   A copy of the design is created. The copy of the design displays in the design window and the original file is closed at remains in its original location.
Closing a design and quitting Layout

To close a design

- From the File menu in the design window, choose Exit.

When you close a design, Layout asks if you want to save your changes and then displays the session frame.

To quit Layout

- From the File menu in the session frame, choose Exit.
The Layout design environment

This chapter describes the things you need to know to find your way around in Layout. It describes the windows you will see in Layout: the design window, the library manager, the spreadsheet windows, and others. It also introduces you to the toolbar, and general Layout concepts such as selecting and editing objects and using pop-up menus.

The design window

The design window provides a graphical display of the printed circuit board, and is the primary window used when designing the board. It also provides tools—such as the tools to update components, check for design rule violations, and generate reports—to facilitate the design process. The design window appears when you open a new or existing design.
Chapter 4  The Layout design environment

The library manager

The library manager is used to view, create, and edit footprints and footprint libraries. The library manager has two windows: the library manager window and the footprint editor. The windows open simultaneously, and are tiled vertically.

In the library manager window, you can browse to select the libraries you want to modify during the current session. Once you select a library, you have access to all of the footprints in that library. Using the library manager, you can also create custom libraries, create footprints, and save new or modified footprints to the library of your choice.

The footprint editor is the primary window used when creating and editing footprints. It provides a graphical display of the footprint and is specifically tailored for the creation and modification of individual footprints.

To open the library manager

⇒ From the design window’s Tool menu, choose Library Manager.

The library manager and footprint editor.

See also  For more information on the library manager, and on footprints and footprint libraries, see Part 3: Libraries.
The session log

The session log lists all the events that have occurred in the current Layout design file. The information in the session log is useful when working with OrCAD’s technical support staff to solve technical problems.

To open the session log

1. From the design window’s File menu, choose Text Editor.
   Layout asks if you want to create a new document.
2. Choose the No button.
   The Text file dialog box displays.
3. From the Files of type drop list, select LOG files (*.LOG).
4. Open the main Layout directory.
5. Select LAYOUT.LOG and choose the Open button.
   The session log opens in the text editor window.

**Note**  You can also open LAYOUT.LOG in Windows Write or in any other text editor.

![The LAYOUT.LOG file.](image)
The toolbars

There are two toolbars in Layout: the session frame toolbar, and the design toolbar. By using the buttons on the Layout toolbars, you can quickly perform the most frequently used Layout commands.

When you move the pointer over a toolbar button, the button name displays below the pointer. Toolbar buttons are unavailable (and appear dark) when they do not apply to the current activity.

The session frame toolbar

The session frame has its own toolbar which offers a couple of basic Windows file management tools such as New and Open. The tasks that the toolbar buttons perform are described in the table below.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![File]</td>
<td>New</td>
<td>Create a new document. Similar to the New command on the File menu.</td>
</tr>
<tr>
<td>![Open]</td>
<td>Open</td>
<td>Open an existing document. Similar to the Open command on the File menu.</td>
</tr>
<tr>
<td>![Help]</td>
<td>Help</td>
<td>Access the online help. Similar to the Help Topics command on the Help menu.</td>
</tr>
</tbody>
</table>

Tools on the session frame toolbar.
## The design toolbar

The following table describes the tools on the toolbar that displays in the design window and in the library manager.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Library Manager" /></td>
<td>Library Manager</td>
<td>Open the library manager and footprint editor. Equivalent to the Library Manager command on the Tool menu in the design window.</td>
</tr>
<tr>
<td><img src="image.png" alt="Design Rules Check" /></td>
<td>Design Rules Check</td>
<td>Enable online design rules checking for interactive routing or component editing. Equivalent to the DRC Enabled command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image.png" alt="Instantaneous reconnect" /></td>
<td>Instantaneous reconnect</td>
<td>Enable the instantaneous reconnect environment (Layout Plus only). Equivalent to the Reconn Enabled command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image.png" alt="Allow component edits on board" /></td>
<td>Allow component edits on board</td>
<td>Edit components in the design window (on the board) without opening the library manager. You can edit obstacles and pins attached to separate components.</td>
</tr>
<tr>
<td><img src="image.png" alt="Component Tool" /></td>
<td>Component Tool</td>
<td>Insert, move, edit, or delete components in the design. Equivalent to the Component command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image.png" alt="Create and Modify Nets Tool" /></td>
<td>Create and Modify Nets Tool</td>
<td>Insert or delete connections or disconnect pins in the design. Equivalent to the Modify/Create Nets command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image.png" alt="Pin Tool" /></td>
<td>Pin Tool</td>
<td>Insert, move, edit, or delete pins in the design. Equivalent to the Pin command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image.png" alt="Obstacle Tool" /></td>
<td>Obstacle Tool</td>
<td>Insert, move, edit, or delete obstacles such as electrical copper or lines. Equivalent to the Obstacle command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image.png" alt="Text Tool" /></td>
<td>Text Tool</td>
<td>Insert, move, edit, or delete text. Equivalent to the Text command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image.png" alt="Error Tool" /></td>
<td>Error Tool</td>
<td>Find and query spacing and design rule violations. Equivalent to the Error command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image.png" alt="Auto Path" /></td>
<td>Auto Path</td>
<td>Route automatically using the shove algorithm while placing vias manually (not available in Layout Ltd.). Equivalent to the Auto Path command on the Tool menu.</td>
</tr>
</tbody>
</table>

*Tools on the design toolbar (page 1 of 3):*
### Chapter 4  The Layout design environment

<table>
<thead>
<tr>
<th><strong>Tool</strong></th>
<th><strong>Name</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Manual Route with Shove" /></td>
<td>Manual Route with Shove</td>
<td>Route interactively using the shove algorithm. Equivalent to the Shove Route command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image" alt="Manual Route" /></td>
<td>Manual Route</td>
<td>Route interactively without using the shove algorithm. Enable DRC to avoid errors. Equivalent to the Manual Route command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image" alt="Initialize Color" /></td>
<td>Initialize Color</td>
<td>Change or check the color of a layer and the objects on that layer. Or, make a layer (and objects) visible or invisible. Equivalent to the Init Color command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image" alt="Initialize Query" /></td>
<td>Initialize Query</td>
<td>View an object’s attributes or display an editor for modifying the object’s attributes using hyperlinks. Equivalent to the Init Query command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image" alt="Spreadsheet Tool" /></td>
<td>Spreadsheet Tool</td>
<td>List and access the available spreadsheets. Similar to the Database Spreadsheets command on the Tool menu.</td>
</tr>
<tr>
<td><img src="image" alt="Post Processing" /></td>
<td>Post Processing</td>
<td>List and access the post processing options, such as generating reports, creating a drill tape, and creating a post processing file.</td>
</tr>
<tr>
<td><img src="image" alt="Refresh Copper Pour" /></td>
<td>Refresh Copper Pour</td>
<td>Recalculate the copper pour based on changes you have made to the board since the last copper pour operation.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom In" /></td>
<td>Zoom In</td>
<td>Magnify selected areas of the board on the screen. Equivalent to the Zoom In command on the View menu.</td>
</tr>
<tr>
<td><img src="image" alt="Zoom Out" /></td>
<td>Zoom Out</td>
<td>Decrease the size of the graphical display of the board. Equivalent to the Zoom Out command on the View menu.</td>
</tr>
<tr>
<td><img src="image" alt="View whole board" /></td>
<td>View whole board</td>
<td>Zoom out to see the entire board on the screen. Equivalent to the Zoom Fit command on the View menu.</td>
</tr>
<tr>
<td><img src="image" alt="Find" /></td>
<td>Find</td>
<td>Find coordinates or components by name.</td>
</tr>
</tbody>
</table>

*Tools on the design toolbar (page 2 of 3).*
Chapter 4  The Layout design environment

<table>
<thead>
<tr>
<th>Tool</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mod</td>
<td>Modify</td>
<td>Display an editor that allows you to modify a selected item.</td>
</tr>
<tr>
<td>Ins</td>
<td>Insert</td>
<td>Copy a selected item.</td>
</tr>
<tr>
<td>Del</td>
<td>Delete</td>
<td>Delete a selected item.</td>
</tr>
</tbody>
</table>

Tools on the design toolbar (page 3 of 3).

**Viewing the current coordinates**

The X and Y coordinates corresponding to the location of the cursor are shown directly below the toolbar buttons. The value reflects the units of measurement you specify in the Display Units dialog box, accessed by choosing Units from the Options menu in the design window.

**Viewing the current grid**

The current grid spacing displays directly below the toolbar buttons. The value reflects the units of measurement you specify in the Display Units dialog box, accessed by choosing Units from the Options menu in the design window.

**Viewing the current layer**

The active board layer and its color are shown directly below the toolbar buttons in the layer drop list. You can change layers by choosing one from the list.

**Using the postage stamp view**

A miniature outline of the board is shown on the far right of the toolbar. You can use this to determine what your current view is in relation to the entire board. You can change the view by moving your cursor into the postage stamp view and clicking on a different area, or by pressing the left mouse button and drawing a window encompassing the area you want to view.
Chapter 4  The Layout design environment

The status bar

The status bar is located at the bottom of the design window. It displays the cursor coordinates and system memory. When a component, obstacle, pin, track, or text is selected, the status bar displays its name and type. As you move the selected object, the status bar interactively displays its location (X, Y), its distance from its original location, and any other relevant information such as its angle.

Using help and the online tutorial

Layout’s context-sensitive online help is designed to complement this manual, and contains additional information that will help you become familiar with Layout. You can access help from in the OrCAD Design Desktop, from the Help menu in the session frame, from the Help menu in the design window, from any dialog box, or by pressing F1.

Topics include:
- Detailed dialog box descriptions
- Third-party support information

Layout’s online tutorial, Learning Layout, takes you through a series of self-paced, interactive lessons. You can practice what you’ve learned by doing the tutorial’s specially-designed exercises.
Chapter 4  The Layout design environment

The spreadsheet windows

Layout features a variety of spreadsheet windows that you can use to view and edit board information. To access most spreadsheets, choose the spreadsheet toolbar button and select a spreadsheet from the ensuing drop list.

Statistics  Use the Statistics spreadsheet to view general information about the design, including place and route data.

Layers  Use the Layers spreadsheet to view, add, disable, or modify the board layers.

Padstacks  Use the Padstacks spreadsheet to view and edit the location, type, and size of pads.

Footprints  Use the Footprints spreadsheet to view, access, and edit the library of physical parts used in the design.

Packages  Use the Packages spreadsheet to view and edit the logical pin and gate information for pin and gate swapping.

Components  Use the Components spreadsheet to view and edit the component footprint, package name, location, rotation, routing status, and group.

Nets  Use the Nets spreadsheet to set net attributes such as width, route enabling, and shove. These parameters affect both manual and automatic routing.

Obstacles  Use the Obstacles spreadsheet to view and edit the obstacles you create, including assembly drawings, silkscreens, copper pour zones, and board outlines.

Text  Use the Text spreadsheet to access and edit board text.

Error Markers  Use the Error Markers spreadsheet to view error types and error marker locations.
Chapter 4  The Layout design environment

Drill Chart   Use the Drill Chart spreadsheet to access and edit information about drill locations, symbols, and tolerance.

Apertures    Use the Apertures spreadsheet to view the aperture list generated for your design during the batch process.

Color        Use the Color spreadsheet to change the color of a layer or objects, or to make a layer visible or invisible. Access the color spreadsheet by choosing the Initialize Color toolbar button.

Post Process Use the Post Process spreadsheet to access and edit the post process setup file. Access the post process spreadsheet by choosing the Post Process toolbar button (Post Proc.) and selecting Setup Batch from the drop list.

Strategy spreadsheets  By editing the parameters in these spreadsheets, you can create new strategy files (.SF) and edit the existing strategy files that guide automatic placement and routing.

See  For information on strategy files, see Appendix A: Understanding the files used with Layout.

Editing spreadsheet information

Layout's spreadsheets not only visually and structurally organize the multitude of information and elements that comprise your board design, they also provide a means for editing board data.

There are two ways to edit board data using the spreadsheets. You can access dialog box editors by double-clicking on spreadsheet data. Also, you can access a pop-up menu by pressing the right mouse button in an active spreadsheet window.

To edit spreadsheet data

1  Choose the spreadsheets toolbar button.

2  From the drop list, select the spreadsheet you want to open, and choose the OK button. The spreadsheet displays. You can perform the following operations from within the spreadsheet:

   ▪ Double-click in a cell to open a dialog box with the cell’s information highlighted and other information unavailable for selection (dim).

   ▪ Double-click in a column heading to open an editor dialog box with the column’s information highlighted and other information unavailable for selection (dim).

   ▪ Double-click in the first cell of a row to open an editor dialog box with all of the editable options for that row highlighted.

   ▪ Double-click in the first column’s heading to open an editor dialog box with all of the editable options for all of the rows of the spreadsheet highlighted.

   ▪ From within the spreadsheet, press the right mouse button to display the specialized pop-up menu and choose one of the commands.
Chapter 4  The Layout design environment

The query window

The query window provides instantaneous, detailed, editable data for an object selected in either a graphical or spreadsheet view.

When you click on an item within quotation marks, information about that item displays in the query window and the item is also highlighted on the graphical display of the board. By placing the query cursor (shaped like a Q) in the query window and pressing the ENTER key, an appropriate edit dialog box displays, so that you can edit data during the design process without having to open a spreadsheet.

To use the query window

1  From the Tool menu, choose Init Query.
   or
   Choose the Initialize Query toolbar button.
   An empty query window displays.

2  Select an object.

   The information about the selected object displays in the query window and the object is highlighted on the graphical display of the board. You can access additional information on any item within quotation marks.

3  Click on any item within quotation marks.

   The information about the item displays in the query window and the object is highlighted in the graphical display of your printed circuit board.

4  Click on the X and Y coordinates given in the query window.

   The location is highlighted in the graphical display of your printed circuit board.

5  To find an object by name, press the TAB key while your cursor is in the query window.

   The Find and Select Item dialog box displays.

6  Enter the name of an object, then choose the OK button.

   The information about the selected object displays in the query window and the object is highlighted in the graphical display of your printed circuit board.
Using query with spreadsheets

If you open a spreadsheet and choose Refresh Hot Link from its pop-up menu, any objects in the spreadsheet that are related to the object visible in the query window are highlighted. For instance, if the net GND is visible in the query window, the net GND is highlighted in the spreadsheet, and the components attached to GND are displayed in the Components spreadsheet.

See also For more information on hot links, see the topics Append Hot Link command and Refresh Hot Link command in Layout’s online help.
Pop-up menus

In Layout, you can access pop-up menus from the graphical display and in the spreadsheet windows. The pop-up menus offer critical creating, copying, and editing commands.

In the graphical windows, the pop-up menus are unique to each tool. For example, if you choose the Component tool, you can access a pop-up menu with commands such as Select Criteria, Next Comp, and Mincon. But, if you choose the Modify/Create Nets tool, you can access a pop-up menu with commands such as Add Connection to Netlist and Disconnect Pin from Netlist. Each spreadsheet window also displays a unique pop-up menu.

You display pop-up menus by pressing the right mouse button.

To access pop-up menus

Press the right mouse button.
Selecting and deselecting objects

Once you select an object, you can perform many operations on it, including moving, copying, mirroring, rotating, or editing. You can also select multiple objects. Selecting multiple objects is a convenient way to maintain the relationship among several objects while you move them to another location.

This section describes the different ways to select individual objects and groups of objects. These selection methods work both in the design window and footprint editor.

There are two selection modes available in Layout: Auto Select (or *modeless*) and tool-specific selection. When the Auto Select capability is enabled in the User Preferences dialog box, Layout selects objects without regard to the *active* tool. The active tool is the tool that you last selected for use, either by choosing it from the toolbar, or by choosing it from the Tool menu in the design window. For example, if you choose the Component tool from the toolbar or from the Tool menu in the design window, it is the active tool.

If you have trouble picking up an object using Auto Select, it may be too close to surrounding objects. In this case, choose the appropriate tool before selecting the object. After selecting the object, you automatically return to Auto Select if it is enabled in the User Preferences dialog box. If you pick up the correct object, but on the wrong layer, type the layer number hotkey for the appropriate layer.

See For information on the Layout hotkeys, see the OrCAD Layout for Windows Getting Started Guide.

When Auto Select is disabled, you must choose the appropriate tool in order to select a given object. For example, to select a component, you must first choose the Component tool, to select a pin, you must choose the Pin tool, and so on. This mode of selection is very useful if the board is dense and you have trouble isolating an object for auto selection. You can choose a tool from the toolbar or from the Tool menu.

You can enable or disable Auto Select in the User Preferences dialog box.

See For information on setting user preferences, Setting environment preferences in this chapter.

Note Area selection, object insertion and deletion, and all other editing functions are tool dependent. For example, if you want to insert a component, you must first choose the Component tool.
Chapter 4  The Layout design environment

To select an object in Auto Select mode

1. Click on the object with the left mouse button.

   or

2. To select multiple objects, click on each object with the left mouse button while pressing the CTRL key.

   Tip  In the design window pins and error markers are not modeless (they cannot be selected using Auto Select). Hence, when selecting pins and error markers in the design window, you must choose the pin or error tool first. Modeless selection will be reinstated as soon as you select another object.

   However, in the footprint editor, pins are modeless and components are not. This is because, in general, you select a pin in the footprint library, not an entire footprint. Choose the Component tool to select an entire footprint in the footprint editor.

To select an object in tool mode

1. Depending on what type of object you want to select (component, pin, obstacle, etc.), choose the appropriate tool from the toolbar or Tool menu.

2. Position the pointer on the object. Press the CTRL key and click the left mouse button.

   or

   To select multiple objects, click on each object with the left mouse button while pressing the CTRL key.

   or

   To select all objects in an area, press and hold the left mouse button while you drag the mouse, drawing a rectangle around the object or objects to select. Release the left mouse button.

   Selected objects display in the highlight color specified in the Color spreadsheet.

   Tip  If you want to select an object without moving it, select it by pressing the CTRL key and clicking on it with the left mouse button. When you select an object with the sole purpose of moving it, select it by clicking the left mouse button only (but do not press the CTRL key).

To deselect objects

1. Press the ESC key.

   or

   Click on an area where there are no objects or parts.
Editing objects

Each object has a set of properties, and you can edit the value associated with each property. Editing attributes can affect the appearance and function of the object.

To edit objects in Layout

1. Select the object.
2. Double-click on the object on the graphical display.
   or
   Open the appropriate spreadsheet and double-click on the item in the spreadsheet.
   or
   Choose the Modify command from the object’s pop-up menu.
   or
   Press the ENTER key.

Undoing actions

With tools such as the Component tool, Obstacle tool, Create/Modify Net tool, Pin tool and others, the Undo command is available on both the Edit menu, and the pop-up menu. The Undo command returns the board design to the state that existed before the last action was executed.

To undo the last action

⇒ Choose Undo from the pop-up menu.
   or
   Choose Undo from the Edit menu.
Setting environment preferences

In Layout, you can edit predetermined default settings that affect your design environment. You can specify how you want to select objects, and can set preferences for the appearance of pads and tracks on the board.

To set user preferences

1. From the Options menu, choose User Preferences. The User Preferences dialog box displays.
2. Edit the options to reflect your preferences and requirements.
3. Choose the Save button to apply these settings to future Layout sessions.
4. Choose the OK button to close the User Preferences dialog box.

User Preferences dialog box

Toolbar
Selecting the Small icons option displays the toolbar in low resolution (VGA or 800x600). Selecting the Large icons option displays the toolbar in high resolution (1020x780 or higher).

Manual Route Default Mode
Determines the behavior of the Manual Route tools.

- **Vertex Mode** creates a vertex when you click on the track with the left mouse button.
- **Reroute Mode** allows the possibility of rerouting.
Segment Mode selects a segment instead of creating a vertex.

Mincon Mode calculates the minimum length of connections as you route the board.

Show Tooltips Selecting this option displays tool descriptions when you pass your cursor over toolbar buttons. It also enables the use of pop-up dialog boxes as error indicators. If you do not select this option, Layout uses beeps to indicate errors and displays the errors in the status bar.

Fast Fill Copper Pour Reduces the drawing time for copper pour after you have made board modifications, using a simple pattern to represent copper pour on your screen. This option only affects the display of the copper pour on the screen; it does not accelerate the actual pour process.

Hollow Pads Reduces the drawing time for solid pads by using hollow squares or circles to represent the pads.

3D Effects Displays a three-dimensional image representing a component’s height on your screen, and indicates the height on the image (Layout Plus only).

Auto Select Tool Enables modeless selection. In modeless selection, you can select any object without having to choose the appropriate tool type first.

Auto Pan When this option is selected, if you place the mouse pointer at the window edge for a little under one second, the system automatically pans in the direction of the pointer. The pointer and any objects you may be dragging move to the middle of the screen after panning.

Opaque Graphics When selected, tracks and other objects on the screen are solid. That is, you cannot discern what, if anything, is under them. When this option is not selected, tracks and other objects on the screen are translucent and you can see the tracks and objects beneath them.

Minimum True Width Reduces the redraw time for wide tracks by using a minimum width to represent the tracks. That is, Layout only draws tracks wider than the setting for minimum true width as actual size; it draws all other tracks as a single pixel line.

Save Saves the settings in your local directory. The next Layout session uses these settings.
Using color in the graphical display of your design

Layout assigns a default color for each layer. Color is important to the visibility of objects on the board. Use the Color spreadsheet to access and edit the colors used in the graphical display of your design and to make layers visible or invisible.

Layer 0 is assigned to objects that exist on all layers, such as the board outline.

Tip You can save a color scheme as a strategy file for use with future designs. To do so, define the colors using the instructions in this chapter, and then choose Save Strategy from the design window’s file menu.

See Layout uses a different process for specifying the colors you want to use for preview and output. For information on using color during post processing, see Previewing layers in Chapter 15: Post processing.

To access the Color spreadsheet

Choose the Color button on the toolbar.

Layout displays the Color spreadsheet.

![Color spreadsheet]

The Color spreadsheet.

Note Hatched lines on the Color spreadsheet indicate that a layer and the objects on that layer are currently invisible.
To change the color of an object or layer
1 Select an item in the spreadsheet.
2 From the pop-up menu, select a new color for the item.

Or
1 Select an item in the spreadsheet, and from the pop-up menu, choose Modify.
   The Color dialog box displays.
2 Select a color.
   or
   Choose the Define Custom Colors button to create a custom color.
3 Choose the OK button.

To make a layer visible or invisible
1 Select an item in the spreadsheet.
2 From the pop-up menu, choose the toggling Invisible command.
   Hatched lines indicate that an object or layer is invisible, solid color indicates
   that it is visible.
To add a layer or object to the color spreadsheet

1. While the Color spreadsheet is displayed, press the INSERT key.

   Layout displays the Add Color Rule dialog box.

   ![Add Color Rule dialog box](image)

   **Add Color Rule dialog box.**

   2. Select the item that you want to add and specify the layer that the item is on in the Layer text box.

   or

   To add a layer, select the Default options and type the layer name in the text box.

   3. Choose the OK button.

To delete an object or layer from the Color spreadsheet

- Select the color or object in the Color spreadsheet and press the DELETE key.

   The layer or object no longer displays in the design window.
Creating a printed circuit board layout

Part Two describes the board creation process, including setting up the board, creating obstacles such as silkscreen and assembly drawings, creating text, placing components, routing the board, using thermal reliefs and copper pour zones, and ensuring manufacturability.

Part Two includes these chapters:

Chapter 5: Setting up your board describes how to set up a new board design.

Chapter 6: Creating and editing obstacles describes how to create obstacles for footprint libraries and boards. In Layout, you use obstacles to create a variety of design tools and accessories, including board outlines, place outlines, group and height keep-ins and keep-outs, and copper zones.

Chapter 7: Creating and editing text explains how to use text in Layout.

Chapter 8: Placing and editing components explains how to place components on the board using Layout’s manual place tools.

Chapter 9: Routing the board explains how to use Layout’s manual route tools to route the board.

Chapter 10: Using thermal reliefs and copper pour zones describes how to use thermal reliefs and copper pour zones in Layout.

Chapter 11: Ensuring manufacturability explains how to use Layout’s design rules and manufacturability checks to test the integrity of the board.
In Layout, you should set up the board before you begin placing components. This chapter explains how set up the board by combining a board template or a technology template with other Layout commands and processes. Following the instructions throughout this chapter will help to ensure the successful outcome of the board design. The steps involved in the board set up process are listed below, but not all of them are necessary for every user.

- Load a technology template
- Create or modify the board outline
- Add mounting holes
- Define the layer stack
- Select the units of measurement
- Set system grids
- Set spacing rules
- Define padstacks
- Define vias
- Set net attributes
Using technology templates

A technology template provides design rules for use with the current project, and if practical, for reuse with future projects. Most importantly, you can use technology templates to specify the manufacturing complexity of the design, and to define the component type used predominantly on the board. Technology templates can also include the layer structure, grid settings, spacing instructions, and a variety of other board criteria.

When opening a new design, Layout asks you to load a template. As discussed in Chapter 3: Getting started, board templates combine a board outline and possible mounting holes, edge connectors, and other physical board objects all merged with Layout’s default technology template, DEFAULT.TCH. If the design rules included in DEFAULT.TCH do not meet the requirements of your board, you need to load a new technology template after opening the design. For example, you can load a board template (board outline+DEFAULT.TCH) when you create a new board, and then later you can load the 2BET_SMT.TCH technology template to account for the type of components and spacing requirements of your board.

See When you load a new technology template, some existing board data is overwritten, and some is ignored. For a list of exactly what is overwritten and what is ignored, see Technology files in Appendix A: Understanding the files used with Layout.

To load a technology template

1 Choose Load Template File from the File menu.
2 Select a technology template (file_name.TCH) from the list and choose the Open button.

See For a detailed description of technology templates, and for a complete list of the technology templates included with Layout, see Appendix A: Understanding the files used with Layout.

Custom templates

You can create custom templates for reuse with future designs. It is easiest to create a custom template by modifying an existing board template and saving it under a new name, but you can also start with an empty board file. You can use your custom template with any Layout board design.

There are a couple of scenarios in which custom templates are useful. For instance, you may want to use a board outline provided with Layout, but you may need more from the technology template than DEFAULT.TCH can offer. In this case, open the board template that includes the board outline you want. Then, load the technology file of your choice, and if necessary, set up other board criteria such as layers or grids as described throughout this chapter. Then, save the file as a board template (new_name.TPL) using the Save As command.
You may also want to create a custom template if you are creating your own board outline. If you know that you will use the board outline in future designs, you can create a custom template that incorporates the outline and any other design rules you use often.

**To create a custom template using one of Layout's board outlines**

1. In the session frame, choose Open from the File menu.
2. Open the DATA directory.
3. From the Files of type drop list, select Template (*.tpl).
4. Select the board template that includes the board outline you desire, then choose the Open button.
5. Choose Load Template File from the File menu. The Load Template File dialog box displays.
6. Select a technology template and choose the Open button.
7. Define other board criteria as desired using the processes in this chapter.
8. Choose Save As from the File menu.
9. From the Save as type drop list, select Template (*.tpl).
10. Enter a name for the template in the File name text box.
11. Locate the directory in which you wish to save the template and press the Save button.

**To create a custom template using your own board outline**

1. In the Layout session frame, choose New from the File menu.
2. In the Load Template File dialog box, choose the Cancel button. An empty board opens in the design window.
3. Choose Zoom Fit from the View menu.
4. Create a board outline by following the instructions in *Creating a board outline* in this chapter.
5. Choose Load Template File from the File menu.
6. From the Files of type drop list, select Technology (*.tch).
7. Select the technology template you would like to save with the new board outline and choose the Open button. Layout loads the technology file.
8. Choose Save As from the File menu.
9. From the Save as type drop list, select Template (*.tpl).
Chapter 5  Setting up the board

10 Enter a name for the template in the File name text box.
11 Locate the directory in which you wish to save the template and press the Save button.

To create a custom template from an existing design
1 Remove all components except the ones that you want to reuse, such as mounting holes, pre-placed connectors, and so on.
2 Delete all nets.
3 Choose Save As from the File menu.
4 From the Save as type drop list, select Template (*.tpl).
5 Name the template and locate the target directory.
6 Choose the Save button.
Creating a board outline

The board outline defines the boundary of the board. The board outline may be included in the board template that you loaded. You can create a custom board outline, or modify the existing board outline using the Obstacle tool and the Edit Obstacle dialog box. After creating the board outline, you can save it to a template for use in future designs.

To create a board outline

1. Choose the Obstacle toolbar button.  
   or  
   Choose Obstacle from the Tool menu.
2. Choose Zoom Out from the View menu and click on the screen until you can view the entire board. Press the ESC key to exit zoom mode.
3. Press the INSERT key. The cursor changes from a large cross (idle mode) to a small cross (active mode). Locate the point from which you want to start drawing the outline. There are three ways to move the cursor to this point: you can move the mouse, you can use the arrow keys, or you can press the TAB key to go to the desired X, Y coordinates. Click the left mouse button once on the screen. You will begin drawing from that point.
4. Double-click the left mouse button on the screen. The Edit Obstacle dialog box displays.
5. From the Obstacle Type drop list, select Board outline.
6. In the Width text field, enter the desired value.
7. From the Obstacle layer drop list, select Global Layer (all layers).
8. Choose the OK button to accept the settings and close the Edit Obstacle dialog box.
9. Move from the starting coordinates to the desired location of the first corner. Click the left mouse button or press the SPACEBAR to insert the corner. Move to the desired location of the next corner, insert the corner, and so on.

Note When you are creating a board outline, Layout automatically begins forming a closed area after you insert the first corner.

10. When you complete the third corner, choose Finish from the pop-up menu. Layout automatically completes the board outline.

See You may want to create arcs for your board outline. For information on creating arcs for board outlines and other obstacles, see Creating arcs in Chapter 6: Creating and editing obstacles.
Adding mounting holes to the board

If desired, you can add mounting holes to your board and can save them as part of a template. Once you add the mounting holes to the board, define them as non-electrical in order to use them as part of a template.

To add mounting holes to your board

1. Choose the Component tool.
   or
   Choose Component from the Tool menu.
2. Choose Insert from the pop-up menu. The Add Component dialog box displays.
3. Select the Footprint button. The Select Footprint dialog box displays.
4. In the Libraries window, select SHEET23.LLB. Use the Add button if necessary to add this library to the list of available libraries. SHEET23.LLB should be located in the LIBRARY directory.

   See For more information on selecting footprints and making libraries available to Layout, see Part 3: Libraries.

5. In the Footprints window, select a mounting hole. We provide three for you: MTHOLE1, MTHOLE2, and MTHOLE3. Choose the OK button.
6. In the Add Component dialog box, select the Non-Electric option in the Component flags dialog box and choose the OK button. The mounting hole is attached to your cursor.
7. Place the mounting hole in the desired location by clicking the left mouse button.
Defining the layer stack

Using the Layers spreadsheets, you can define the layer stack for your design, including designating copper layers, plane layers, and spare layers. Typically, changes to the layer stack involve adding documentation layers or voltage and GND planes. After defining the layer stack, you can save the information to a template for use in future designs.

To define the layer stack for your design

1. From the spreadsheets toolbar button, choose Layers.

The Layers spreadsheet displays.

2. Review the type assignment for each layer and double-click in the Name column of the layers you want to modify.

3. In the Layer Type group box, select the desired option.

4. Choose the OK button to close the Edit Layer dialog box.

Note: Do not “delete” layers from the spreadsheet. To disable layers, specify them as "Unused Routing" in the Edit Layer dialog box.
Selecting units of measurement

In Layout, it is possible to select one of several unit values for the design. Using the Display Units dialog box, you can select between metric and inch units for the design file. You can display numeric data in mils, inches, microns, millimeters, or centimeters. These values can be changed at any time. For example, you can route the board in inches or mils and then confirm pad locations within footprints in millimeters. After selecting units of measurement, you can save the information in a template.

The Precision option determines the accuracy to which Layout reports all of the coordinates of the system, such as the X, Y coordinates that display on the toolbar, and the net widths in the Nets spreadsheet.

**To select measurement units**

1. From the Options menu, choose Units. The Display Units dialog box displays.
2. Select the base unit.
3. In the Precision text box, edit the value to specify the degree of accuracy you want Layout to support in all system coordinates.
4. Select the Convert database option to convert the design from metric units to inches or visa versa.

**Caution** Use caution when executing the Convert database command on existing boards as it can potentially corrupt a design. If you convert the design from metric (fine) to inches (course), Layout rounds off the unit value. If you convert the same design back to metric, only the estimated values are supported; the original metric values are lost.

**Note** If you are designing a board that is using metric units, you should load the METRIC.TCH technology template to achieve the best precision. See *Using technology templates* in this chapter.
Setting system grids

Layout has five distinct grid settings, all of which are set in the System Grids dialog box. In addition, you can set the rotation angles and routing parameters in the System Grids dialog box. To display the System Grids dialog box, choose the Grid command from the Options menu.

The grid values are measured in user-specified units (usually mils) that you set in the Units dialog box. If you want to include fractions in your grid values, enter a space character following the integer and use the forward slash as the division sign, for example, 8 1/2. You can also use decimals for rational numbers.

The grid values that you assign determine the resolution of the pointer location coordinates given in the lower left corner of the design window. For example, if the Obstacle tool is selected in the design window and the Place grid is set to 100 mils, the coordinates that display are accurate to 100 mils.

Once you set system grids for your design, you can save the information in a template.

To set system grids

1. Choose Grid from the options menu.
   The System Grids dialog box displays.

2. Set the grids for the Layout board file.

3. Choose the OK button to accept the settings and close the dialog box.
Chapter 5  Setting up the board

The System Grids dialog box

<table>
<thead>
<tr>
<th>System Grids</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Routing Parameters</strong></td>
</tr>
<tr>
<td>Routing grid:</td>
</tr>
<tr>
<td>Via grid:</td>
</tr>
<tr>
<td><strong>Allow off-grid routing</strong></td>
</tr>
<tr>
<td><strong>Use all via types</strong></td>
</tr>
<tr>
<td><strong>Unrestricted via spacing</strong></td>
</tr>
<tr>
<td><strong>Shove components</strong></td>
</tr>
<tr>
<td><strong>Dot grid [X,Y]</strong></td>
</tr>
<tr>
<td><strong>Place grid [X,Y]</strong></td>
</tr>
<tr>
<td><strong>Detail grid [X,Y]</strong></td>
</tr>
<tr>
<td><strong>Increment</strong></td>
</tr>
<tr>
<td><strong>Snap</strong></td>
</tr>
</tbody>
</table>

**Routing grid**  Assigns the grid used for routing.

**Via grid**  Assigns the grid upon which you or the router can place vias.

**Allow off-grid routing**  When enabled, the router can place tracks off grid if needed to route a pad off-grid.

**Use all via types**  When enabled, the router can use any of the vias defined in the Padstack spreadsheet.

**Unrestricted Via Spacing**  When enabled, you or the router can place a via closer to a pad of the same net than the via-to-pad spacing specified in the Edit Spacing dialog box. With this option enabled, the via can be placed contiguous to or on top of the pad; it is recommended that you manually check the spacing of vias.

**Shove components**  If enabled, the router is allowed to shove components in order to efficiently route a track (Layout and Layout Plus only).

**Dot grid**  Assigns the grid for the visible grid dots.

**Place grid**  Assigns the component placement grid. For greatest routing efficiency, this value needs to be a multiple of the routing grid. The datum, or origin, of footprints are constrained to this grid.

**Detail grid**  Assigns the grid for obstacles and text objects.

**Increment**  Assigns rotation increment (up to one minute of resolution).

**Snap grid**  Assigns the very finest rotation increment for use when the Place grid value and the Increment value are very small, This is especially useful on a round board for precise angular placement of components.
Defining global space values

Global space values set rules for spacing between the various objects on the board. You can define global space values for the design using the Route Spacing spreadsheet and the Edit Spacing dialog box. You can save spacing requirements to a template.

To define global space values
1. Choose the spreadsheets toolbar button.
2. Choose Strategy and Route Spacing from the drop list.
   The Route Spacing spreadsheet displays.

   ![Route Spacing Spreadsheet]

3. Double-click on the layer for which you want to modify spacing.
   The Edit Spacing dialog box displays. If you double-click in a value column, for example, Track to Track, the dialog box displays with only the Track to Track option enabled. If you double-click on the Layer Name title cell, you can set the spacing for all values on all layers of the board.
4. Choose the OK button to accept the settings and close the dialog box.
Chapter 5  Setting up the board

The Edit Spacing dialog box

<table>
<thead>
<tr>
<th>Edit Spacing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Layer &quot;TOP&quot;</td>
</tr>
<tr>
<td>Track to Track Spacing</td>
</tr>
<tr>
<td>Track to Via Spacing</td>
</tr>
<tr>
<td>Track to Pad Spacing</td>
</tr>
<tr>
<td>Via to Via Spacing</td>
</tr>
<tr>
<td>Via to Pad Spacing</td>
</tr>
<tr>
<td>Pad to Pad Spacing</td>
</tr>
</tbody>
</table>

**Pad to Pad Spacing**  Pad-to-pad spacing specifies the minimum space required between pads of different nets.

**Track to Pad Spacing**  Track-to-pad (and obstacle-to-pad) spacing specifies the minimum space required between pads and tracks of different nets.

**Track to Track Spacing**  Tracks are defined as any routed track and copper obstacles (such as keep-outs and place outlines). Track-to-track spacing specifies the minimum space required between tracks of different nets, and between tracks and obstacles of different nets.

---

**Note**  The generic track-to-track spacing set here can be overridden on a "per-net" basis using the Net Spacing By Layer dialog box accessed from the Edit Net dialog box.

**Track to Via Spacing**  Track-to-via (and obstacle-to-via) spacing specifies the minimum space required between vias and tracks of different nets.

**Via to Pad Spacing**  Via-to-pad spacing can be used to specify the minimum space required between pads and vias of the same net (as well as different nets, which is the usual case). For instance, if you wish to keep a distance of 25 mils between your SMT pads and the fanout vias that are connected to the pads, set Via to Pad Spacing to 25.

**Via to Via Spacing**  Via-to-via spacing specifies the minimum space required between vias of different nets.

---

**Note**  Obstacles use track spacing rules.

---

58  *OrCAD Layout for Windows User’s Guide*
Defining padstacks

Padstacks define the pads of the footprint. They possess attributes on each layer of the board, such as shape and size. If you are using the standard Layout footprint libraries, or if you have made your own footprints using Layout standards, you have used padstacks T1 through T7 to create most of the standard through-hole components in your library. The use of each padstack is defined as follows:

- T1: Round IC pads.
- T2: Square IC pads.
- T3: Round discrete pads.
- T4: Square discrete pads.
- T5: Round connector pads.
- T6: Square connector pads.
- T7: Via SMT stringer pads.

You can create new padstacks when you set up the board, or in the footprint library. You must define padstacks before you assign them to footprints. You can define new padstacks by copying and editing existing padstacks in the Padstacks spreadsheet. Then, you can assign them to footprints or footprint pins. After you create new padstacks, you can save them in a template for reuse with future designs.

See For information on assigning padstacks to footprints or footprint pins, and on editing padstacks, see Chapter 14: Creating and editing footprints.

To create a new padstack

1. Choose the spreadsheets toolbar button.
2. Select Padstacks from the drop list. The Padstack spreadsheet displays.
3. Select a padstack and press the INSERT key.
   This creates a copy of the padstack with a unique name. The spreadsheet scrolls to the new padstack.
4. Double-click on the padstack. The Edit Padstack dialog box displays.
5. Type a new name for the padstack in the Padstack text field and edit the other options as desired.
6. Choose the OK button.

Note Never name your padstacks with the names T1 through T7. These padstacks will be overwritten by technology template padstacks whenever a technology template is loaded.
Defining vias

During the board setup process, you can define the types of vias that you want to use in your board design, including size and target layer. Layout initially provides you with one defined via, plus spaces for fifteen more. You must define additional vias in the Edit Padstack dialog box to make them available for routing. Then, using the Assign Via dialog box, you can assign a specific via to be used when routing a particular net.

Selecting a via for a particular net does not prohibit any other net from using that via. The assignments made in the Assign Via dialog box simply override, for selected nets, the Use all via types option set in the System Grids dialog box. Therefore, you can check the Use all via types option and still assign specific vias to specific nets in the Assign Vias dialog box.

For example, if you wish to use Via1 for all of your signal routing, but you wish to restrict VCC to Via 2 and GND to Via 3, you would start by selecting the Use all via types option to make the defined vias available for routing. Then you would select VCC in the Nets spreadsheet, choose Assign Via per Net from the pop-up menu, and in the Assign Via dialog box, select Via 2. Finally, you would select GND in the Nets spreadsheet, choose Assign Via per Net from the pop-up menu, and in the Assign Via dialog box, select Via 3.

If you do not select the Use all via types option in the System Grids dialog box, you must specifically assign vias to all nets that need their via types restricted. Otherwise the router chooses what it considers the "best" via, using its standard criteria.

To make a via available for general routing
1. Open the Padstacks spreadsheet.
2. Scroll the spreadsheet and select a via whose shape is undefined.
3. Choose Modify from the pop-up menu. The Edit Padstack dialog box displays.
4. Edit the options to define a via and choose the OK button.
5. From the Options menu, choose Grids. The System Grids dialog box displays.
6. Select the Use all via types option and choose the OK button.
Chapter 5  Setting up the board

To assign a via to a net

1  Open the Nets spreadsheet.
2  Select the net to which you want to assign a via.
3  Choose Assign Via per Net from the pop-up menu.
4  Select the desired via and choose the OK button.

Note  You do not have to select the Use all via types option to assign a via to a particular net.

See  For information on changing the definition of a via, see Changing vias in Chapter 9: Routing the board.
**Setting net attributes**

This section explains how to set net attributes for routing. Net attributes affect manual routing, automatic routing, and autoplacement.

Most of the net data used in Layout is established at the schematic level using net properties. However, these rules can be enhanced or modified at any time during the design process. Net data can be viewed and accessed in the Nets spreadsheet. To modify information in the Nets spreadsheet, you use the Edit Net dialog box.

**To open the Nets spreadsheet**

1. Choose the Spreadsheets toolbar button.
2. Select Nets from the drop list.

The Nets spreadsheet displays.

In the Nets spreadsheet, you can access the following information.

- **Color** The color of the ratsnest on the graphical display of the board.
- **Width Min/Con/Max** The Min (minimum), Con (desired), and Max (maximum) width for the net.
- **Routing Enabled** The current routing status (enabled or disabled) for each net.
- **Share** Allows connections in the same signal to share common vias or allows T-connections to be formed.
- **Weight** The routing priority assigned to a net. The higher the weight, the sooner the net is routed.
- **Reconn Rule** Controls connection order.
To edit net parameters

1. In the Nets spreadsheet, double-click on a net.
   The Edit Net dialog box displays.
2. Edit the options in the dialog box as desired.
3. Choose the OK button.

To find a net in the spreadsheet

1. In the Nets spreadsheet, choose Select Any from the pop-up menu.
   The Net Selection Criteria dialog box displays.
2. Enter the name of the net you are looking for and choose the OK button.
   Layout scrolls and highlights the net in the Nets spreadsheet and highlights the net on the board.

The Edit Net dialog box

- **Net Name**  The name of the selected net.
- **Routing Enabled**  When selected, indicates that the net is enabled for routing. If this option is not selected for a net, you cannot route that net.
- **Retry Enabled**  When selected, the router has the option to reroute a net to create room for another track.

Usually you enable or disable Retry Enabled in tandem with Shove Enabled. If both are disabled, then all tracks of the net are essentially locked in place. If the net is completely routed, turning off both options is identical to using Lock Routes. Using Lock Routes affects only previously routed segments.
You might disable Retry Enabled by itself in situations in which you need to keep a
certain track segment on a given layer, but do not care if the router shoves the track
as it routes. An example of this may be a clock line that must be on layer three, but
does not have any critical length requirements.

**Share Enabled**  Share Enabled considers an existing track within a net to be a
legal connection point for any new tracks within the net. In other words, Share
Enabled allows T-connections to be used on the board. Disabling this option forces
nets to go to pads only. No connections can be made to any existing track. You might
use Share disabled to force “daisy-chain” routing for ECL boards. Share Enabled is
generally disabled when routing ECL or high-speed lines.

You would normally use Reconnect None when Share is disabled, assuming that you
input the correct point-to-point netlist (from the source through the loads to the
termination). Otherwise, use Reconnect HI-SP (high speed) to optimize daisy-
chained connections automatically.

If you use Reconnect enabled along with Share Enabled, you increase the probability
of achieving a 100% routed board.

**Shove Enabled**  Allows the selected net to be moved to create space for other
tracks. You would not normally disable only shove for an existing piece of track, as
the router could still use Retry Enabled to rip up the track if necessary. Therefore, if
you want to completely lock a net, you should turn off both Shove Enabled and Retry
Enabled.

If Retry Enabled and Shove Enabled are both turned off, then all tracks of the net are
essentially locking in place. If the net is completely routed, turning off both options
is identical to using Lock Routes except that using Lock Routes affects only
previously routed segments.

**Highlight**  Highlight displays critical connections in the highlight color, to make
them easier to see. The default color for highlight nets on all layers is white. You can
change the highlighting color on a layer-by-layer basis.

**See**  For instructions on changing the Highlight color, see *Using color in the
graphical display of your design* in Chapter 4: The Layout design environment.

**Test Point**  When enabled, the selected nets can be assigned a test point manually.
Or, they are assigned test points when you choose the Test Point command on the
Auto menu (Layout Plus only). In the Edit Padstack dialog box, select the Use for
test point option to define a via as a test point.
Group  If, at the schematic level, you assigned a number to a group of nets, that number is displayed here. The ratsnests of grouped nets are displayed in Layout in a distinct color.

All nets not assigned to a group at the schematic level are assigned to group zero, whose default color is yellow. You can edit a net’s group number only at the schematic level.

Net group numbers are displayed in the following default colors.

<table>
<thead>
<tr>
<th>Group</th>
<th>Color</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group 1</td>
<td>Red</td>
</tr>
<tr>
<td>Group 2</td>
<td>Green</td>
</tr>
<tr>
<td>Group 3</td>
<td>Blue</td>
</tr>
<tr>
<td>Group 4</td>
<td>Yellow</td>
</tr>
<tr>
<td>Group 5</td>
<td>Purple</td>
</tr>
<tr>
<td>Group 6</td>
<td>Sky Blue</td>
</tr>
<tr>
<td>Group 7</td>
<td>White</td>
</tr>
<tr>
<td>Group 8</td>
<td>Gray</td>
</tr>
<tr>
<td>Group 9</td>
<td>Dark Red</td>
</tr>
<tr>
<td>Group 10</td>
<td>Dark Green</td>
</tr>
</tbody>
</table>

Weight  The priority a net is given for routing. The higher the weight, the sooner it will be routed. The range is zero to 100, with 50 as the default. A higher weight overrides all other ordering criteria.

Min Width  Min Width is the minimum width of routed tracks. You can override this value for individual tracks using the Manual Route Strategy and Track Width dialog boxes.

Con Width  The router creates new tracks using the value set for Con Width. For nets with variable widths, set Con Width to the preferred width. Then, you can override the preferred width as desired in the Manual Route Strategy and Track Width dialog boxes.

Max Width  Max Width is the maximum width of routed tracks. You can override this value for individual tracks using the Manual Route Strategy and Track Width dialog boxes.

See  For information on using the Manual Route Strategy dialog box, see Using the interactive route strategy in the OrCAD Layout for Windows Autorouter User’s Guide. For information on using the Track Width dialog box, see Changing the width of tracks in this chapter.
Enabling layers for routing

In the Layers Enabled for Routing dialog box, you can specify on what layers a particular net can be routed. That is, you control which layers are enabled for routing on a per-net basis.

This option is valuable for nets that can only be routed on certain layers. The autorouter will not put a particular track on a layer unless the layer is enabled for routing for that net. An error occurs if you try to manually route a track on a layer that is not enabled for routing in this dialog box.

To enable or disable layers for routing

1. Open the Nets spreadsheet.
2. Select a net and choose Modify from the pop-up menu. The Edit Net dialog box displays.
3. Choose the Net layers button.
   The Layers Enabled for Routing dialog box displays.
4. Select the layers on which you want to route the selected net.
Setting net widths by layer

In the Net Widths by Layer dialog box, you can set a specific track width for each layer for each net. This feature is especially useful for impedance controlled boards. If the width of a net varies from its value as set in this dialog box, the DRC check flags it as an error.

After you set a net width using the Nets by Layer dialog box, you can change the width of the net later using the Force Width by Layer command.

Note The Net Widths by Layer command is not available in Layout Ltd.

To set net widths by layer

1. Open the Nets spreadsheet.
2. Select the nets for which you want to set width by layer and choose Modify from the pop-up menu.
3. Choose the Width by layer button.
   
   The Net Widths By Layer dialog box displays.

   ![Net Widths By Layer dialog box]

4. Edit the options as desired and choose the OK button.
Setting connection order

Using the Reconnection type dialog box, you can edit the reconnection rules for each type of reconnection allowed for Layout and control the connection order.

To set the connection order

1. Open the Nets spreadsheet.
2. Select the nets for which you want to set routing order and choose Modify from the pop-up menu.
   The Edit Net dialog box displays.
3. Choose the Net reconn button.
   The Reconnection Type dialog box displays.
4. Select a reconnection type for the nets and choose the OK button.

Reconnection Type dialog box

**None** Select the None option to maintain the schematic net order.

**Vertical** Select the Vertical option to instruct the router to seek primarily vertical paths for each connection within a net. This option is used for power (VCC) and ground (GND).

**Horizontal** Select the Horizontal option to instruct the router to seek primarily horizontal paths for each connection within a net. This option is generally used for power (VCC) and ground (GND).

**Standard Orthogonal** Select the standard orthogonal option to instruct the router to seek the easiest path between any two points within a net. This is usually the shortest distance, but the option has a predisposition for horizontal or vertical routes where possible. This is the default option, and should be used for all routing of standard digital signals.
High speed  Use this option to prohibit T-connections and instruct the router to daisy-chain the connections in the net from the source to the load, and then to the terminator rather than creating tracks to find the shortest route. This option is usually used for critical ECL nets. It is often used in conjunction with disabling share on critical nets.

The source, loads, and terminators are set in the Packages spreadsheet. You must assign source and terminator pins in the Package Edit dialog box in order to use High speed for automatic ECL routing. Without these assignments, the router will daisy-chain the tracks, but will use an arbitrary source and terminator.
Chapter 5  Setting up the board

Setting net spacing by layer

In the Net Spacing By Layer dialog box, you can set the spacing per layer for each net so that you can precisely control the distance between any net and its neighbor. This applies to track-to-track spacing only, so that you can route critical signals between pins using the normal pad-to-track spacing.

Tip  This is particularly useful for Underwriters Laboratories (UL®) or telecommunications boards that have a high degree of sensitivity to track spacing per net.

The router always uses the largest spacing criteria that applies. Therefore, if the net-to-net spacing is 8, but the global track-to-track spacing is 12, the tracks remain 12 mils apart. This rule also applies to nets with different spacing.

The DRC issues an error message if the specified minimum is violated.

Note  The Net Spacing by Layer command is not available in Layout Ltd.

To set the net spacing per layer

1  Open the Nets spreadsheet.
2  Select the nets that you want to edit and choose Modify from the pop-up menu. The Edit Net dialog box displays.
3  Choose the Net Spacing button. The Net Spacing By Layer dialog box displays.
4  Set the spacing for each layer for the selected nets and choose the OK button.
Creating and editing obstacles

Using obstacles in Layout

Layout uses objects called obstacles to restrict where components and routes can be placed on a board. The most common types of obstacles used in Layout are:

- Board outlines
- Copper pour
- Insertion outlines
- Place outlines

You can also use obstacles to create copper zones, component height restrictions, and much more.

See If you have Layout or Layout Plus, you can use OrCAD Visual CADD to create board outlines, keep-ins and keep-outs, and similar objects. For information on Visual CADD, see the OrCAD Layout for Windows Visual CADD User's Guide.

You can use Layout's obstacle tool to create, edit, and place obstacles on your board. You can use the Edit Obstacle dialog box to choose the type of obstacle you want to create, and to set physical attributes for the obstacle, such as size, target layer, and net attachments.

Obstacles are used on the board and in the footprint library. In a library, Layout assumes that the obstacles you place are to be attached to component footprints. See the description of the Comp/footprint attachment dialog box in this chapter for a better explanation of obstacles attached to footprints in libraries.

Layout remembers the physical attributes of the last obstacle you created. When using the obstacle tool, you can easily create one or more similar obstacles in succession, including net and component attributes. The obstacles can be different sizes.
Creating obstacles

There are two steps in the obstacle creation process: defining the obstacle, then drawing the obstacle.

1. Choose the Obstacle toolbar button or choose Obstacle from the Tool menu.
2. Choose Zoom Out from the View menu and click on the screen until you can view the entire board.
3. Press the INSERT key. The cursor changes from a large cross (idle mode) to a small cross (active mode). Locate the point from which you want to start drawing the outline. There are three ways to move the cursor to this point: you can move the mouse, you can use the arrow keys, or you can press the TAB key to go to the desired X, Y coordinates. Click the left mouse button once on the screen. You will begin drawing from that point.

Tip To place an obstacle at exact coordinates or coordinates that are off-grid, choose the Find toolbar button. In the Find coordinate or Component Name dialog box, enter the coordinates (X, Y) at which you want to place the first corner and choose the OK button. Repeat for the other three corners.

Tip If you are using a fine detail grid, use the mouse to approach the starting point, and then use the arrow keys to position the cursor. Once you are at the starting location, click the left mouse button to start drawing the obstacle or press the SPACEBAR to eliminate accidental mouse movement.

4. Double-click the left mouse button on the screen.
5. From the Obstacle Type drop list, select the type of obstacle you want to create.

See The Edit Obstacle dialog box includes special options based on the type of obstacle you are creating. For a detailed description of each option, see The Edit Obstacle dialog box description in this chapter.

6. In the Obstacle Group, Height, Width text field, enter the desired value. The appropriate option is enabled depending on the type of obstacle you are creating.
7. From the Obstacle layer drop list, select the layer on which you want to place the obstacle.
8. Choose the OK button to accept the settings and close the Edit Obstacle dialog box.
9  Move from the starting coordinates to the desired location of the first corner. Click the left mouse button or press the SPACEBAR to insert the first corner. Move to the desired location of the next corner. Click the left mouse button or press the SPACEBAR to insert the second corner.

   ![Diagram of constructing an obstacle]

   **Note**  When you are creating an obstacle type that is by definition an area, such as a place outline or copper pour zone, Layout automatically begins forming a closed area after you insert the first corner.

   **Note**  When creating an obstacle that is a line (free copper, detail, etc.), drag the cursor to draw the line, click the left mouse button to stop drawing, and choose End Command from the pop-up menu.

10  When you complete the third corner, choose Finish from the pop-up menu. Layout automatically completes the obstacle.
Chapter 6  Creating and editing obstacles

The Edit Obstacle dialog box

The name of the obstacle. It is given a number until you assign it a name.

Obstacle Type  The type of the obstacle. There are many types of obstacles. They are listed below.

Free track. A line or track. It can be electrically attributed or electrically attached to a component pin. A free track obstacle may appear on the artwork and act as a routing barrier unless the track belongs to the same net. A free track obstacle has no affect on placement.

Copper area. A copper-filled zone on the board that can be used for noise suppression, to draw heat away from components that tend to get hot, or as a routing barrier. It can be electrically attributed or electrically attached to a component pin. It has no affect on placement. It can be filled with hatched lines or it can be solid.

Copper pour. A copper-filled zone on the board that features automatic voiding where there are tracks or pads. Tracks can pass through it. Copper pour can be used for noise suppression, shielding, to draw heat away from components that tend to get hot, or to isolate signals. It can be electrically attributed or electrically attached to a component pin. It has no affect on placement. It can be filled with hatched lines or it can be solid. It repours when you edit the board, or when you choose the Refresh Copper pour toolbar button.

Note  In the User Preferences dialog box, you can select the option Fast Fill Copper Pour to accelerate redraw. See Setting environment preferences in Chapter 4: The Layout design environment for more information.

Anti-copper. A copper-free area within a copper pour zone.

Board outline. A line that defines the board edge for routing and placement. There is usually only one per board on all layers (Global layer).
Chapter 6  Creating and editing obstacles

Detail. A line that is not used by place or route. These lines are used for silkscreens, drill information, and assembly drawings, and can be attached to footprints.

Place outline. Place outlines are critical for every part. This outline defines the outline of the component and is used to maintain spacing between parts. Both interactive placement and autoplacement routines look for this information. The place outline can exist on the top or bottom for surface mount parts or on all layers for through-hole parts.

Insertion outline. Insertion outlines define the size and shape of components so that the auto-insertion machine knows where to grip the component prior to placing it on the board. It is usually defined in the footprint library as a part of the footprint.

Note  For surface mount parts, the insertion outline can be larger so that sufficient space exists between parts to eliminate solder shadowing and help ease the post-assembly inspection process.

Comp height keep-in. An area you define to contain all components of a certain height or greater.

Comp height keep-out. An area you define to exclude all components of a certain height or greater.

Comp group keep-in. An area you define to contain all components of a certain group.

Comp group keep-out. An area you define to exclude all components of a certain group.

Route keep-out. An area you define that routes cannot penetrate.

No via. An area you define to restrict vias from being placed under surface-mount discrete parts.

Group, Height, Width  One of the options is enabled, depending on the Obstacle Type you have chosen from the Obstacle Type drop list. Specify the desired dimension in the text field.

Obstacle layer  Specify on which layer you want the obstacle to reside. If you specify all layers (layer 0), the obstacle is present on all layers. Most of the layer names are straightforward, but some use the following nicknames.

GND. Ground plane.

PWR. Power plane.

SMTOP/SMBOT Solder mask top or bottom.

SPTOP/SPBOT Solder paste top or bottom.
Creating and editing obstacles

**SSTOP/SSBOT.** Silkscreen top or bottom.

**ASYTOP/ASYBOT.** Assembly drawing top or bottom.

**DRLDWG.** Drill drawing.

**DRILL.** Drill information for Excellon drill tape.

**Copper pour rules** In the Copper pour rules group box, you can specify options governing copper pour.

**Copper pour clearance.** Copper pour clearance designates the absolute clearance between this particular piece of copper pour and all other objects. A clearance of zero designates that the default clearances from each type of object will be used.

**Isolate all routes.** Attaches copper pour to a net, but only by thermal connections into the pads of that net. The tracks remain isolated.

**Seed only from designated object.** When you are creating a copper pour zone in Layout, the copper pour must either encompass a track of the appropriate net, or you must designate a seed point. The seed point is the point from which the copper pours. The Seed only from designated object option specifies that the copper pour fill as much area as is possible contiguously from the seed point without violating DRC settings, ignoring any tracks that might otherwise be used to connect the copper pour to the net.

**Note** If you do not select the Seed only from designated object option, the copper pours from tracks and vias. When the option is selected, copper pours *only* from the seed point.

**See** For more information on copper pour, see Chapter 10: Using thermal reliefs and copper pour zones.

**Net attachment ("-" for none)** Specifies a net attachment for the obstacle.

**Hatch pattern** Whenever you create copper, copper pour, or shavable copper, the hatch pattern defaults to solid. Use this dialog box to create a hatch pattern within the copper. The hatch grid defaults to the routing grid, and the hatch rotation defaults to 0 (horizontal).
**Comp attachment** Unless you are drawing obstacles in the footprint editor, Layout attaches all items to the board by default. However, any type of obstacle can be attached to a component.

When creating an obstacle in the footprint editor, it is automatically attached to the footprint that you are editing or creating. Also, a copy of the obstacle appears at the same relative location attached to every component that uses that footprint.

If you attach an obstacle to a component in the design window, it moves with the component, but is not attached to any other component of the footprint.

Only electrical obstacles (outlines, copper, and copper pour) can be attached to pins. In this case, they acquire the electrical attributes of the pin.
Chapter 6  Creating and editing obstacles

Selecting obstacles

To select an entire obstacle

Press the left mouse button and drag across any area of the obstacle.

or

While pressing the CTRL key, click on the obstacle with the left mouse button.

Either method selects the entire obstacle. You can select multiple obstacles by pressing the CTRL key and clicking on the obstacles that you want to select. Selected obstacles are highlighted.

To select a segment of an obstacle

Click on the segment with the left mouse button.

Editing obstacles

Use the Edit Obstacle dialog box to edit obstacles. Using the dialog box, you can choose the obstacle type and set physical attributes, such as width, layer, and hatch pattern. You can also specify attachments for the obstacle, including footprints, components, pins, and net attachments.

Note  You can use the Edit Obstacle dialog box to set the attributes for an obstacle before creating it as described in Creating obstacles in this chapter.

To edit obstacles

1  Select the obstacle using the CTRL key and the left mouse button to select the entire obstacle.

2  Choose Modify from the pop-up menu.

or

Double-click on the obstacle.

or

Press the ENTER key.

The Edit Obstacle dialog box displays.

3  Edit the options as desired.

4  Choose the OK button to close the Edit Obstacle dialog box.

Note  For a complete list of options available in the Edit Obstacle dialog box, see the Edit Obstacle dialog box description in this chapter.
Copying obstacles

In Layout, you can copy existing obstacles and can place the copies on any layer.

To copy obstacles
1 Select an obstacle.
2 To make a copy of the obstacle, choose Insert from the pop-up menu.  
   or
   Press the INSERT key.
3 Pressing the left mouse button, drag the copy to the desired location.
4 Click the left mouse button to place it.

To copy obstacles to other layers
1 Copy the obstacle as described in steps 1 through 4 above.
2 Choose Layer from the View menu. The Zoom Layer dialog box displays.
3 Type in the name of the target layer and choose the OK button.
4 Press the SPACEBAR or click the left mouse button to place the obstacles on the target layer.

Tip  You can also press the hotkey for the layer. These keys are listed in the Layers spreadsheet.
Chapter 6  Creating and editing obstacles

Moving obstacles

To move an obstacle
1 Select the obstacle by pressing the CTRL key and clicking the left mouse button, or using area select.
2 Drag the cursor to the desired location.
3 Choose End Command from the pop-up menu.

To move an obstacle to another layer.
1 Select the obstacle.
2 Choose Layer from the View menu. The Zoom Layer dialog box displays.
3 Type in the name of the target layer and choose the OK button.

Rotating obstacles

You can rotate obstacles using the Rotate command. First, you must set the increment of rotation in the System Grids dialog box. Layout supports any rotation value.

To rotate an obstacle
1 Choose Grid from the Options menu.
   The System Grids dialog box displays.
2 In the Increment text box, enter the value in degrees to which you want to rotate the obstacle and choose the OK button.
3 Select the obstacle.
4 Choose Rotate from the pop-up menu.
Mirroring obstacles

You can display an obstacle as it would appear in a mirror’s reflection using the Mirror command.

To mirror an obstacle
1 Select the obstacle.
2 Choose Mirror from the pop-up menu. Layout mirrors the obstacle on the current layer.
   or
   Choose Opposite from the pop-up menu. Layout mirrors the obstacle on the opposite layer.

Exchanging the ends of obstacles

After you select a linear obstacle, you can use this command to focus the pointer on the end opposite the current selection.

To exchange the ends of an obstacle
1 Create an obstacle.
2 Select a segment or corner of the obstacle by clicking on it with the left mouse button.
3 Choose Exchange ends from the pop-up menu.

Moving segments

When you select a segment on an obstacle and attempt to move it, a vertex is created. Use the Segment command to move entire segments without forming vertices. You can use this tool to make obstacles larger or smaller.

To move a segment
1 Select a segment, or side, of the obstacle.
2 Choose Segment from the pop-up menu.
3 Drag the cursor.
4 The segment moves allowing you to extend or depress the entire side of the obstacle.
Creating circular obstacles

You can create circular shapes using the Arc command.

To create a circle

1. Choose the Obstacle toolbar button. 
   or 
   Choose Obstacle from the Tool menu.

2. Choose Insert from the pop-up menu. 
   or 
   Press the INSERT key.

3. Double-click at the point on the screen that you want to designate as the center of the arc.
   The Edit Obstacle dialog box displays.

4. Choose an obstacle type from the Obstacle Type drop list, edit other options as necessary, and choose the OK button.

5. Choose Arc from the pop-up menu.

6. Drag the cursor to begin creating a circle.

7. Click the left mouse button to stop drawing.

Creating a circular copper pour obstacle.

Tip When you select a segment and type A, an arc forms. Drag the arc to the desired coordinates and click the left mouse button to stop drawing.
Deleting obstacles

To delete an obstacle

1. Select the obstacle to delete. To avoid inadvertently selecting other obstacles, press the CTRL key while selecting.

2. Choose Delete from the pop-up menu.
or
   Press the DELETE key.

Tip If you accidentally select the wrong obstacle, click the right mouse button to abort the operation.
Adding, copying, and deleting text uses many of the same techniques used when working with obstacles. In Layout, you can use text to label packages and pins, create reference designators, or to add useful information, such as manufacturing notes, to the board.

Creating labels

Use the Text Edit dialog box to create all of the text you need to label your board and library parts.

To create text

1. From the Tool menu, choose Text.
   or
   Choose the Text toolbar button.
2. Press the INSERT key.
   or
   Choose Insert from the pop-up menu.
3. From the Type of Text group box, select the type of text that you want to create. If you select the Free or Custom Properties option, type a text string into the Text String text box. These options are described in the dialog box description in this section.
4. Edit the Line Width, Rotation, Radius, Text Height, Char Rot (character rotation), and Char Aspect (character aspect) text fields as desired. These options are described in the dialog box description in this section.
5. Select the Mirrored option if you want the text to appear as in a mirror’s reflection on the layer (useful for placing text on the bottom of the board).
6. Select the target layer from the Layer drop list.
   or
   Type in the hotkey for the layer as listed in the Layers spreadsheet.
7. Choose the OK button to accept the edits and close the Text Edit dialog box.
8. Position the text on the screen and click the left mouse button to place it.
The Text Edit dialog box

**Text String**  You need to enter a text string if you choose Free or Component Values from the Type of Text group box. Enter the text string as you want it to appear on the board. If you select any of the other options from the Type of Text group box, the placeholder text appears in the text box. For example, if you are adding a reference designator to the footprint, it will appear as &Comp in the Text String text box and in the footprint editor. It is replaced on the board with the appropriate reference designator as defined by the schematic netlist.

**Note**  The symbol & is a macro signifier and should not be interpreted as a literal piece of text. The text string you see in the footprint library, such as &Comp, is a placeholder that will be replaced on the board by the actual name, value, or property as described and assigned by the schematic netlist.

**Type of Text**  Choose the type of text that you want to add to the board by selecting the corresponding option. The choices are described below.

*Free.* When you select this option, you can enter any text in the Text String text box, such as a serial number, to display on the board.

*Reference Designator.* The reference designator is supplied by the schematic netlist. The text string &Comp acts as a placeholder in the library. It is replaced by the appropriate reference designator when the footprint is attached to the component on the board.

*Component Value.* Select this option to display component values from the schematic netlist on the board. The text string &Value acts as a placeholder in the library. It is replaced by the appropriate component value when the footprint is attached to a component on the board. For example, the component value of a resistor may be 10k. The placeholder &Value displays in the footprint editor, but after the footprint is attached to the resistor, the value 10k will display on the board.
Custom Properties: Select this option to display selected properties from the schematic netlist on the board. These properties can include part numbers and other details. You must type the appropriate placeholder in the Text String text box, as defined at the schematic level. For example, if you want to display the part number on the footprint, you may type $Partnumber$ in the Text String text box. The text string $Partnumber$ acts as a placeholder in the library, until the footprint is attached to the component on the board. Then $Partnumber$ is replaced by the actual part number of the component as supplied by the schematic netlist.

Package Name. The package name is supplied by the schematic netlist and is used to describe the logical or internal characteristics of a component. The text string $Pack$ or No Package may appear as a placeholder in the library, but is replaced by the appropriate schematic netlist information when the footprint is attached to a component on the board.

Footprint Name. When this option is selected, Layout displays the name of the footprint.

The placeholder $Comp$ is replaced by the appropriate reference designator on the board design. The placeholder $Pin$ is replaced by the appropriate schematic netlist information on the board design. Test 1 is the footprint name.
Chapter 7  Creating and editing text

**Text location**  Displays the current coordinates of the text.

**Line Width**  Specifies, in characters, the working units width of the text line.

**Rotation**  Specifies, in degrees, the rotation of a text line.

**Radius**  Assigns a radius (circular shape) to a text string.

**Text Height**  Specifies text height in working units.

**Char Rot**  Rotates individual characters.

**Char Aspect**  Assigns the width of the letters relative to the height.

**Mirrored**  Reflects the text on the layer.

**Layer**  Specifies the layer on which you want the text to appear.

**Comp Attachment**  Displays the Comp/Footprint Attachment dialog box. In the dialog box, edit the options to attach text to an individual component.
Moving text

To move text
1. Choose the Text toolbar button.
   or
   From the Tool menu, choose Text.
2. Click on the text using the left mouse button. It is now attached to the cursor.
3. Move the mouse to position the text in the target location.
4. Click the left mouse button to place the text.

Deleting text

To delete text
1. Choose the Text toolbar button.
   or
   From the Tool menu, choose Text.
2. Select the text by clicking on it with the left mouse button.
3. Press the DELETE key.
Placing and editing components

Once you have set up your board, you can begin placing components. Whether you are placing components manually, or using Layout Plus’ autoplacement utility, you can place components individually or in groups, and can take advantage of a variety of powerful placement commands. The steps involved in the component placement process are listed below.

- Optimize the board for component placement
- Load a placement strategy file
- Place the components on the board
- Optimize placement using placement commands

See also  The commands and processes described in this chapter are applicable for Layout Ltd., Layout, and Layout Plus users. For information on using the placement commands and processes available in Layout Plus only, see the OrCAD Layout for Windows Autoplacement User’s Guide.

The board before component placement.
Preparing the board for component placement

Before you begin placing components manually or using autoplacement, it is important to set up the board properly. Use the list below as a pre-placement checklist. These steps are the same for manual placement and autoplacement.

- Check the board, place, and insertion outlines
- Check the place grid
- Check mirror or library layer settings
- Weight and color-code nets
- Check pre-placed components and secure them on the board
- Create component height or group keep-ins and keep-outs
- Check gate and pin data

Checking the board, place, and insertion outlines

The board outline is used by Layout to determine the overall board placement boundary, and must be present on every layer of the board. It can be defined as part of the board template, or you can create it when you set up the board.

A place outline defines the extent of the area that is reserved for component placement. Each footprint must have one. Layout uses place outlines to determine whether any component spacing violations occur during the placement of the printed circuit board. A place outline can be assigned a height and a layer. One or more place outlines of different heights and shapes, and on different layers, can be used to more closely represent the placement area required by a component. However, all place outlines should be rectangular.

Tip If you enable the 3D Effects option in the User Preferences dialog box (accessed by choosing User Preferences from the Options menu), and have assigned a Height for a Place outline, Layout displays a three-dimensional image representing the component’s height, and indicates the height on the image.

An insertion outline is optional, and is used by Layout to provide clearance for autoinsertion machines. An insertion outline can overlap another insertion outline, but it cannot overlap a place outline.
To check board, place, and insertion outlines

1. Choose the spreadsheet toolbar button.
2. Select Obstacles from the drop list.

The Obstacles spreadsheet displays.

<table>
<thead>
<tr>
<th>Obstacle Name</th>
<th>Width or Height</th>
<th>Obstacle Type</th>
<th>Layer</th>
<th>Corners</th>
<th>Times Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>OB2</td>
<td>10</td>
<td>Free track</td>
<td>ASYTOP</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>OB4</td>
<td>10</td>
<td>Free track</td>
<td>ASYTOP</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>OB6</td>
<td>10</td>
<td>Free track</td>
<td>ASYTOP</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>OB8</td>
<td>10</td>
<td>Free track</td>
<td>ASYTOP</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>OB10</td>
<td>10</td>
<td>Free track</td>
<td>ASYTOP</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>OB12</td>
<td>10</td>
<td>Free track</td>
<td>ASYTOP</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>OB14</td>
<td>10</td>
<td>Free track</td>
<td>DR1DWG</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>OB16</td>
<td>10</td>
<td>Free track</td>
<td>DR1DWG</td>
<td>2</td>
<td>1</td>
</tr>
</tbody>
</table>

3. Press SHIFT + D to view the physical attributes of the board outline. If there are "cutouts" in the board outline where no components should be placed, you need to create "zero-height" keep-outs inside the cutouts to ensure that no components are placed in these areas.

See For information on creating height keep-outs, see Creating height or group keep-ins and keep-outs in this chapter.

See For information on creating board outlines, see Chapter 5: Setting up the board. For information on creating place and insertion outlines, see Chapter 6: Creating and editing obstacles.
Chapter 8  Placing and editing components

Checking the place grid

The place grid affects the spacing used for component placement. Before placing components, check the setting specified for the place grid in the System Grids dialog box.

The default placement grid is 100 mils, with which you can use routing grids of 25 mils, 20 mils, 12½ mils, 10 mils, 8½ mils, 6½ mils, or 5 mils.

Tip  If you use a 50 mils or 25 mils placement grid, you can use routing grids of 25 mils, 12½ mils, 10 mils, 8½ mils, or 6½ mils.

The standard metric placement grids are 2 mm, 1 mm, and 0.5 mm.

See  For information on setting other system grids in Layout, see Chapter 5: Setting up the board.

To check the place grid setting

1  Choose Grids from the Options menu.
2  Check the value in the Place grid text box and choose the OK button.

Checking mirror layers and library layers

You can check which layers are set up to have their obstacles, padstacks, and text mirrored to another layer during component placement, and change the settings, if necessary. For example, all of the TOP layer components can be automatically mirrored to the BOTTOM layer, and vice versa.

Typically, all inner layers of a design (INNER1, INNER2, and so on.) correspond to the INNER library name, and all plane layers of a design (POWER, GND) correspond to the PLANE library name. All other layers typically have a one-to-one correspondence; for example, the BOTTOM layer in the design corresponds to the BOTTOM library name.

To check the mirror layer and library layer settings

1  Choose the spreadsheets toolbar button.
2  Select Layers from the drop list. The Layers spreadsheet displays.

See  For more information on layer setup and editing, see Defining the layer stack in Chapter 5: Setting up the board.
Weighting and color-coding nets

Layout places a higher priority on keeping higher-weighted nets and their components together during placement. In Layout, nets are weighted on a linear scale from 0 to 100.

**To weight and highlight nets**

1. Choose the spreadsheets toolbar button.
2. Select Nets from the drop list. The Nets spreadsheet displays.
3. Double-click in the Net Name cell in the spreadsheet that corresponds to a net whose weight you want to change, or that you want to highlight. The Edit Net dialog box displays.
4. To change the weight for a net, type in a new weight in the Weight text box, then choose the OK button.
   or
   Use the scroll bar at the left of the text box to change the number, then choose the OK button.
   The new number shows in the Weight column of the spreadsheet.
5. To highlight a net, enable the Highlight option, then choose the OK button.
   The net shows in the highlight color in your design.

---

**Tip**  To assign a color to a net other than the highlight color, click in the Color cell in the Nets spreadsheet, choose Change Color from the pop-up menu, then select a color from the color palette displayed.

---

**See**  For information on setting net attributes, see Chapter 5: Setting up the board.

---

**To color-code a net**

1. In the Nets spreadsheet, select the net(s) to which you want to assign a color.
2. From the pop-up menu, choose Change Color and select a color from the palette that displays.
Checking gate and pin information

A package is the electronic gate and pin information that is associated with a component (as opposed to a footprint, which is the information regarding the physical characteristics of a component). The information in the Packages spreadsheet is used to determine whether you can swap gates between identical components or only within a component, and how the gates are arranged within a part.

To check gate and pin information

1. Choose the spreadsheets toolbar button.
2. Select Packages from the drop list. The Packages spreadsheet displays.

<table>
<thead>
<tr>
<th>Package Name or Pin Number</th>
<th>Gate Name</th>
<th>Pin Name</th>
<th>Gate Group</th>
<th>Pin Group</th>
<th>Pin Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Package 7400</td>
<td>A</td>
<td>INA</td>
<td>1</td>
<td>1</td>
<td>None</td>
</tr>
<tr>
<td>Pad 1</td>
<td>A</td>
<td>INB</td>
<td>1</td>
<td>1</td>
<td>None</td>
</tr>
<tr>
<td>Pad 2</td>
<td>A</td>
<td>OUT</td>
<td>1</td>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>Pad 3</td>
<td>B</td>
<td>INA</td>
<td>1</td>
<td>1</td>
<td>None</td>
</tr>
<tr>
<td>Pad 4</td>
<td>B</td>
<td>INB</td>
<td>1</td>
<td>1</td>
<td>None</td>
</tr>
<tr>
<td>Pad 5</td>
<td>B</td>
<td>OUT</td>
<td>1</td>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>Pad 6</td>
<td>C</td>
<td>GND</td>
<td>0</td>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>Pad 7</td>
<td>C</td>
<td>OUT</td>
<td>1</td>
<td>0</td>
<td>None</td>
</tr>
<tr>
<td>Pad 8</td>
<td>C</td>
<td>INA</td>
<td>1</td>
<td>1</td>
<td>None</td>
</tr>
</tbody>
</table>

Packages spreadsheet.

**Package Name**  Package Name is a text string that designates the name of the electrical package.

**Gate Name**  Gate Name is usually an alpha character that designates which gate each pin belongs to. Each gate in a package must have a unique gate name, and all of the pins in the same gate must share the same gate name.

**Pin Name**  Pin Name identifies each pin in terms of its electrical characteristics (INA, INB, etc.) so that Layout can swap gates correctly. Each pin within a gate must have a unique identifier. Each swappable gate must have identical pin names for each correlating pin.

**Gate Group**  Gate Group is an integer used to determine which gates can be swapped. Any gates that are assigned to the same Gate Group are swappable. Gate Group 0 is a special case that represents a non-swappable gate.
**Pin Group**  The Pin Group is an integer used to determine which pins can be swapped. Any pins that are assigned to the same Pin Group are swappable. Pin Group 0 is a special case that represents a non-swappable pin.

**Tip**  Pin swapping is handled by the Pin Group, not the Pin Name, so you should not use the same name for both pins (for example, INPUT) to show that they are swappable. Pin Names are used only for correlating pins during gate swaps.

**Pin Type**  The Pin Type is usually set to None for standard TTL-type pins, which indicates that the pin is not part of an ECL net, and is not a source, a terminator, or a load. You can assign a Pin Type of None, Source, Terminator, or Load.
Securing pre-placed components on the board

If your design has components or footprints that were placed at the schematic level or as part of the template, you should ensure that they were placed properly before you begin placing additional components. Pre-placed components may include connectors, mounting holes, memory arrays, predefined circuits, alignment targets, and components that must be placed in specific locations due to height or temperature restrictions.

Once you are satisfied that the pre-placed components are properly placed, you must lock them to the board using the Fix or Lock command. Otherwise, they may be moved inadvertently when you are placing other components. The Lock command is temporary; the user can easily override the command.

The Fix command, on the other hand, must be disabled in the Edit Component dialog box. The Fix command is intended for parts like connectors and mounting holes that need to be placed permanently in specific locations.

To lock components on the board

1. Choose the Component toolbar button.
   or
   Choose Component from the Tool menu.

2. To select all of the preplaced components, press and hold the left mouse button while you drag the mouse, drawing a rectangle around the components. Release the left mouse button. Every selected component is highlighted.

3. To lock the components in a location temporarily, choose Lock Comps from the pop-up menu.
   or
   To permanently fix components in a location, choose Fix Comps from the pop-up menu.

To override the Lock Comps command

1. Select a locked component.
   A prompt asks, "One or more components locked. Override?"

2. Choose the OK button.
   The component is unlocked.
To override the Fix command

1. Choose the Spreadsheets toolbar button.
2. Select the Components spreadsheet from the drop list.
3. Double-click on the row for the component that you want to move.

   The Edit Component dialog box displays.

4. In the Component flags group box, deselect the Fixed option.
5. Choose the OK button to exit the Edit Component dialog box.
Creating height or group keep-ins and keep-outs

You can restrict component placement based on physical constraints using the Comp height keep-in or Comp height keep-out obstacle types. A height keep-in contains all components at or above a specified height, while a height keep-out excludes all components at or above a specified height.

You can also restrict placement based on group number (assigned in the schematic) using the Comp group keep-in or Comp group keep-out obstacle types. A group keep-in contains all the components in a specified group, while a group keep-out excludes all the components in a specified group.

To create keep-ins and keep-outs

1. Select the Obstacle tool from the toolbar.
2. From the pop-up menu, choose Insert.
3. Draw a rectangle that defines the desired keep-in or keep-out area.
4. Double-click on the rectangle.
   The Edit Obstacle dialog box displays.
5. From the Obstacle Type drop list box, select Comp height keep-in or Comp height keep-out. In the Height text box, enter a number corresponding to the height of the components you want to include or exclude and choose the OK button.
   or
   From the Obstacle Type drop list box, select Comp group keep-in or Comp group keep-out. In the Group text box, enter a number corresponding to the group number of the components you want to include or exclude, then choose the OK button.
6. From the pop-up menu, choose Finish.
   If you created a component height restriction, the rectangle displays the height number and the words “Comp keep-in” or “Comp keep-out.” If you created a group restriction, the rectangle displays the group number and the word “Group number keep-in” or “Group number keep-out.”
Chapter 8  Placing and editing components

Placing components manually

There are several commands available in Layout to assist you in manually placing components on a board. You can place components one at a time or in groups. This section describes how to place components manually. You can place the whole board manually, or if you have Layout Plus, you can place some components manually, and then use Autoplacement to place the remaining components on the board.

See For instructions on using autoplacement, see the OrCAD Layout for Windows Autoplacement User’s Guide.

Tip Before you begin placing components, save your board file.

Loading a placement strategy file

In manual placement, strategy files set up the window for what you need to see during component placement, highlighting appropriate elements such as place outlines, electrical connections, and reference designators, and making irrelevant elements, such as plane layers, invisible. We suggest that you load the strategy file, PLSTD.SF, that is included with Layout, before performing manual placement. The file can be selected from the list that appears in the Load Strategy File dialog box as described below.

To load a placement strategy file

1 Choose Load Strategy from the File menu. The Load Strategy File dialog box displays.

2 Select the strategy file PLSTD.SF from the list and choose the Open button.
Disabling the power and ground nets

If the power and ground are not critical to placement, disable routing for all nets attached to plane layers. This significantly improves system performance during placement as these typically large nets often have no bearing on placement.

To disable routing for nets attached to plane layers

1. Choose the spreadsheets toolbar button.
2. Select Nets from the drop list.
   The Nets spreadsheet displays.
3. Using the CTRL key, select the nets that are attached to plane layers by clicking on them with the left mouse button.
4. From the pop-up menu, choose Enable<->Disable.
   In the Nets spreadsheet, the Routing Enabled column for the nets changes to No*.
Placing components using manual placement

Use the Select Criteria command to make a component or group of components available for placement. Using this command with the Next Comp command, you can select one or more components based on a set of criteria (component name, footprint name, or use wild cards), then place the components individually using the Next Comp command.

To place components individually

1. Choose the Component toolbar button.
   or
   Choose Component from the Tool menu.

2. Choose Select Criteria from the pop-up menu.
   or
   Choose Select Criteria from the Edit menu.

   The Component Selection Criteria dialog box displays.

   Note The Select Criteria command and the Select Any command display the same dialog box, but have different functions. The Select Criteria command makes certain components available for placement by the Next Comp command. The Select Any command actually selects specified components or groups for placement, attaching them to the cursor.

3. Enter the name or (other criteria) of the component that you want to place in the appropriate text box and choose the OK button.

   Tip Usually, when you use the Select Criteria command, you will want to make more than one component available for placement. You can specify more than one component using wild cards; you can use an asterisk (*) as a substitute for multiple characters and a question mark (?) as a substitute for a single character. For example, if you enter U*, you will select all components with names beginning with the letter U.

4. Choose Next from the pop-up menu.
   or
   Choose Next from the Edit menu.

   The component snaps to the cursor. If you selected a group (such as all components with names beginning with the letter U), then the component with the greatest number of connections that meets that criterion snaps to the cursor.

5. Drag the component to the desired location and click the left mouse button to place it.
### Component Selection Criteria dialog box

![Component Selection Criteria dialog box](image)

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Comp Name</strong></td>
<td>This option is used to specify components by name. You can use the question mark (?) wild card as a substitute for a single character, or the asterisk (*) wild card as a substitute for any number of characters. The default is all components.</td>
</tr>
<tr>
<td><strong>Footprint Name</strong></td>
<td>This option is used to specify footprints by name. You can use the question mark (?) wild card as a substitute for a single character, or the asterisk (*) wild card as a substitute for any number of characters. The default is all footprints.</td>
</tr>
<tr>
<td><strong>Group Number</strong></td>
<td>This option is used to select all components belonging to a certain Comp Group (component group), which is an attribute assigned in the schematic and brought into Layout. Group numbers range from 1 to 100.</td>
</tr>
<tr>
<td><strong>Minimum Pins or Maximum Pins</strong></td>
<td>These options are used to exclude or include components with a certain number of pins.</td>
</tr>
<tr>
<td><strong>Exclude placed</strong></td>
<td>This option is used to direct Next Comp to bring only unplaced components to your cursor. This is helpful if you have unlocked pre-placed components on the board.</td>
</tr>
<tr>
<td><strong>Exclude locked</strong></td>
<td>This option is used to direct Next Comp to bring only unlocked components to your cursor.</td>
</tr>
</tbody>
</table>
Selecting the next components for placement

Use the Select Next command (available on the Edit menu and the pop-up menu) to display a dialog box that lists the components yet to be placed. If you made components available for placement according to certain criteria (using the Component Selection Criteria dialog box), Layout displays only the components that remain to be placed that meet that criteria. From this list, you can select the next component that you want to place.

If there are too many components to list, Layout displays a dialog box that reports the number of components that remain to be placed. The default selection that appears in the text box is the one that Layout would automatically choose if you used the Next Comp command. You can accept the default, or enter a new choice.

To select the next component for placement using Select Next

1  Choose the Component toolbar button.
   or
   Choose Component from the Tool menu.

2  Choose Select Next from the pop-up menu.
   or
   Choose Select Next from the Edit menu.

   The Select Next dialog box displays.

3  Select the component for placement, or enter the component name in the text box.
Placing component groups

You can assign functionally related components to groups at the schematic level. When you specify the group number (as assigned in the schematic) in the Component Selection Criteria dialog box, the components assigned to the group snap to the cursor for placement.

To place a component group

1. Choose the Component toolbar button.
   or
   Choose Component from the Tool menu.
2. Choose Select Any from the pop-up menu.
   or
   Choose Select Any from the Edit menu.

   The Component Selection Criteria dialog box displays.
3. Enter the group number, as assigned at the schematic level, in the Group Number text box and choose the OK button.

   The group of components snaps to the cursor.
4. Click the left mouse button to place the components on the board.

   The group was placed in the middle of the board.
Using manual placement commands to optimize placement

Layout Ltd., Layout, and Layout Plus offer a variety of manual placement commands that you can use to place components on the board, and to enhance placement. They are described in this section.

See For information on enhanced interactive placement commands offered only in Layout Plus, see Using enhanced interactive placement commands in Layout Plus in the OrCAD Layout for Windows Autoplacement User's Guide.

Minimizing connections

Use the Mincon command to evaluate the connections within a signal and find the shortest route for the signal (ratsnest) based on the placement of the pins or components on the board. When nothing is selected, Mincon is a global command; it affects the entire board each time you apply it. However, if you have selected one or more components, Mincon only affects the nets attached to the selected components.

In Layout Plus, you can enable dynamic reconnect by turning off the instantaneous reconnect toolbar button. Dynamic reconnect performs the Mincon function automatically whenever you move components on the board. In Layout and Layout Ltd., however, you must choose the Mincon command every time you want to minimize the connections between components.

See For more information on dynamic reconnect in Layout Plus, see Turning on the reconnection environment in the OrCAD Layout for Windows Autoplacement User's Guide.

To use the Mincon command

1 Choose the Component toolbar button.

or

Choose Component from the Tool menu.

2 Choose Mincon from the pop-up menu.

Layout minimizes the connections between components.
Copying, moving, and deleting components

You can copy selected components using the Insert command and delete them using the Delete command. You can switch between move mode and edit mode using the Move On/Off command. When you select a component, you can immediately begin moving it. If you choose Move On/Off, the component remains selected but freezes in place and can only be moved using the arrow keys. If you select a component using CTRL+left mouse button or SHIFT+SPACEBAR, it will remain stationary until you drag the cursor while pressing the left mouse button, or until you press an arrow key.

To copy a component

➤ Choose Insert from the pop-up menu.
  or
    Press the INSERT key.

To move a component

➤ Choose Move On/Off from the pop-up menu.

To delete a component

➤ Choose Delete from the pop-up menu.

Swapping components

Use the Swap command to swap the position of two selected components.

To swap components

1 Select two components.

Tip You can select two items by clicking on the first item, holding down CTRL, and clicking on the second item. You can also area select two items using the click and drag method.

2 Choose Swap from the pop-up menu.
  or
    Choose Swap from the Edit menu.

The selected items switch places.
Rotating components

The Rotate command rotates any selected components around the lower left corner of the component (or component area, if you select more than one component), based on the Increment setting in the System Grids dialog box. The relationships between the components you select remain the same. The entire group rotates around the lower left corner, rather than each component rotating in its place.

To rotate components

1. Select one or more components.
2. Choose Rotate from the pop-up menu.
   or
   Choose Rotate from the Edit menu.

   The selected items rotate based on the increment setting in the System Grids dialog box.

Tip To change the rotation increment, choose Grid from the Options menu, then type the number of degrees you want the components to rotate in the Increment text box in the System Grids dialog box. The default rotation increment is 90°. You can also set a rotation increment to minute precision by typing the degrees of rotation followed by a space, followed by the number of minutes. You generally want to make the increment divisible by 360°, so that the component returns to 0° rotation when it comes fully around.

Mirroring components using the Opposite command

The Opposite command mirrors the components you have selected in the X dimension to the opposite side of the board. If you area select a number of components and choose the Opposite command, the relationships between the components you selected remain the same. The entire group mirrors around the X axis, rather than each component mirroring in place.

To mirror components

1. Select one or more components.
2. Choose Opposite from the pop-up menu.
   or
   Choose Opposite from the Edit menu.

   The components are mirrored to the other side of the board.
Placing components using a matrix

In Layout and Layout Plus, you can also place components in matrices. Matrix placement is useful for placing groups such as memory arrays and discrete components. You can create a matrix of any size anywhere on the board. Then you can place a group of components in the matrix using Matrix Place.

Note This command is not available in Layout Ltd.

To place components using a matrix

1. Choose Matrix from the Tool menu.
2. Place the pointer at the desired location for upper left corner of the matrix and, pressing the left mouse button, drag the mouse to the desired lower left corner and click the left mouse button. By moving the pointer up and down or left and right within the matrix, you can create the desired number of cells. Click the left mouse button to stop drawing.
3. Choose the Component toolbar button.
   or
   Choose Component from the Tool menu.
4. Select a group of components to place in the matrix.
5. Choose Matrix Place from the pop-up menu.
   or
   Choose Matrix Place from the Edit menu.

The parts are placed into the matrix.

The components in the upper right corner of the board are placed in a matrix.
Chapter 8  Placing and editing components

To move a matrix line

- Click the left mouse button on any matrix line and move the mouse up or down for horizontal lines, or left or right for vertical lines.

To move an entire matrix

- If you area select the matrix, you can move the entire structure in any direction.

To add a new line to a matrix

- Click the left mouse button on any matrix line (horizontal or vertical) and the press INSERT key to create a new line of the same type.

To copy a matrix

- If you area select the matrix and press INSERT, you create a new, identical matrix.

To delete a line from a matrix

- Click the left mouse on any matrix line (horizontal or vertical) and press the DELETE key.
Chapter 8  Placing and editing components

Using circular placement

Circular placement may begin with or without selecting a component. You use the Circular Placement dialog box to set up circular placement.

**Note**  You cannot select multiple components for circular placement. If you do select more than one component, Layout chooses one from the selection to use for circular placement.

If a component is selected, its current footprint name, group number, location (relative distance from circle center), rotation, radius, start angle from (0,0), and component angle are included in the dialog when you open it. If you change the values for location, rotation, radius, or angle, it causes the component to be moved or rotated. Changing the reference designator does not affect the selected component.

During circular placement, the board datum temporarily shifts to the center of the proposed circle or arc. The values in the dialog are calculated relative to this temporary datum.

When you enter values for certain options in the dialog box, Layout calculates the effect of the values on other parameters within the dialog. For example, consider a board with its circle center at 0, 0. If you set the circle’s radius to 1000 mils and the Start Angle to 45 degrees, the Rel Start will automatically calculated to 707.100, 707.100. These values display when you tab to another option in the dialog, click in another field, or when you choose the OK button.

There is no error checking available to prevent component overlap. Angular values must be positive or negative values within the range of 0 to 360 degrees. Real numbers are supported as are degrees and minutes. For example, an angle of 45.5 degrees is equivalent to 45 degrees 30 minutes and both values are supported.

The following dialog box values are pre-set based on a selected component:

- Footprint Name
- Group Number
- Circle Radius
- Start Angle
- Rel Start X, Y
- Comp Angle

If a component is not pre-selected, all dialog box values are persistent upon reinvocation of the dialog box with the exception of Ref Des. If a component is pre-selected, the following dialog values are persistent upon reinvocation of the dialog box:

- Comp Count
- Angle To Fill
- Angle Between

112  OrCAD Layout for Windows User's Guide
Chapter 8 Placing and editing components

- Comp Angle Increment
- Added Comp Angle

**Note** Blank fields are not legal.

To use circular placement

1. With no component selected, choose the Circular Placement command from the Auto menu. In the Circular Placement dialog box, choose the Footprint button and locate and select the footprint that you want to use for circular placement.

**Note** In the Select Footprint dialog box, select Local in the Libraries window to select a part from your current board file.

or

In the design window, select a component while pressing the CTRL key. From the Auto menu, choose Circular Placement. In the Circular Placement dialog box, the footprint name, group number, relative location to circle center, current rotation, current radius from circle center, current start angle from (0,0), and component angle are entered for you.

**Note** You can also select a component using Select Criteria and Next as described in Placing components using manual placement in this chapter.

2. Enter new values as desired for the dialog box options. The options are automatically calculated and updated according to the interrelationships of their values. See Autoupdating in this section for specific information.

3. Enter the number of components that you want to place in the Comp Count text box and select the Use Angle to Fill or Use Angle Between option. The Comp Angle Increment is automatically calculated based on these entries.

**Note** The Comp Count includes the selected component.
4 Choose the OK button. The components are placed according to the values specified.

**Note** Circular placement can be reversed using the Undo command only immediately after execution, but not following any subsequent commands.

---

**The Circular Placement dialog box**

- **Footprint**: Displays the Select Footprint dialog box, in which you can select a library and then a footprint for circular placement.

- **Reference Des**: The reference designator for the selected component. Default shown is the next unused reference designator for the Layout design file. Or, you may choose your own unique reference designator.
Chapter 8  Placing and editing components

**Group Number**  Group number to associate with added components. The default is 0 (zero), meaning components do not belong to any group.

**Circle Center X, Y**  Coordinates of the circle center.

**Rel Start X, Y**  Placement location for first component added. This value is measured as a relative distance from the Circle Center value. If a component has been selected on the board, changing these values will cause the selected component to move and placement to begin from this new location.

**Circle Radius**  Radius of the circle of placed components. The radius is measured from the circle center to the component placement point. The component is placed with its origin on this placement point.

**Start Angle**  Beginning placement angle of first component added or selected.

**Comp Count**  The total number of components to be added, inclusive of a selected component.

**Use Angle to Fill**  Toggle button to select between Angle to Fill and Angle Between.

**Use Angle Between**  Toggle button to select between Angle to Fill and Angle Between.

**Angle to Fill**  The angle to be filled by added components.

**Angle Between**  The space or angle between each added component's placement point.

**Comp Angle**  The rotational angle of each added component. Changing this value will cause a selected component to rotate.

**Comp Angle Increment**  A successive rotation angle increment for each added component, calculated before placement. This will not affect a selected component, however each added component will be rotated by this increment based on previous components rotation. For example, starting at 0, a Comp Angle Increment value of 20 degrees would cause components to be rotated before placement at 0, 20, 40, 60, degrees, and so on.

**Added Comp Angle**  A rotational angle that is added to each component after it is placed. This command rotates the individual components in place, around their graphic origins. For example, starting at 0, if the Comp Angle Increment is 20 and Added Comp Angle is 5 the component rotations would be 5, 25, 45, 65.

---

**Note**  Certain dialog box options are automatically updated to reflect how they are affected when other dialog box values are changed. The updated values display when the focus is changed in the dialog box by using the TAB key or clicking the left mouse button on any other item in the dialog. They are also updated when you choose the OK button to exit the dialog box. The relationships are explained in *Autoupdating* in this section.
Autoupdating

Certain dialog box options are automatically updated to reflect how they are affected when other dialog box values are changed. The updated values display when the focus is changed in the dialog box using the TAB key, or by clicking the left mouse button on any other item in the dialog. They are also updated when you choose the OK button to exit the dialog box. These relationships are listed below:

- Changing Circle Center X, Y automatically updates Circle Radius, Start Angle, Rel Start X, Y, and Comp Angle.
- Nothing automatically updates Circle Center X, Y.
- Changing Circle Radius automatically updates Rel Start X, Y.
- Changing Start Angle sets Comp Angle to the same value, and automatically updates Rel Start X, Y (by default, Start Angle and Comp Angle should be the same).
- Changing Rel Start X, Y automatically updates Circle Radius, Start Angle, and Comp Angle.

**Note** By default, Start Angle and Comp Angle should be the same. However, the user can change Comp Angle and it will not update any other option.

- Changing Comp Count automatically updates Angle to Fill, Angle Between, and Comp Angle Increment.
- Nothing automatically updates Comp Count.
- Changing Angle to Fill automatically updates Angle Between and Comp Angle Increment.
- Changing Angle Between will set Comp Angle Increment to the same value and will automatically update Angle to Fill.

**Note** By default, Angle Between and Comp Angle Increment should be the same. However, the user can change Comp Angle Increment and it will not automatically update anything else.
Editing components

You can edit the component name, the footprint name, create mirrored components, lock or fix components, and enable or disable components for placement using the Edit component dialog box.

See You can also edit component obstacles and pins attached to separate components by choosing the Allow component edits on board toolbar button. For more information, see the Toolbar topic in Layout’s online help.

To edit components

1. Select one or more components.
2. From the pop-up menu, choose Modify.
   or
   From the toolbar, choose the Mod button.
   The Edit Component dialog box displays.
3. Edit the dialog box options as desired.
4. Choose the OK button to exit the dialog box.

Edit Component dialog box

Component Name Component Name is the reference designator, and can be changed at any time (up to 100 characters are allowed). Layout remembers an infinite chain of name changes for back annotation purposes.
X and Y  The X and Y fields contain the coordinates of the component’s origin, relative to the board’s [0, 0] origin. The coordinates are displayed in the units of measurement (mils, inches, microns, millimeters, or centimeters) that you selected in the Display Units dialog box (available when you choose Units from the Options menu).

Rotation  The rotation of a component can be specified in degrees (0 to 360) and minutes (0 to 60) of rotation from the origin of the component’s associated footprint. If you type an integer without a suffix, Layout assumes it is in degrees. If you type two integers separated by a space, Layout assumes the second integer to be minutes of rotation. A single quote is optional, to indicate that the second integer represents minutes.

Tip  If you are going to be rotating many components at odd angles, you can use the Increment field in the System Grids dialog box (accessed by choosing Grid from the Options menu) to set the rotation increment globally, so that you can use the Rotate command on the pop-up menu to rotate components.

Group #  A group number (0 to 100) is a permanent way of organizing components and helping Layout recognize which components should be grouped together, regardless of the phase of the design. Typically, the component group number comes directly from the schematic input.

Fixed  Fixed components are permanently placed in a given location. The fixed designation can only be overridden by selecting the fixed component in the design, opening the Edit Component dialog box, and disabling the Fixed option.

Locked  Locked components are temporarily placed in a given location. The locked designation can be overridden by selecting the locked component, then choosing the OK button when a dialog box with the message “One or more components locked. Override?” displays. You can also override the locked designation by selecting the locked component, opening the Edit Component dialog box, and disabling the Locked option.

Non-Electric  A non-electrical component is a component that does not display on the schematic. If a component, such as a mounting hole, displays on the board but not on the schematic, and you do not want the component to be deleted when you run AutoECO, you must designate it as Non-Electric.
Selecting an alternate footprint

You can use Layout's Select Footprint command to select alternate footprints for components on the board.

You may want to select an alternate footprint for a component if you are changing component technology. For example, you may want to replace a through-hole part with an SMT part. Or, you may find that two components can be functionally replaced by one component.

You can use the Select Footprint dialog box (accessed by choosing the Footprint button in the Edit Component dialog box) to change a component's footprint. When you do so, the previous footprint becomes an alternate, which is then listed in the Footprint Selection dialog box for that component.

To select a new footprint for a component

1. Choose the Component toolbar button.
   or
   Choose Component from the Tool menu.
2. Double-click on a component.
   The Edit Component dialog box displays.
3. Choose the Footprint button.
   The Select Footprint dialog box displays.
4. In the Libraries window, select the library from which you want to select a footprint. Choose the Add button to locate the library if necessary.
5. In the Footprints window, select the footprint. The footprint displays in the preview window.
6. Choose the OK button twice to dismiss the dialog boxes.
   The footprint for the component is replaced. The alternate footprint is now available for selection in the Footprint Selection dialog box as explained next.

To select an alternate footprint

1. Choose the Component toolbar button.
   or
   Choose Component from the Tool menu.
2. Select a component.
3. Choose Select Footprint from the pop-up menu.
   The Footprint Selection dialog box displays.
4. Choose the desired alternate footprint and choose the OK button.
Select Footprint dialog box

![Select Footprint dialog box]

**Note**  If you change a footprint on the board, be sure to back annotate the change to the schematic.

- **Libraries**  Lists the libraries that are available for the current Layout session.
- **Add**  Locate libraries and add them to the list of available libraries for the current Layout session. This list displays in the Libraries window.
- **Remove**  Remove selected libraries from the Libraries window.
- **Footprints**  Lists the footprints that are contained in the libraries that are selected in the Libraries window. Select a footprint to display a graphical preview.
Adding components to the board

If you add a spare component to the design, such as a mounting hole, or if you did not bring in a netlist and are therefore adding components to the design manually, you can use the Add Component dialog box to bring components into the design.

To add components to the board

1. In the Layout design window, choose the Component toolbar button.
2. From the pop-up menu, choose Insert.

The Add Component dialog box displays.

3. Choose the Footprint button. The Select Footprint dialog box displays.
4. In the Libraries window, select the library from which you want to select a footprint. Choose the Add button to locate the library if necessary.
5. In the Footprints window, select the footprint. The footprint displays in the preview window.
6. Choose the OK button twice to dismiss the dialog boxes. The footprint is attached to the cursor.
7. Place the footprint in the desired location on the board by clicking the left mouse button.

See For information on creating a board without importing a netlist, see Layout’s on-line help.
Running Place Design Check

Before you route the board, you should run the Place Design Check. The Place Design Check looks for component-to-component spacing violations and for other placement errors, such as components that violate height restrictions, components that violate insertion outlines, and components that violate grid restrictions.

Place Design Check uses the component outlines to determine whether there is a spacing violation. Therefore, component outlines should encompass the entire area of the IC or discrete component, including such objects as pin-out patterns and sockets.

Any problems found by Place Design Check are marked by a circle and can be queried using the Error tool and query window.

See For information on how to use the error tool to get more information about reported errors, see Querying flagged errors in Chapter 11: Ensuring manufacturability.

To run Place Design Check

- From the Auto menu, choose Place Design Check.

Layout checks the board for component placement violations.

Viewing component placement statistics

When you finish placing components on the board, you can view the component placement statistics in the Statistics spreadsheet. The spreadsheet shows the percentage and number of components placed, how many were placed off the board, and how many were placed in clusters.

To view the component placement statistics

1 Choose the spreadsheets toolbar button.
2 Select Statistics from the drop list.

The Statistics spreadsheet displays.
3 Scroll until you find the Place data.
Routing the board

After you have placed the components, you can route the board to form the electrical connections between the components. This chapter explains how to route the board manually, and describes the manual routing commands.

You can route the entire board manually using the commands in this chapter. Or, if you have purchased Layout or Layout Plus, you can use the autorouter and enhanced manual routing commands to route the board, and then use the manual routing commands described in this chapter to optimize routing. The information in this chapter is helpful whether you are performing manual routing or autorouting.

See For information specific to autorouting and enhanced manual routing, see the OrCAD Layout for Windows Autorouter User's Guide.

You probably defined the following parameters when you set up the board. If not, you need to do so before you route the board.

- Designate layers as plane layers
- Define vias
- Set or verify net attributes

See For information on designating plane layers, defining vias, and setting net attributes see Chapter 5: Setting up the board.

After you have checked the above items, you are ready to begin the routing process. The steps in the manual routing processes are listed below.

- Check the board outline, via definitions, and routing grid
- Load a strategy file
- Fanout SMDs or verify connections to power and ground on predominantly through-hole boards
- Route the remaining signals
- Optimize routing using the manual routing commands
- Run design for manufacturability checks

See For information on running design for manufacturability checks, see Chapter 11: Ensuring manufacturability.
Preparing the board for routing

Before you route, check the parameters you defined when you set up the board. If you are not satisfied with the settings, you can load a new technology template at this time, or you can adjust the settings individually.

Specifically, this section describes how to check the settings for the board outline, vias, and routing grid. This is helpful whether you plan to route the board manually or using autoroute.

See For a complete description of the technology templates, see Technology templates in Appendix A: Understanding the files used with Layout. For instructions on how to load templates, see Using technology templates in Chapter 5: Setting up the board.

Checking the board outline

Before routing the board, verify that the board outline has a desirable amount of internal clearance and that there is only one board outline in your design.

To check the board outline

1. Choose the spreadsheets toolbar button.
2. Select Obstacles from the drop list.

The Obstacles spreadsheet displays.

See For information on creating and editing a board outline, see Chapter 5: Setting up the board.
Checking via definitions

You should inspect the vias in the Padstacks spreadsheet to make sure that they are the right size and on the correct layer.

To check vias

1. Choose the spreadsheets toolbar button.
2. Choose Padstacks from the drop list.
   The Padstacks spreadsheet displays.
3. Check the size and layer of the vias.

See For information on defining vias, see Defining vias in Chapter 5: Setting up the board.

Checking the routing grid

The routing grid sets the grid for the placement of tracks on the board. To set the routing grid options, use the System Grids dialog box.

To set routing grid options

1. From the Options menu, choose Grid.
   The System Grids dialog box displays.
2. In the Routing grid text box, enter the desired value for the routing grid.
3. In the Via grid text box, enter the desired value for the via grid.
4 If desired, select one or more of the routing options described below.

- *Allow off-grid routing.* Route off-grid.
- *Use all via types.* Use more than the standard via type.
- *Unrestricted via spacing.* Allow vias to be placed closer to the SMT pads.
- *Shove components.* Enable shove components (available in Layout Plus).

5 Choose the OK button to accept the settings and close the dialog box.

The following chart is a synopsis of routing grids and how to use them in Layout.

<table>
<thead>
<tr>
<th>Grid</th>
<th>Uses</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Compatible grids 25, 12(\frac{1}{2}), 8(\frac{1}{6}), and 6(\frac{1}{4})</strong></td>
<td></td>
</tr>
<tr>
<td>25, 12(\frac{1}{2})</td>
<td>Use for less dense (usually .45 density or greater) through-hole and SMT boards, and for routing one track between IC pins.</td>
</tr>
<tr>
<td>8(\frac{1}{3})</td>
<td>Use for a secondary grid on through-hole boards, and for a primary grid on SMT boards. Use as a secondary grid with 25 mils grid only if the 25 mils grid initially routes 95% or better.</td>
</tr>
<tr>
<td>6(\frac{1}{4})</td>
<td>Use for 6/6 technology, or more dense one-between boards.</td>
</tr>
<tr>
<td><strong>Compatible grids 20 and 10:</strong></td>
<td></td>
</tr>
<tr>
<td>20</td>
<td>Use for through-hole boards only. This is the most efficient way to route two tracks between IC pins.</td>
</tr>
<tr>
<td>10</td>
<td>Use for through-hole, two-between boards placed on a 50 mils grid and for SMT boards using 10/10 technology. Also, use for special cases when a 20 mils grid causes off-grid jogs.</td>
</tr>
<tr>
<td><strong>Compatible grids 25, 20, and 10:</strong></td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Use for extremely dense SMT boards that use 5 mils spacing and 5 mils track width, especially for mixed imperial and metric technologies.</td>
</tr>
</tbody>
</table>

**Note** Incompatible grids such as 20 and 25 should not be mixed on the same board. If you find it necessary to do so, use a 5 mils grid for the final reroute pass. Also, a via grid smaller than the routing grid (for instance, a 5 mils via grid on a 25 mils grid board) increases completion on difficult SMT boards.

Of course, if a board is very dense, via sizes should be reduced to the minimum size possible as vias are responsible for much of the channel blockage during routing.
Defining a DRC Box

Using a DRC box, you can define and zoom in to the densest area of the board, or another location at which you want to begin routing. If you are autorouting, the router automatically begins routing the board at the area you designate using the DRC box command. If you are manually routing, you still benefit by using the DRC box; Layout zooms in to the area encompassed by the box and centers it on the screen.

To define a DRC Box
1. From the View menu, choose DRC Box. The cursor changes to a “Z.”
2. Place the cursor at one corner of the box you would like to define.
3. Click and hold down the left mouse button, then drag the cursor to the opposite corner of the area you would like to define.
4. When you have the box the size you want, release the left mouse button.
   Layout zooms in on the area.

Tip: To cancel this command, press the ESC key before you release the left mouse button.

To move a DRC Box
1. From the View menu, choose DRC Box. The cursor changes to a “Z.”
2. Move the cursor to the target location.
3. Click the left mouse button.
   Layout centers the location on the screen.

Tip: To move the DRC Box without zooming in or changing the aspect ratio of the graphics, position the DRC Box cursor (“Z”) over what is to be the center of the new box, type an asterisk (*) using the numeric keypad, then choose End command from the pop-up menu.

Tip: If you are manually routing, you should move the DRC Box to the area you are routing, then release it using the space bar.
Chapter 9  Routing the board

Routing the board manually

When you view the printed circuit board before routing has occurred, you see the parts, and many fine, hair-like lines running between them. The lines are known as the ratsnest. The ratsnest lines represent the connections that need to be routed to form the necessary connections on the board.

**Note** Yellow triangles in the ratsnest indicate unrouted, zero-length connections (connections that lead directly from a pad on the top layer to a pad on the bottom layer). These connections need to be routed using a via.

When routing the board, make the necessary connections to the plane layers first, and then route the remaining tracks.

*See* Before routing, run a Place Design Check and a full-board Board Space Check, and be sure to correct any spacing violations before starting to route. For information on running Place Design Check, see *Running Place Design Check* in Chapter 8: Placing and editing components. For information on running Board Space Check, see *Running Board Space Check* in Chapter 11: Ensuring manufacturability.

*Tip* Before you begin routing the board, save your board file.

Loading a routing strategy file

In manual routing, a strategy file sets up the appropriate graphical display for routing. There are many strategy files provided with Layout. Load the strategy file that is most suitable for your board.

*See* For a complete list of routing strategy files provided with Layout, see *Strategy files* in Appendix A: Understanding the files used with Layout.

**To load a routing strategy file**

1. From the File menu, choose Load Strategy. The Load Strategy File dialog box displays.

2. Select a strategy file from the files listed, then choose the OK button.
Routing power and ground

In Layout, plane layers are typically used for power (VCC) and ground (GND). When routing multilayer boards, it is essential to route power and ground first. To do so, you should enable power and ground nets for routing and disable all other signals for routing. This causes all signal ratsnest lines to disappear.

See Before you can route power and ground, you need to designate plane layers in the layer stack. For information on designating layers as plane layers, see Chapter 5: Setting up your board.

On SMT boards, you must perform manual fanout to connect SMDs to the plane layers.

On through-hole boards, the appropriate nets are automatically attached to the plane layers with thermal reliefs. If power or ground did not connect to the plane, one of three errors may have occurred in the netlist: the global power pin is not defined in the part, the pin is not connected to the proper signal, or if the pin is connected, it does not have the correct signal name. To remedy the problem, you can either modify the schematic and reannotate, or you can modify the board by adding a pin to the signal. Keep in mind that this board modification cannot be back annotated to the schematic.

Connections to the planes may be verified prior to post processing by verifying that only nets to be connected to the planes are enabled, then referring to the Statistics spreadsheet to verify that these nets are 100% routed. If anything less than 100% routing is displayed in the Enabled column in the Statistics spreadsheet, the remaining connections may be found (in the design window) by selecting a routing tool and choosing Next from the pop-up menu.

See You can also view the thermal connections using the post process preview. For more information, see Previewing thermal reliefs in Chapter 10: Using thermal reliefs and copper pour zones in the OrCAD Layout for Windows User’s Guide.

See For information on adding pins to nets, see Adding pins to nets in this chapter.

After routing power and ground nets, you must disable them and enable all other signals for routing. Then you can route the remaining signals.

Tip Since ratsnest lines are only displayed for enabled nets, you can control which ratsnest lines are visible by controlling which nets are enabled for routing.
The steps in the power and ground routing process are listed below:

- Enable the power and ground nets for routing and disable the other nets
- On SMT boards, perform manual fanout to connect SMDs to the plane layers
- On predominantly through-hole boards, verify proper connection to the plane layers
- Disable the power and ground nets for routing and enable the remaining nets

**To enable power and ground for routing**

1. Choose the Spreadsheet toolbar button.
2. From the drop list, choose Nets. The Nets spreadsheet displays.

![Nets spreadsheet](image)

3. Double-click in the title cell of the Routing Enabled column.
   
   The Edit Net dialog box displays.

4. In the Net Attributes group box, deselect the Routing Enabled option, then choose the OK button.
   
   The Routing Enabled for all nets changes to No.

5. While the Nets spreadsheet is displayed, press the TAB key to invoke the Net Selection Criteria dialog box.
6. Enter VCC in the Net Name text box provided, then choose the OK button.
   
   The VCC net is highlighted in the Nets spreadsheet.

7. From the pop-up menu, choose Modify.
   
   The Edit Net dialog box displays.

8. Select the Routing Enabled option.

---

130  *OrCAD Layout for Windows User's Guide*
Chapter 9  Routing the board

9 Choose the Net layers button to invoke the Layers Enabled for Routing dialog box.

10 Select POWER in the Plane Layers group box.

11 Choose the OK button twice to dismiss the dialog boxes.

The Routing Enabled for the VCC net changes to Yes*.

12 Repeat steps 5 through 11 for the ground net, using GND as the net name and the plane layer.

13 Close the Nets spreadsheet.

Note  In the Nets spreadsheet, the asterisk (*) next to the Yes or No indicates that the net has special layer considerations. For example, it could indicate that the net is connected to a plane, or that one of the routing layers is disabled for the net. You can check which layers are enabled for a given net using the Enable Layers for Routing sub-dialog box accessed through the Edit Net dialog box.

To verify connections to the planes

1 Open the Statistics spreadsheet and locate the Enabled column for routing. You should see a value of 100% in the Enabled column indicating that the appropriate nets are indeed connected to the plane layers.

2 If the value is anything less than 100%, choose a routing tool and choose Next from the pop-up menu.

The window centers on the offending connection. The connection attaches to the cursor for routing.

3 Connect the net to the appropriate plane layer.

To manually fanout surface mount devices

1 Choose the Gridded Manual Route tool.

2 Select a VCC or GND net for routing.

3 Route the net to the point at which you want to insert the via.

4 Press the SPACEBAR to insert a corner.

5 Choose Insert Via from the pop-up menu to connect the net to the plane layer.

To route power and ground on a board with no plane layers

1 Choose the Gridded Manual Route without shove tool.

2 Select the VCC or GND net.

3 Route the net.
To disable the power and ground nets and enable other nets

1. Choose the spreadsheets toolbar button.

2. Select Nets from the drop list.
   
The Nets spreadsheet displays, showing Routing Enabled set to Yes* for VCC and GND, and set to No for the rest of the nets.

3. Click once in the title cell of the Routing Enabled column.
   
The entire column is highlighted.

4. From the pop-up menu, choose the toggling Enable<->Disable command.
   
The Routing Enabled for the VCC and GND nets changes to No*, and the Routing Enabled changes to Yes for the rest of the nets.
Using the Gridded Manual Route without shove tool

You can use the Gridded Manual Route without shove tool to create new tracks and edit existing tracks without unrouting them, by placing your cursor on any routed vertex or segment and clicking the left mouse button. If you pick up a track connection using Manual Route, you can continue installation of the track, a segment at a time, at a 45° or 90° angle.

Note When modifying tracks, you may see slightly different effects, depending on whether you are editing a segment or a vertex. For example, if you place your pointer directly on top of a vertex and click the left mouse button, the router picks up only the vertex and the two immediately adjacent segments. On the other hand, if you select a segment, you are basically rerouting the track. You can specify the effect of route selection in the User Preferences dialog box by selecting Vertex Mode, Reroute Mode, or Segment Mode.

When you select a track with the left mouse button at a location where there is copper on more than one layer, the router edits the track that is on the current layer.

If you pick up an existing track, press the SPACEBAR, and type a layer number, the track switches to the new layer, and vias are installed automatically where necessary. If it is impossible to clear room for the vias, the router responds with beeps and does not switch the track.

Tip You can copy tracks by selecting an area (even if that area encompasses only one track), and pressing INSERT. This is particularly useful for any repeated circuitry, such as round IC test boards with repeated circuitry.

To manually route a track

1 Choose the Gridded Manual Route without shove toolbar button.
2 Choose Zoom In from the View menu and click the left mouse button to magnify the area to route.

Note By default, the DRC (Design Rules Check) is always on for routing. To temporarily disable Design Rules Checking, choose the DRC off toolbar button.

3 Select a ratsnest with the left mouse button. The ratsnest is attached to the cursor when it is selected.
4 Drag the cursor to draw the track on the board.
5 Click the left mouse button or press the spacebar to create vertices (corners) in the track.
6 When drawing the last segment for the connection, click the left mouse button. The track automatically connects to the center of the pad. A complete connection is indicated by the cursor changing size (bigger) and the ratsnest disappearing from the cursor.

Note The final segment must meet the target pad at a 90° or 45° angle to finish.
Chapter 9  Routing the board

Using Manual Route in Mincon mode

Using the Manual Route command with Mincon Mode selected in the User Preferences dialog box automatically reconnects routes to the nearest vertex or pin in the routing window.

To use the Manual Route tool in Mincon mode

1. Choose User Preferences from the Options menu.
   The User Preferences dialog box displays.
2. In the Manual Route Default Mode group box, select the Mincon Mode option and choose the OK button.
4. Pick the connection you want to alter and begin routing the track. As you close in on your target, your connection automatically reconnects to the new pin or vertex of an existing route.
5. When your connection is attached to the proper pin, click the left mouse button to accept the attachment.

The new reconnection pattern displays.

Using manual route in Mincon mode.
Using the Gridless Route tool

When using the Gridless Route tool, you can place tracks without regard to the routing grid. It does not matter if DRC is enabled or disabled in this mode.

To manually route a track

1. Choose Gridless Route from the Tool menu.
2. Choose Zoom In from the View menu and click on the screen to magnify the area to route.

Note: By default, the DRC (Design Rules Check) is always on for routing. To temporarily disable Design Rules Checking, choose the DRC off toolbar button.

3. Select a ratsnest with the left mouse button.
   - The ratsnest is attached to the cursor when it is selected.

4. Drag the cursor to draw the track on the board.

5. Click the left mouse button to create vertices (corners) in the track. When drawing the last segment for the connection, click the left mouse button. The track automatically connects to the center of the pad. A complete connection is indicated by the cursor changing size (bigger) and the ratsnest disappearing from the cursor.

Tip: You can add a vertex by positioning the cursor at the desired position and pressing the SPACEBAR.
Using the Curve Route tool

In Layout, you can easily place a curved route. With the Curve Route tool, you can create curved tracks and horizontal or vertical tracks. It does not matter if DRC is enabled or disabled when you are using this tool.

To create a curved route

1. From the Tool menu, select Curve Route.
2. Select an unrouted connection.
3. Move the pointer to begin drawing the track.
4. Click the left mouse button to create a vertex.
5. Drag the cursor to create the desired curve.

Creating curved routes.
Creating duplicate connections

In the design window you have the ability to insert a *duplicate connection* from a node (pad), a vertex, or a corner. A duplicate connection is a redundant circuit, or two tracks that connect to the same pads at both ends. Using this ability, you can insert guard ring connections for shielding, meet special routing requirements, or split nets.

**To create a duplicate connection**

1. Choose Zoom In from the View menu and area select the target pads to magnify them on the screen.

2. Choose the Gridded Manual Route without shove toolbar button.
   *or*
   Choose the Manual Route with Shove toolbar button.

3. Select a connection with the left mouse button.

4. Begin inserting a track to the right of the node by dragging the cursor.

5. Establish the duplicate connection by choosing Insert from the pop-up menu.

6. Continue to input the track. As you now have a duplicate connection displayed from the original pin, you can select that connection and draw another track around the left of the large pads.

*Creating a duplicate connection.*
Optimizing routing using manual routing commands

There are several commands available on the Edit menu and pop-up menus to assist you in routing a board. These commands are described below. They are available in Layout Ltd., Layout, and Layout Plus.

Minimizing connections

The Mincon command finds the shortest connection pattern possible for the ratsnest. If you have nothing selected, it reconnects the entire board. If you are dragging a connection, it tries to find the nearest endpoint for that connection.

To minimize connections

➔ Choose Mincon from the pop-up menu.

or

Choose Mincon from the Edit menu.

or

From within the Nets spreadsheet, choose Mincon from the Edit menu.

Changing the colors of nets

To change the color of a net

1. Open the Nets spreadsheet.
2. Select a net in the spreadsheet.
3. Choose Change Color from the pop-up menu.
4. Select a color from the palette that displays.
Removing tracks

There are a variety of options available for “undoing” the routing performed on a track if you are not achieving the desired results.

With one of the manual route tools active, you can access three commands for unrouting routed segments or tracks.

The Ripup Segment command rips up the segment “behind” the one you are dragging (the segments drawn before the current segment), and continues to rip up segments back to their source if you continue to use the Ripup Segment command. If you are using the DRC-enabled environment, the ripup stops at the DRC Box edge.

The Ripup Conn command rips up the track for the entire connection. If you are using the DRC-enabled environment, the ripup stops at the DRC Box edge.

The Ripup Net command rips up the tracks for the entire net, regardless of whether you are in the DRC-enabled environment or not.

There are also commands for removing whole and partial routes that you can access from the pop-up menu and Edit menu when the Nets spreadsheet is open. The Remove Partial Track command removes routes that are not complete. The Remove Center Partial removes routes that are not connected to a pad at either end. The Remove Track command removes the entire completed routes. The Remove Unlocked Track removes unlocked routes from the board.

To unroute routed segments or tracks

1 Select a track.
2 Choose Ripup Segment from the pop-up menu or Edit menu.
   or
   Choose Ripup Conn from the pop-up menu Edit menu.
   or
   Choose Ripup Net from the pop-up menu Edit menu.

To unroute routed tracks using the Nets spreadsheet

1 Open the Nets spreadsheet.
2 Select one or more nets. If you want the command to affect the whole board, click once in the Net Name title cell.
3 Choose Remove Partial Track from the pop-up menu or Edit menu.
   or
   Choose Remove Center Partial from the pop-up menu or Edit menu.
   or
   Choose Remove Unlocked Track from the pop-up menu or Edit menu.
   or
   Choose Remove Track from the pop-up menu or Edit menu.

The routed segment or entire route of the track is removed, but the net remains on the board and in the Nets spreadsheet.
Copying tracks

Use the Insert command to copy a routed track.

To copy a track
1 Select a track.
2 Choose Insert from the pop-up menu.
   or
   Press the INSERT key.

Moving segments on tracks

If you plan on doing a lot of editing of tracks on the board, you may choose to use Segment mode to facilitate the movement of track segments. The Segment command inserts a vertex that creates a segment extending from the track at the selected point at a 45° angle. This command is equivalent to selecting the Segment Mode in the User Preferences dialog box. When you choose the Segment command from the pop-up menu, it is active until you choose another command.

To move a segment
1 Select a track.
2 Choose Segment from the pop-up menu.
   or
   Choose Segment from the Edit menu.
Changing the widths of tracks

The Change Width command changes the width of the segment you are currently routing. If you have set net widths per layer using the Net Widths By Layer dialog box, you should force the width set using the Change Width command.

**To change the width of a track**

1. Select a track.
2. Choose Change Width from the pop-up menu.  
   or  
   Choose Change Width from the Edit menu.
   The Track Width dialog box displays.
3. Enter a new width for the track in the New Width text box and choose the OK button.

Forcing a net width on a layer

When you set your net attributes before routing, you may have specified a width for a particular net on a given layer. If you interactively change the width of the net using the Track Width dialog box, you can use this command to force a specified net width on a given layer.

**To force a net width on a layer**

1. Open the Nets spreadsheet.
2. Select the net with the new width in the spreadsheet.
3. Choose Force Width by Layer from the pop-up menu.

Inserting vias

The Insert Via command adds a via to the end of the selected track. This is useful for manually creating dispersion vias, which are short connections from SMT components to the internal power and ground planes.

**To insert a via**

1. Select a track.
2. Insert a corner by clicking the left mouse button or pressing the SPACEBAR.
3. Type the number of the target layer for the via (the layer numbers are available on the layer drop list on the toolbar).
4. Choose Insert Via from the pop-up menu.  
   or  
   Choose Insert Via from the Edit menu.
Changing vias

The Change Via command displays a dialog box from which you can select a new via type. The Via Selection dialog box only displays vias that have been defined by you and are therefore available for routing.

See For information on defining vias, see Defining vias in Chapter 5: Setting up the board.

To change a via

1. Select a via by clicking on the intersection of the segments with the left mouse button.

2. From the Edit menu, select Change Via.
   The Via Selection dialog box displays, listing all of the vias that are defined and, therefore, available for routing.

3. Select a new via and choose the OK button.
Using tack points

The Tack Conn command adds a corner to the selected connection, allowing you to “tack” segments of the track out of the way. Use this option when you need to see what is under a connection, and when you want to reconnect connections between pins of the same net as you are designing the board.

To use a tack connection

1. Select a track.
2. Choose Tack Conn from the pop-up menu.
   or
   Choose Tack Conn from the Edit menu.
3. Drag the track to the location of desired tack and click the left mouse button to place it.
   The track is “tacked” out of the way of the other tracks.

To remove a tack connection

1. Select the tacked track.
2. Choose the spreadsheets toolbar button.
3. Choose Nets from the drop list.
   The Nets spreadsheet displays. The selected net is highlighted in the spreadsheet.
4. Choose Remove Tack Point from the pop-up menu.
   The tack is removed from that track.

Tip You can also remove all of the tack points on the board at once. Without selecting a net on the board, choose Remove Tack Point from the Nets spreadsheet pop-up menu.
**Exchanging the ends of a track**

The Exchange Ends command exchanges the source and target of the connection so that you can route in the opposite direction. For example, if you are routing ratsnest and you accidentally pick up the wrong end of the connection, you can use this command to swap ends without releasing the connection.

**To exchange the ends of a track**

1. Select a track.
2. Choose Exchange ends from the pop-up menu.
   or
   Choose Exchange ends from the Edit menu.

**Tip** When you are modifying a track, if the router is not showing you exactly the path you would like, use the Exchange Ends command. This gives you two distinct sets of paths to choose from.

**Routing on the opposite layer of the board**

The Alternate Layer command, available from the pop-up menu, flips the track you are working on to the opposite layer of the board. If the board has more than two routing layers, this is the last layer you were routing on.

**To route on the opposite layer of the board**

1. Select a track.
2. Choose Alternate Layer from the pop-up menu.

**Locking routed tracks**

The Lock Route command locks the selected segment, and everything behind it, back to the source point.

**To lock routes**

1. Select a track.
2. Choose Lock Track from the pop-up menu.
   or
   Choose Lock Track from the Edit menu.

**To unlock routes**

1. Select a track.
2. Choose Unlock Track from the pop-up menu.
   or
   Choose Unlock Track from the Edit menu.
Creating and modifying nets

In Layout, you can create nets manually using the Interactively create or modify nets tool.

Note These modifications cannot be back annotated to the schematic design.

Creating nets

To create a net

1 Choose the Interactively create or modify nets toolbar button and choose Add Connection to Netlist from the pop-up menu.

Note When you select this option, Layout reminds you that, although you are adding the net to the board in Layout, the change will not be reflected back to the schematic design during back annotation.

2 Select a component pin.

3 Draw the new net by clicking the left mouse button on the target pad. The Modify Nets dialog box displays.

4 Enter the name of the new net.

5 Choose End Command from the pop-up menu.

Splitting nets

You can also separate a net into two separate nets interactively.

To split a net

1 Choose the Interactively create or modify nets toolbar button.

2 Choose Delete Connection from Netlist from the pop-up menu.

3 In the board design, select a net to split into two separate nets. (Do not select a pin at the end of the signal.)

   Layout asks you to confirm your decision to delete the connection. If you answer Yes, you are asked to name the new nets individually.
Adding and deleting pins connected to nets

In Layout, you can add and delete pins from nets on the board or in the Nets spreadsheet.

To add or delete pins from a net

1. Select a pin.
2. Choose Modify from the pop-up menu.
3. Enter the new net name and choose the OK button.

Or

1. Open the Nets spreadsheet.
2. Select a net in the spreadsheet.
3. Choose Connection Edit from the pop-up menu. The Modify Connections dialog box displays.
4. Enter the names of the pins in the Pins list text box.
5. Select the Add option to add pins.
   or
   Select the Delete option to delete pins.
6. Choose the OK button.

Disconnecting pins from nets

In Layout, you can easily disconnect a pin from a net without splitting the net.

To remove a pin from a net

1. Choose the Interactively create or modify nets toolbar button.
2. Choose Disconnect Pin from Netlist from the pop-up menu.
3. Select the pin. The system asks if you want to disconnect the selected pin from the net.
4. Choose the Yes button to disconnect the pin from the net.
Generating test points interactively

You can generate test points automatically in Layout and Layout Plus, or you can place them interactively during manual routing.

Layout provides great flexibility with test points. Because you can define one or more vias for use as test points, you can assign a distinctive shape or other characteristic to your test point vias. You can have as many test point vias defined as you need.

See For information on generating test points automatically, see Generating test points automatically in the OrCAD Layout for Windows Autorouter Users Guide.

To generate test points interactively

1 In the Padstacks spreadsheet, select the first via padstack that shows all layers undefined.

2 From the pop-up menu, choose the Modify command.

   The Edit Padstack dialog box displays.

3 Define the shape and size of the test point via.

4 Enable the Use for Test Point option and choose the OK button.

5 If you need additional vias available as test points, repeat steps 1 through 4. Then, close the Padstacks spreadsheet.

6 Select a manual routing tool.

7 Select the net that needs a test point, route it to the test point location, then choose the Add Test Point command from the pop-up menu. Layout places the via and flags it as a test point.
Viewing routing statistics

When you have finished routing the board, you can view the routing statistics in the Statistics spreadsheet. The spreadsheet gives the percentage and number of connections completed, via data, and more.

To view the routing statistics

1. Choose the spreadsheets toolbar button.
2. Select Statistics from the drop list.
   
   The Statistics spreadsheet displays.

3. Scroll until you find the Route data.
Using thermal reliefs and copper pour zones

This chapter explains how to use thermal reliefs and copper pour zones in your board design.

Using thermal reliefs

Thermal relief pads are used as contacts to plane layers or copper zones, for applications such as the connection to power and ground on a multilayer board. There are two things you must do before defining thermal reliefs. First, you must designate the target layer for the thermal reliefs as a plane layer in the Layers Spreadsheet. Second, a net must be assigned to the layer.

See For instructions on designating layers as plane layers and for setting net attributes, see Chapter 5: Setting up your board.

Note When viewing a plane layer, the background represents copper, and the foreground represents cleared areas.
Chapter 10  Using thermal reliefs and copper pour zones

Defining thermal reliefs

You can specify relative dimensions for the small and large thermal reliefs in your design by editing the default values set in the Thermal Reliefs dialog box. The dimension options include the sizes for annular over drill, isolation width, and spoke width.

Small thermal reliefs are used throughout the design by default. You can assign large thermal reliefs to a particular padstack in the Edit Padstack dialog box.

To specify dimensions for the thermal reliefs in your design

1. From the Options menu, choose Thermal Reliefs. The Thermal Reliefs dialog box displays.

2. In the Small Thermal Reliefs group box, edit the values in the Annular over drill, Isolation Width, and Spoke Width text fields.

3. In the Large Thermal Reliefs group box, edit the values in the Annular over drill, Isolation Width, and Spoke Width text fields.

4. Choose the OK button to accept the settings and close the Thermal Reliefs dialog box.

The Thermal Reliefs dialog box

<table>
<thead>
<tr>
<th>Small Thermal Relief</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annular over drill</td>
</tr>
<tr>
<td>Isolation Width</td>
</tr>
<tr>
<td>Spoke Width</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Large Thermal Relief</th>
</tr>
</thead>
<tbody>
<tr>
<td>Annular over drill</td>
</tr>
<tr>
<td>Isolation Width</td>
</tr>
<tr>
<td>Spoke Width</td>
</tr>
</tbody>
</table>

Annular over drill  After drilling, the width remaining between the drilled hole and the inside of the isolation ring.

Isolation Width  The width of the isolation ring that surrounds the pad.

Spoke Width  The width of the copper tie that connects the pad to the plane.

Note  The spoke width value specified in the Thermal Reliefs dialog box is used for copper pour as well as layer planes.
To assign large thermal reliefs

1. Choose the spreadsheets toolbar button.

2. Select Padstacks from the drop list. The Padstacks spreadsheet displays.

3. Double-click on the name of the padstack for which you want to assign a large thermal relief. The Edit Padstack dialog box displays.

4. Select the Large Thermal Relief check box.

5. Choose the OK button to close the Edit Padstack dialog box.

Layout assigns a large thermal relief to the padstack. It will have the relative dimensions that you specified in the Thermal Reliefs dialog box.
**Previewing thermal reliefs**

In Layout, it is possible to preview thermal reliefs to check their connections to the board. You can preview them on the layer on which they are located, or you can preview them using the Post Process spreadsheet.

**To preview thermal reliefs**

1. Press the BACKSPACE key.
   
   Layout displays a blank screen.

2. Type the number that corresponds to the layer that you want to view (for example, 3 for GND layer) (you may need to press the HOME key to refresh the screen).

   Layout paints the layer on top.

3. View the thermal connections.

![Viewing thermal reliefs while working on the board.](image-url)
To preview thermal reliefs using the Post Process spreadsheet

1. From the toolbar, choose the Post Proc. button.
2. Choose Setup Batch from the drop list.
   The Post Process spreadsheet displays.
3. Select the GND layer from the Post Process spreadsheet.
4. Arrange your windows so that you can see both the Post Process spreadsheet and the design window.
5. From the pop-up menu, choose Preview. Layout displays the preview in the design window.

![Preview of the unrouted board.](image)

*OrCAD Layout for Windows User's Guide* 153
Rules that apply to creating thermal reliefs

Layout follows the rules below to determine what pads are assigned thermal reliefs on the plane layers and in what order.

1. If the entire net is unrouted, all through-hole pads attached to nets are assigned a thermal relief.

2. Routed sections of nets are considered subnets. Each subnet must have at least one thermal relief. Subnets employ the following search order for assigning a thermal relief.
   - Vias are always assigned thermal reliefs. For example, if you route between a capacitor on the bottom of the board and an IC on the top of the board, the via will have a thermal relief.
   - If the subnet does not find a via, any pad marked forced thermal relief becomes the thermal relief for that subnet.
   - If the subnet does not find a via or a pad marked forced thermal relief, the first pad marked preferred thermal relief becomes the thermal relief for that subnet.
   - If the subnet does not find a via or a pad marked forced or preferred thermal relief, global or standard pins receive thermal reliefs.
   - If the subnet does not find a via, forced or preferred thermal relief, or a global or standard pin, the pad for the thermal relief is picked at random.
   - If no pins fit the correct criteria, a Design Rules Check for dispersion creates an error at each pin that fails to connect to the plane.

See SMD pads cannot connect to a plane using thermal reliefs. If you are using Layout or Layout Plus, see Running fanout on boards with surface mount devices in the OrCAD Layout for Windows Autorouter User's Guide. If you are using Layout Ltd., see Routing to power and ground in Chapter 9: Routing the board.
Forced thermal reliefs and preferred thermal reliefs

If you designate any pin of a footprint as a forced thermal relief pad, then as long as it is attached to the appropriate net, the pin is assigned a thermal relief on the plane layers that are attached to that net.

If you designate a footprint pin as a preferred thermal relief, then as long as the pin is attached to the appropriate net, the pin will be the first in each subnet (routed portion of the net) to receive a thermal relief on the plane layers that are attached to that net. If there is already a via on the subnet, the via will receive a thermal relief; vias are always assigned thermal reliefs.

To designate a pin as a forced or preferred thermal relief

1. Choose the spreadsheet toolbar button.
2. Choose Footprints from the drop list.
   The Footprints spreadsheet displays.
3. Select the footprint pin that you want to designate as a forced or preferred thermal relief.
4. From the pop-up menu, choose Modify.
   The Edit Pad dialog box displays.
5. Select the Forced Thermal Relief check box.
   or
   Select the Preferred Thermal Relief check box.
6. Choose the OK button to close the dialog box.

Layout designates the pin as a forced or preferred thermal relief.

Specifying a forced thermal relief in the Edit Pad dialog box.
Chapter 10  Using thermal reliefs and copper pour zones

Using padstacks to create thermal reliefs

You can also assign thermal reliefs using the Edit Padstack dialog box. In this dialog box, you can assign a thermal relief to any pin independent of its net designation. The thermal reliefs assigned in this dialog box are forced thermal reliefs and override preferred thermal reliefs as specified in the Edit Footprint dialog box.

Note  By default, Layout assigns thermal reliefs to nets connected to plane layers. You may use the command described here to connect a pin to the plane layer regardless of its net assignment.

To create thermal reliefs using padstacks

1  Choose the spreadsheets button from the toolbar.
2  Choose Padstacks from the drop list.
   The Padstacks spreadsheet displays.
3  Double-click on the layer that you want to edit.
   The Edit Padstack Layer dialog box displays.
4  In the Pad Shape group box, select the Thermal Relief option.
5  Choose the OK button to close the dialog box.

Layout assigns a thermal relief to the padstack. When the padstack is assigned to a pin, the thermal relief will be forced on that pin, regardless of net or thermal preference.

The Edit Padstack Layer dialog box.
Chapter 10  Using thermal reliefs and copper pour zones

Creating copper pour zones

A copper pour zone is used to place copper in designated areas. It also places thermal reliefs on pads while eliminating copper islands. In Layout, you create a copper pour zone by drawing and modifying an obstacle.

A copper pour zone can be placed on any layer, can be solid or cross-hatched, and can be attached to any net. The hatch pattern is set in the Hatch pattern dialog box, which is displayed when you choose the Hatch pattern button in the Edit Obstacle dialog box. The cross-hatch can be at any angle that is a multiple of 45 degrees.

A copper pour outline can be any shape, using angles and arcs as needed. It can be attached to a component pin. Copper that is attached to a net assumes the attributes of that net.

There are three types of obstacles in Layout that you need to be aware of when working with copper.

- **Copper area.** You can use copper areas to create custom pad shapes. Isolation rules do not apply to copper areas.

- **Copper pour zone.** Copper pour zones avoid pins and tracks but attach to pins with a thermal relief.

- **Anti-copper zone.** Use anti-copper zones to create non-copper areas within copper pour zones.

See  The spoke width value defined in the Thermal Reliefs dialog box is used for copper pour as well as layer planes. For information on editing this value, see Defining thermal reliefs in this chapter.

Designating a seed point

Before you create the copper pour zone, you must designate a seed point. The seed point is the point from which the copper pours.

**To designate a seed point**

1  Choose the Pin tool from the toolbar.  
   or  
   Choose Pin from the Tool menu.

2  Select a pin that is attached to the net to which you want to attach the copper pour zone.

3  From the pop-up menu, choose Toggle Copper Pour Seed.  
   or  
   Choose Toggle Copper Pour Seed from the Edit menu.  
   This sets the copper pour seed point from which the copper will pour.
Chapter 10  Using thermal reliefs and copper pour zones

Creating a copper pour zone

After you designate a seed point, you can create the copper pour obstacle. This section explains how to create a typical copper pour zone, a circular copper pour zone, specify a hatch pattern, and repour the copper after modifying the board.

To create a copper pour zone

1. Choose the Obstacle tool from the toolbar.
   or
   Choose Obstacle from the Tool menu.

2. Choose Insert from the pop-up menu.
   or
   Press the INSERT key.

3. Click the left mouse button and drag to create the area that you want to designate as a copper pour zone.

4. Select the area that you have drawn by pressing the left mouse button and dragging the pointer across any part of the area. It is highlighted when it is selected.
   or
   Select the obstacle using the CTRL key and the left mouse button, enabling you to edit the obstacle without accidentally moving it. It is highlighted when it is selected.

5. From the pop-up menu, choose Modify.
   The Edit Obstacle dialog box displays.

6. From the Obstacle Type drop list, select Copper pour.

7. From the Obstacle layer drop list, select the appropriate layer.

8. In the Copper pour rules group box, specify the following as necessary.

   - **Copper pour clearance.** Copper pour clearance designates the absolute clearance between this particular piece of copper pour and all other objects. A clearance of zero designates that the default clearances from each type of object will be used. When a net has a clearance specified which is larger than the copper pour clearance or the layer-object rule clearance, the larger clearance is used for objects belonging to that net.

   - **Isolate all routes.** All tracks, including those that have the same net as the pour, are isolated from the zone.

   - **Seed only from designated object.** Specifies that the copper pours into as much area as is possible contiguously from the seed point. Tracks and vias will not be used to seed the pour. To use the copper pour as a shield (rather than as a current source or sink) select both options and mark one pad as a seed.
9 In the Net attachment text field, you may specify a net to attach to the copper pour.

```
Obstacle name: 139

Obstacle Type:
Copper pour

Group: Height Width

Obstacle layer: TOP

Copper pour rules:
Copper pour clearance: 10

Note: Use Pin Tool command ‘Toggle Copper Pour Seed’ to set copper pour seedpoints
☑ Isolate all routes ☑ Seed only from designated object

Net attachment (‘\n’ for none):

AGND

Hatch pattern...

Comp attachment...

OK Help Cancel
```

10 Choose the OK button to exit the dialog box.

The copper pour zone forms on the screen.

Note If you want thermal isolation around vias in your copper pour zones, you must edit the LAYOUT.INI file. The LAYOUT.INI file is located in your Windows directory. Modify the following line in the LAYOUT_GLOBALS section: THERMAL_COPPER_POUR_VIAS=YES. Without this modification, vias on the same net as the copper pour are flooded with copper.
To create a circular copper pour zone

1. Designate a seed point.

See To learn how to designate a seed point, see Designating a seed point in this chapter.

2. Choose the Obstacle tool from the toolbar.
   or
   Choose Obstacle from the Tool menu.

3. Choose Insert from the pop-up menu.
   or
   Press the INSERT key.

4. Choose Modify from the pop-up menu.

5. Define the obstacle using the Edit obstacle dialog box and choose the OK button.

See To learn how to define an obstacle as a copper pour zone, see To create a copper pour zone in this chapter.

6. Click the left mouse button at the desired center for the circular copper pour zone.

7. Choose Arc from the pop-up menu.

8. Drag the cursor to create a circle of the desired size.

9. Click the left mouse button to stop drawing.

The copper pour zone forms on the screen.

A circular copper pour zone.
To specify a hatch pattern for a copper pour zone

1. Choose the Hatch pattern button.
2. In the Hatch pattern group box, indicate the pattern in which you want the copper to pour, and the desired grid and angle of the hatch.
   - **Line.** Straight lines.
   - **Cross hatching.** Crossed lines.
   - **Solid.** Solid pour. When you select Solid, your hatch grid setting is ignored and the grid is set to 90% of the obstacle pour width value (from the previous screen).
   - **Hatch grid.** Space between the lines.
   - **Hatch rotation.** Angle of the lines in the pattern.

**Note** Only angles in increments of 45 degrees are supported.

*The circular copper pour has a cross-hatch pattern with the hatch grid of 50 at a 45 degree rotation.*

**Note** The more complex the hatch pattern, the slower the copper will pour. For example, hatch patterns that are not either horizontal or vertical pour quite slowly. Avoid small grid cross hatched patterns at odd angles of rotation.

**See also** For more information on creating and editing obstacles such as copper pour zones, see *Chapter 6: Creating and editing obstacles.*
Chapter 10  Using thermal reliefs and copper pour zones

To refresh copper pour after editing the board

1  Edit the board as necessary.
2  Choose the Refresh Copper Pour icon from the toolbar.

   Layout repours the copper. The pour area adjusts automatically to accommodate your board edits.

Tip  Choose User Preferences from the Options menu to display the User Preferences dialog box. Select the Fast Fill Copper Pour check box to display the copper pour that is on the board. The copper pour will display in a sparse cross-hatch pattern. This accelerates the copper pour display process. Turn the Fast Fill option off only after you have finished editing your board. This option is for copper pour display, and does not perform copper pour.
Ensuring manufacturability

This chapter explains how to use Layout's design rules and manufacturability checks to test the integrity of the board layout. The design management utilities available in Layout include: Board Design Check, Board Space Check, Board AutoCDE, and Board AutoDFM.

Running Board Design Check

The Board Design Check command verifies the board design's adherence to design rules. The Board Design Check automatically sweeps through the entire design checking for design rule errors. You tell Layout what checks you want to run by selecting the options in the Design Rules dialog box.

To run Board Design Check

1. From the Auto menu, choose Board Design Check.
   The Design Rules dialog box displays.
2. Select the rules that you want to verify.
3. Choose the OK button.
   Layout performs the specified checks and flags the errors with circles on the board.

See For information on querying errors using the error tool, see Querying flagged errors in this chapter.
## The Design Rules dialog box

<table>
<thead>
<tr>
<th>Design Rules</th>
</tr>
</thead>
<tbody>
<tr>
<td>Via Location Errors</td>
</tr>
<tr>
<td>Copper Continuity</td>
</tr>
<tr>
<td>SMD Fanouts</td>
</tr>
<tr>
<td>Pad Exit Errors</td>
</tr>
<tr>
<td>Net Rule Violations</td>
</tr>
<tr>
<td>Check Test Points</td>
</tr>
</tbody>
</table>

### Test Point Options

- Generate test points from vias
- Test points allowed under components
- Through-hole pins valid as test points

### Via Location Errors

This option checks for vias that violate the via location rules you have set.

See For information on defining vias, see *Defining vias in Chapter 5: Setting up the board.*

### Copper Continuity

This option checks for net attached copper that is either attached to the wrong net, or not attached to its net.

See For information on attaching copper to nets, see *Creating copper pour zones in Chapter 10: Using thermal reliefs and copper pour zones.*

### SMT Fanouts

This option checks for any nets attached to a plane that come from SMD pads and do not terminate at either a through-hole or a via.

See For information on performing fanout, see *Running fanout on boards with surface mount devices in the OrCAD Layout for Windows Autorouter User's Guide.*

### Pad Exit Errors

This option checks for routing that does not adhere to the pad exit criteria assigned in the Edit Footprint dialog box.
Net Rule violations  This option checks for any net parameters that are outside the rules you have set for the net.

See  For information on setting net attributes, see Setting net attributes in Chapter 5: Setting up the board.

Check Test Points  This option verifies that every net enabled for a test point actually does have a test point.

Test Point Operations

Generate test points from vias. When enabled, this option uses existing vias as test points (via will be substituted with a test point.) This is used most often for surface mount boards.

Test points allowed under components. When enabled, this option allows test points under components. This is generally used only for bed-of-nails- testing or bare-board testing.

Through-hole pins valid as test points. When enabled, you can use a component pin as a test point. This is generally used only for bare-board testing.

Test Point Pitch. Specifies the minimum distance, measured from center-to-center, allowed between test points.

See  For information about generating test points, see Generating test points interactively in Chapter 9: Routing the board and in Generating test points automatically in the OrCAD Layout for Windows Autorouter User’s Guide.

Running Window Design Check

Window Design Check checks only the portion of the board that is currently visible on the screen. You can use the Zoom In and Zoom Out commands to define the portion. This command offers the same options as running a full board design check. The Window Design Check command is not available in Layout Ltd.

To run Window Design Check

1  Zoom In or Zoom Out to define the area to check.

2  From the Auto menu, choose Window Design Check. The Design Rules dialog box displays.

3  Select the rules that you want to verify.

4  Choose the OK button.

   Layout performs the specified checks in the area you specified and flags the errors with circles.
Running Board Space Check

Board Space Check verifies board spacing criteria. Layout does not allow spacing errors to be created during interactive or autorouting (Layout and Layout Plus only).

If you have disabled DRC at any time during the design process, you should run this test.

The internal spacing information on the routing window is continuously updated, so that a spacing check takes only a few minutes. Any problems in spacing are marked by a circle and can be queried using the Error tool.

To run Board Space Check

- From the Auto menu, choose Board Space Check.

Layout checks the board for spacing errors and flags the errors with a circle.

📖 See For information on querying errors using the error tool, see Querying flagged errors in this chapter.

Running Window Space Check

Window Space Check checks only the portion of the board that is currently visible on the screen. You can use the Zoom In and Zoom Out commands to define the portion to check. The Window Space Check command is not available in Layout Ltd.

To run Window Space Check

1. Zoom In or Zoom Out to define the area that you want to check.
2. From the Auto menu, choose Window Space Check.
   Layout checks the selected area for spacing violations.
Running Board AutoCDE

Board AutoCDE automatically sweeps through the entire design, checking for space check errors and automatically rips up a minimum number of segments to eliminate any electrical shorts. Using Board AutoCDE, you can accurately judge the impact of engineering change orders and achieve a clean design for rerouting.

To run Board AutoCDE

► From the Auto menu, choose Board AutoCDE.

Layout checks the board and rips up offending segments.

Running Window AutoCDE

Window AutoCDE checks only the portion of the board that is currently visible on the screen. You can use the Zoom In and Zoom Out commands to define the portion to check. The Window AutoCDE command is not available in Layout Ltd.

To run Window AutoCDE

1 Zoom In or Zoom Out to define the area that you want to check.
2 From the Auto menu, choose Window AutoCDE.

Layout checks the selected area and rips up offending segments.
Running Board AutoDFM

Board AutoDFM (available only for Layout and Layout Plus) automatically smoothes, miters, and checks for both aesthetic and manufacturing problems that may have been created during routing. It is recommended that you run Board AutoDFM at least once, at the end of the design cycle.

Some of the problems recognized by Board AutoDFM may include off-grid 90 degree angles, acute angles, bad copper share, pad exits, and overlapping vias. Any problems are marked by a circle and can be queried using the Error tool and query window.

To run Board AutoDFM

☞ From the Auto menu, choose Board AutoDFM.

Layout smoothes, miters, and checks the board.

See For information on querying errors using the error tool, see Querying flagged errors in this chapter.
Investigating errors

When you run Design Check, Space Check, or Board AutoCDE, the errors are flagged on the board with circles. You can query the errors to receive a full description of the problem.

**Note** You can also view the errors in the Error Markers spreadsheet.

**To query flagged errors**

1. Choose the Select errors for query toolbar button.
   
   or
   
   From the Tool menu, choose the Error tool.

2. From the Tool menu, choose Init Query.
   
   The query window displays.

3. Select an error flag.
   
   A description of the error displays in the query window.

4. Take the necessary actions to reconcile the errors.

```
A bad pad exit error as described in the query window.
```
Part Three provides information about libraries and footprints. A footprint library is a file that stores footprints and symbols. Layout provides over 3000 footprints contained in many different libraries. You can also create custom libraries to store any combination of items.

Part Three includes these chapters:

*Chapter 12: About libraries* provides an overview of the libraries and footprints used in Layout.

*Chapter 13: Managing footprint libraries* describes how to manage footprint libraries and how to create custom footprint libraries.

*Chapter 14: Creating and editing footprints* describes how to create new footprints, how to edit footprints and footprint pins.

Part Three
About libraries

Layout’s libraries contain more than 3000 footprints. This chapter describes Layout’s libraries, and explains how footprints and symbols are stored in libraries.

Libraries

Libraries are files that contain reusable design data. Layout provides the capability to develop a footprint library for component footprints. Libraries may also contain a variety of symbols that you can reuse in your designs.

The relationship between the library and the footprints and symbols it contains is similar to the relationship between a design and its contents. The contents of the library move with the library and are deleted with the library.

You can create custom libraries to store any combination of items. You can, for example, create a library to hold functionally related components, or to hold symbols such as alignment targets. Or, you can create a library to contain all of the footprints used in a project.

Caution  If you edit a library provided by Layout, you should give it a new and unique name so that it will not be replaced when you install updated libraries.

When you work with footprint libraries in Layout, you use the library manager and the footprint editor. The library manager lists the libraries and all of the footprints contained in the libraries and the footprint editor is a graphical editing environment. You have the option of selecting libraries and footprints for editing.

Because a library is a file, you can use the same Windows principles that apply to other files when working with libraries.
Footprints

Footprints describe the physical description of components. A footprint generally consists of three object types: padstacks, obstacles (representing among other things, the physical outline of the component, silkscreen outline, assembly outline, and placement and insertion outlines), and text (for example, the component name or component value).

You can view footprint data graphically in the footprint editor or textually in the Footprints spreadsheets.

See For a complete list of the footprint libraries provided with Layout, see the OrCAD Layout for Windows Footprint Libraries.
Managing footprint libraries

You can use the library manager to access and view every library and footprint supplied by Layout. You can make libraries available for the current Layout session, and can remove them from the session. You can also create custom libraries, copy footprints between libraries, and delete footprints from libraries.

This chapter explains how to manage Layout's footprint libraries and describes the following tasks.

- Opening the library manager
- Making libraries available for the current session
- Removing libraries from the current session
- Creating a custom library
- Adding and copying footprints to libraries
- Removing footprints from libraries

See For a complete list of the footprint libraries provided with Layout, see the *OrCAD Layout for Windows Footprint Libraries.*
Starting the library manager

You can start the library manager from the session frame before you open a design, or from the toolbar in the Layout design window.

To start the library manager

- In the session frame, choose Library Manager from the Tools menu.

  OR

- In the design window, choose the Library Manager toolbar button.

The library manager and footprint editor display.

The library manager and footprint editor.
Making libraries available for use

Libraries may exist in any directory, even on a network. Layout allows you to use libraries from any of these sources at the same time. Although Layout ships with a set of libraries containing over 3000 parts that are installed automatically and are accessible for use, you may add additional libraries from another area.

To make any library available for use in Layout, you use the Add Library button in library manager. You will then have access to all of the footprints in the selected libraries.

You can also remove libraries from the list of available libraries. When libraries are removed, they are not erased. They are simply removed from Layout’s list of active, or available, libraries.

To make a library available to Layout
1 In the library manager, choose the Add button.
2 Locate and select the library that you want to make available and choose the Open button.
   The library will be added to the bottom of the list of libraries in the Libraries window. You can only add one library at a time.

To make a library unavailable to Layout
1 Select the library in the Libraries window. You may select multiple libraries using the CTRL key.
2 In the library manager, choose the Remove button. Layout asks you to confirm your decision.
   The library is removed from the list of available libraries.

Tip You can also select an existing board file (.MAX) as a library, and borrow footprints from it.
Viewing footprints using the library manager

In the Libraries window, select a library to generate and display a list of its parts in the Footprints window. If you select multiple libraries using the CTRL key, the Footprints window displays a list of the footprints in all selected libraries in alphabetical order.

When you select a footprint from the list in the Footprints window, a graphical display of the footprint appears in the footprint editor. You can perform various actions on the footprint, such as editing, saving, copying, and deleting.

To view footprints in the footprint editor

1. In the Libraries window, select a library. You can select multiple libraries using the CTRL key. The footprints from the selected libraries display in the Footprints window.
2. In the Footprints window, select a footprint. The footprint displays graphically in the footprint editor.
3. Perform actions on the footprint as described in Chapter 14: Creating and editing footprints.
Creating a new footprint library

This section explains how to create a custom footprint library. Using the library manager, you can create a new library by saving a new or existing footprint to a library that you name. You can then add other footprints by selecting them in the Footprints window and saving them to the newly created library.

To create a custom footprint library

1. In the Footprints window, select a footprint to save to the new library. The footprint displays in the footprint editor. 
   or
   Create a footprint as described in Creating a footprint in Chapter 14: Creating and editing footprints.

2. Choose the Save As button. The Save Footprint As dialog box displays.


4. Enter the name for the new library in the File name text box, select a target directory for the library, and choose the Save button.

5. Choose the OK button to exit the Save Footprint As dialog box. The new library is added to the bottom of the list of available libraries in the Libraries window.

6. Add footprints to the library by following the instructions in Adding, copying, and deleting footprints in this section.
Adding, copying, and deleting footprints

Using the library manager, you can add or copy a footprint to a library by saving the footprint to the desired library. You can also delete footprints from libraries.

To add or copy footprints to libraries

1. In the library manager, select the footprint name in the Footprints window. The footprint displays in the footprint editor.
2. Choose the Save As button. The Save Footprint As dialog box displays.
3. Select a library from the drop list.
   or
   Choose the Browse button. Locate and select the desired library.
   or
   Create a new library.
4. Choose the OK button.

To delete footprints from libraries

1. In the library manager, select a footprint in the footprints window.
2. Choose the Delete Footprint button. Layout asks you to confirm your decision to remove the footprint.
3. Choose the Yes button.

Note The footprint is permanently removed. If there is a possibility that you will want to use the footprint in the future, you should first copy the footprint to another library, such as OLD.LLB, before you delete it.
Creating and editing footprints

A footprint is the physical description of a component and consists of three elements: padstacks, obstacles (silkscreens, assembly drawing data, outlines), and text. In Layout, you can create and edit footprints in the footprint editor window. You can also access and edit footprint data for the current design using the Footprints spreadsheet.

Setting a grid for the footprint pins

It is important to establish a useful placement grid before creating footprints. When you start a new footprint, the first padstack is automatically placed at 0, 0. When you add new padstacks, they are placed on the placement grid that has been specified in the System Grids dialog box. You should always set the placement grid so that the pins you add will adhere to the spacing required.

See For information on setting system grids, see Setting system grids in Chapter 5: Setting up the board.
Chapter 14  Creating and editing footprints

Creating a footprint

In Layout, you can create new footprints and add them to the libraries of your choice.

See Before you create a footprint, you must define padstacks to assign to the footprint pins. For information on defining padstacks, see Defining padstacks in Chapter 5: Setting up the board.

To create a footprint

1. In the library manager, choose the Create New Footprint button. The Create New Footprint dialog box displays.

2. Enter a name for the new footprint.
3. If the footprint is to be a metric footprint, select the Metric check box.
4. Choose the OK button.

The footprint origin, one pin, and default text objects display in the footprint editor.

Creating a new footprint.
Chapter 14  Creating and editing footprints

Adding pins to a footprint

You can easily add padstacks to the footprint. In Layout, pins can be numeric, alphanumeric, and placed in any order. For example, you can name the pins 1, 7, 8, and 14 to fit a 4-pin oscillator that is numbered for a 14-pin part. Pin names must correspond to the pin numbers (or pin names if numbers are not used) of the schematic symbols.

Note  By default, Layout names the pins in numerical order beginning with the number 1. You must change the pin names in Layout to match the pin numbers in the schematic, or change them in the schematic library.

To add a pin to the footprint

1  Maximize the footprint editor.
2  In the footprint editor, choose the Pin tool from the toolbar.
3  Press the INSERT key.
   or
   Choose Insert from the pop-up menu.
   A new pin appears on the cursor.
4  Position the pin in the desired location. As you move the pin, its X and Y coordinates are displayed in the status bar. Use them as a guide for placing the pin.

Pins one and two of DIP14.
5 Click the mouse button to place the pin. Placing this pin establishes the distance between the pins on the current side of the footprint.

6 Press the INSERT key once for each additional pin that you want to add to the current side of the footprint. Pins are placed using the distance established between pins 1 and 2.

7 To begin the next row of pins, select a pin and press the INSERT key. Position the pin in the desired location to start the next row. Click the left mouse button to place the pin.

8 Press the INSERT key. Again, place the second pin to establish the spacing for the this row of pins.

9 Repeat steps 6, 7, and 8 until the footprint has the desired number of pins.

Tip If the pin names are not visible, choose the Initialize Color icon from the toolbar and scroll until you find Pin Name. Select a color that will display in the window. The pin name should appear after you close the color window. For more information on using color, see Chapter 4: The Layout design environment.
Assigning padstacks to footprint pins

Padstacks define the pins on each layer of the footprint. They possess attributes on each layer of the board, such as shape and size. You may use the default padstacks included in the technology template, or define them when you are setting up the board. Once you define a padstack, you can assign it to pins in a footprint.

You can assign the same padstack to all the pins in the footprint using the Edit Footprint dialog box. Or, you can assign padstacks to individual pins using the Edit Pad dialog box. You can also input the exact coordinates for the pin location in the Edit Pad dialog box. This is a helpful tool for placing pins on a fine or irregular grid.

You can view the padstack assigned to each footprint pin in the Footprints spreadsheet. You can view the padstack definitions by layer for each padstack using the Padstacks spreadsheet.

To assign one padstack to all of the pins in the footprint

1. Choose the spreadsheets toolbar button.

2. Select Footprints from the drop list. The Footprints spreadsheet appears displaying footprint and pad data for the footprint you are creating.

3. In the Footprints spreadsheet, double-click on the footprint name.
The Edit Footprint dialog box displays.

4 Select a padstack for the footprint from the Padstack Name drop list.
5 Choose the OK button to accept the setting and close the Edit Footprint dialog box.

**To assign a padstack to an individual pin**

1 In the footprint editor, choose the Pin tool from the toolbar.
2 Press the CTRL key and click the left mouse button on the pin to select it.
3 From the pop-up menu, choose Modify.
   The Edit Pad dialog box displays.
4 Select a padstack for the footprint pin from the Padstack Name drop list.
5 Choose the OK button to accept the settings and close the Edit Pad dialog box.

See For a detailed description on the Edit Footprint and Edit Pad dialog boxes, see *Editing footprints and footprint pins* in this chapter.
Attaching obstacles to footprints and pins

A variety of obstacles are used in the creation of footprints. In footprint libraries, the most commonly used obstacles are described below:

**Place outlines**  Layout's interactive and automatic placement utilities look for placement outlines. The outline is used to maintain a specified distance between parts. For surface mount parts, this outline should be large enough to provide sufficient space between parts, eliminating solder shadowing and facilitating the post-assembly inspection process.

**Detail**  Use detail obstacles to create silkscreen and assembly drawings for the parts. Assembly drawings represent the component shapes for manufacturing, and silkscreen references the actual parts on the board.

**Copper**  When copper is attached to a pin, it becomes an integral part of the pin. If the pin is moved, the copper moves with it. If the pin is attached to a net, then the copper automatically becomes a part of the net. When attached to a pin, copper can create a heat sink under a power part. Or, copper can create an odd-shaped pad for a special application.

**Insertion outlines**  An insertion outline is added to a footprint to represent the size of the auto-insertion head. It provides clearance around parts on the board so that the insertion machine head will not hit any components.

**Height restrictions**  A height keep-in contains all components at or above a specified height, while a height keep-out excludes all components at or above a specified height.

**See**  For instructions and examples for creating and editing obstacles, see Chapter 6: Creating and editing obstacles.

To attach obstacles to footprint pins

1  Create an obstacle as described in Chapter 6: Creating and editing obstacles.

2  In the Edit Obstacle dialog box, choose the Pin attachment button.

3  Choose the Attach to pin option and enter the name of the pin to which you want to attach the obstacle.

4  Choose the OK button twice to dismiss the dialog boxes.
Adding labels to footprints

You can assign several types of labels to footprints in the footprint editor. These include standard labels as well as custom text strings. You can specify which labels you want to assign using the Text Edit dialog box.

The labels in the footprint editor are placeholders that are replaced by part properties from the schematic, such as reference designators and values. The placeholders are preceded by ampersands (for example, &Comp or &Value).

The following labels can be assigned to footprints:

- Reference designators
- Component value
- Custom properties (user-defined)
- Package name
- Footprint name

See For detailed descriptions of the types of text listed above, and for instructions for labeling footprints and editing text, see Chapter 7: Creating and editing text.
Editing footprints and footprint pins

You can edit footprints in the footprint editor. Or, you can edit footprint data using the Footprints spreadsheet. One method may be more practical than the other depending on the type of activity you are performing. Typically, when editing obstacles or text, use the footprint editor window. When editing multiple pin locations or padstacks, use the spreadsheet.

You can edit all of the pins of a footprint at once, or individual pins. You can edit the location, padstack assignment, and entry and exit rules of a pin. Additionally, you can make a pin a forced or preferred thermal relief, and allow vias to be placed under the pin.

The Edit Footprint and Edit Pad dialog boxes offer the same editing options. But, changes made in the Edit Footprint dialog box affect all of the pins in the footprint, while changes made in the Edit Pad dialog box affect only the selected pin.

See You can also access footprint and pin data using query. For information on using query, see The query window in Chapter 4: The Layout design environment.

To edit footprint pins in the footprint editor

1. Choose the Pin tool.
2. Double-click on a pin.
   or
   Choose Modify from the pop-up menu and edit the objects as desired.

To edit the footprint or footprint pins using the spreadsheet

1. Open the Footprints spreadsheet.
   To edit all the pins in the footprint, double-click on the footprint name.
   or
   To edit a footprint pin, double-click on a pin name.
2. Edit the dialog box options as desired.
3. Choose the OK button to accept the settings and close the dialog box.
The Edit Pad dialog box

Pad Name  The pin name.

Pad X, Y  The X and Y coordinates of the selected pin.

Padstack name  The padstack currently assigned to the selected pin.

Pad Entry/Exit Rule  Specify the pin entry and exit rules for all the pins in the footprint, or for the selected pin. For example, for a rectangular pad, you can choose the entry and exit to occurs at the long end only.

Allow via under pad  Allows the router to place vias under the pin(s).

Preferred thermal relief  Designate the pin(s) as a preferred thermal relief.

Forced thermal relief  Designate the pin(s) as a forced thermal relief.

See  If a pin attaches to a plane layer it is potentially assigned a thermal relief. For information on using preferred and forced thermal reliefs, see Preferred thermal reliefs and forced thermal reliefs in Chapter 10: Using thermal reliefs and copper pour zones.
Editing padstacks

You can edit the default padstack definitions predefined in Layout, or padstacks that you have defined while setting up the board. You can edit the padstack as it appears on all board layers, or edit its definition on selected layers.

See For instructions on defining new padstacks, see Defining padstacks in Chapter 5: Setting up the board.

To edit the padstack on all layers

1. In the Padstacks spreadsheet, double-click on the padstack name.
   
   or
   
   Select the padstack name and from the pop-up menu, choose Modify. The Edit Padstack dialog box displays.

2. Edit the dialog box options as desired: Any edits made apply to all layers of the padstack.

3. Choose the OK button to accept the settings and close the Edit Padstack dialog box.

To edit the padstack on selected layers

1. In the Padstacks spreadsheet, double-click on the layer name. The Edit Padstack Layer dialog box displays.

2. Edit the dialog box options as desired. The edits apply only to selected layers.

3. Choose the OK button to accept the settings and close the dialog box.

To change the drill size of a padstack

1. In the Padstacks spreadsheet, double-click on the DRILL layer.

2. In the Edit Padstack layer dialog box, choose round as the shape for the drill hole.

3. Enter the desired value in the Pad Width text box and choose the OK button.
Chapter 14  Creating and editing footprints

The Edit Padstack dialog box

Non-Plated  Select the check box to specify the padstack’s holes as non-plated. They will be displayed as non-plated on the drill drawing.

Use For Test Point  Select the check box to specify the padstack as a test point. Used to evaluate the assignment of test points to nets.

Note  You must also assign a test point to the net. In the Nets spreadsheet, double-click on the name of the net that you want to assign a test point. In the Edit Net dialog box that displays, select the Test Point option. Do not use a via that is used for routing as a test pin. Create a new via as described in Defining vias in Chapter 5: Setting up the board.

Large Thermal Relief  Specifies the assignment of a large thermal relief to the padstack.

Pad Shape  Select the appropriate option to choose a shape for the padstack. Padstacks can be round, square, oval, annular, oblong, rectangular, thermal, or undefined.

No connection  Select the check box to specify that the padstack should have no electrical connection to the layer (Edit Padstack Layer only).

Pad Width, Pad Height, X Offset, and Y Offset  The inner diameter of an annular pad or thermal relief is approximated on screen. The actual inner diameters can be defined during post processing. Oblong, oval, and rectangular pads are defined by their Pad Width (X dimension) and Pad Height (Y dimension). These pads can also have an offset in either the X or Y direction. This offset is measured from the electrical center of the pad. A positive offset means that the physical center of the pad is shifted in a positive direction from the electrical center.
Moving the insertion origin

In Layout, footprints have an *insertion origin*. The insertion origin serves as the location of the part as specified in the insertion report.

**To move the insertion origin**

1. From the Tool menu, choose Move Datum. The cursor becomes a crossbar.
2. Move the pointer to the target location for the insertion origin.
3. Choose Move Insertion Origin from the pop-up menu.
4. Click the left mouse button on the screen to move the insertion origin to that location.

**To center the insertion origin**

1. From the Tool menu, choose Move Datum.
2. From the pop-up menu, choose Center Insertion Origin.
Post processing

Part Four contains the information you need to perform post processing.

Part Four includes this chapter:

*Chapter 15: Post processing* describes how to create output for use by the board manufacturer. The chapter describes how to preview the board design, explains how to modify board output, and describes how to generate output, drill tape, and reports.
Post processing

Post processing is creating machine- and human-readable output for use in the manufacturing process of circuit boards. From Layout, you can generate Gerber files, DXF files, and several output formats that can be accessed from the Windows print manager.

There are several steps involved in post processing:

- Rename components
- Document board dimensions
- Preview the layers
- Modify the output criteria, if necessary
- Implement the Run Batch command
- Print or plot
- Generate drill tape
- Generate reports
Renaming components

Using the Rename Components command, you can automatically rename components in the order of your choice. To rename your components, you must establish the renaming rules, mark the components which you don't wish to rename, and launch the rename.

If all components are renamed, each category of component is renamed from 1 to n. If any component retains its name, it becomes the baseline for the rest of the renames. For example, if there are four ICs on a board (U1, U2, U3, and U4), and you rename U1, U2, and U3, they will be renamed as U5, U6, and U7. If you rename U1, U3, and U4, they will be renamed as U3, U4, and U5. If you rename U2 and U3, they will be renamed as U5 and U6.

To rename components

1. From the Options menu, choose the Manual Place/Rename Rules command.
2. In the Manual Place Rules dialog box, choose the Rename Directions button.
3. In the Rename Direction dialog box, choose one of the renaming strategies. For example, if you choose the Up, Left strategy, Layout begins at the lower right of the board, renames components from bottom to top, and from right to left.
4. Choose the OK button twice to dismiss the dialog boxes.
5. Open the Components spreadsheet.
6. Select the components you do not wish to rename and choose the Modify command.
7. In the Component Flags group box of the Edit Component dialog box, select the Do Not Rename option, then choose the OK button.
8. From the Auto menu, choose the Rename Components command.

Layout renames the components.
Documenting board dimensions

Layout’s autodimension tool can create complete dimensioning objects for your board, including arrows, lines, and text. You may want to use autodimension to show the measurements of the entire board, or to show the measurements of an object on the board, such as a large mounting hole. There are two autodimension options that you can choose in the Autodimension Options dialog box: relative dimension and absolute dimension.

Relative dimension causes a temporary origin to be created at the starting point of a drawing. The point at which you begin drawing registers as coordinates 0,0 temporarily, allowing you to easily draw the object to the dimensions you desire. The dimensions of the obstacles are measured relative to the temporary origin and the dimensioning tool draws a line and its dimension on the screen.

In absolute dimension, the origin is fixed at the board datum. The dimensions of the object are measured from the starting coordinates as determined by the placement of the pointer relative to the board datum. The dimensioning tool only displays the coordinates at the location that you place them. It places coordinates on the X or Y axis depending on the direction in which you begin moving the mouse.

See If you have Layout or Layout Plus, you can use Visual CADD’s associate dimensioning tool. For information on Visual CADD, see the OrCAD Layout for Windows Visual CADD User’s Guide.

To document board dimensions

1. Choose Auto Dimension from the Tool menu.
2. Choose Modify from the pop-up menu.
   The Autodimension Options dialog box displays.
3. Select Relative Dimensions or Absolute Dimensions from the Dimension Type group box.
4. If you are drawing an arrow, select a style from the Arrow Style group box.
5. Specify a line width in the Line Width text field.
6. Specify a text height in the Text Height text field.
7. Specify the layer on which you will draw the object in the Layer text field.
8 Choose the OK button to close the Autodimension Options dialog box.

9 In absolute dimensioning, position the cursor over the desired starting coordinates, and then click the left mouse button to begin measuring. Drag the cursor to measure, then click the left mouse button to place the first value. Repeat the process for each desired value.

or

In relative dimensioning, position the cursor over the desired starting coordinates, click and release the left mouse button, and move the pointer to interactively display the dimensions of the object you are measuring, lines and arrows. Click the left mouse button again to stop measuring.

**Note** Autodimension uses the settings in the Display Units dialog box. You can access the Display Units dialog box by choosing Units from the Options menu.

---

![Design: Auto Dimension]

*Layout's autodimensioning tool documents the dimensions of your board.*

**To delete autodimensioning objects**

1 Choose the Obstacle tool from the toolbar.

2 Drag across the entire autodimension object to select it.

3 Press the DELETE key.

   Layout deletes the lines in the object.

4 Choose the Text tool from the toolbar.

5 Select the text.

6 Press the DELETE key to delete the text.
Opening the Post Process spreadsheet

In Layout, almost all post processing functions, including previewing layers, are performed from the Post Process spreadsheet. There are several ways to access the Post Process spreadsheet. The most common way is using the toolbar button, Post Proc., but you can also access the spreadsheet using the icon at the bottom of the screen, or with a special keystroke.

To access the Post Process spreadsheet

- Click on the Post Proc. toolbar button and choose Setup Batch from the pop-up menu.

The Post Process spreadsheet displays.

The Post Process spreadsheet.

In the Post Process spreadsheet, you can view the following information.

Plot output File Name This is the primary name of the plot output files that result from post processing. The name displays during output.

Enabled Selectively enable and disable output plots.
Device  Lists the name of the target device. Layout supports either direct plotting or output-to-file to the following devices:


* DXF. Standard .DXF for input to AutoCAD or other mechanical CAD.

Print Manager: Any device supported by Windows or by a driver supplied by the manufacturer. The following are examples:

  - HPGL—Standard 7575 or 7580 HPGL for Hewlett-Packard pen plotters.
  - Dot Matrix—Standard EPSON II output for dot matrix printers with a GTD file (no .APP file).

Note  Aside from using Print Manager to specify drivers, you can choose Print from the File menu to specify standard Windows drivers to support devices such as PostScript or color printers.

* Extended Gerber. Gerber 274D format with an embedded aperture list.

Shift  Lists any special shifting, rotation, mirror, or scaling requirements.

Plot Title  A user-defined field that identifies generated reports and provides helpful information and notes for future Layout sessions. Comments can include up to 100 characters.
Previewing layers

As you create your board, you generate the necessary artwork and labels for each layer. Before you implement post processing, you should preview each layer to ensure that all of the necessary elements are present and visible on the film that you are sending to the manufacturer.

If an item is visible on the screen in preview mode, it appears in the Gerber or DXF output. If the item is invisible on the screen, it does not appear on the output. You can preview the board layer-by-layer and adjust the visibility of items on the board using the Post Process spreadsheet, the Color spreadsheet, and Layout’s post process preview.

**Copper layers**
- Verify the position of associated labels
- Check that the rotation, shift, and output format are properly set

**Power planes**
- Verify that thermal reliefs are present on the proper planes for the proper nets
- Ensure that the plane has proper clearance from the board edge
- Verify the position of associated labels
- Check that the rotation, shift, and output format are properly set

**Silkscreen layers**
- Verify the position of the reference designators
- Verify the position of other labels
- Check that the rotation, shift, and output format are properly set

**Soldermask layers**
- Verify the position of associated labels
- Check that the rotation, shift, and output format are properly set

**Assembly drawing layers**
- Verify the position of the reference designators
- Verify the position of other labels
- Check that the rotation, shift, and output format are properly set

**Solder paste layers**
- Verify that the proper pads are displayed
- Verify the position of associated labels
- Check that the rotation, shift, and output format are properly set
Drill drawing layers

- Verify the position of associated labels
- Review drill chart
- Move or resize the drill chart if necessary
- Check that the rotation, shift, and output format are properly set

See For information on moving and resizing the drill chart, see Moving the drill chart in this chapter.

To preview a layer

1. Choose the Post Proc. toolbar button and select Setup Batch from the drop list to open the Post Process spreadsheet.
2. Choose Tile from the Window menu so that you can view the Post Process spreadsheet and the design window side-by-side.
3. In the Post Process spreadsheet, select the layer you want to preview by clicking in the Plot output File Name column for the layer.
4. From the pop-up menu, choose Preview.
   The Preview of the layer displays in the design window.
5. Check the layer preview for the items that should be visible for output. If all necessary items are visible on the layer preview, skip to step 11.
6 If an item that should be visible on the preview for that layer is not visible, choose the Initialize Color toolbar button to open the Color spreadsheet.

**Note** To make items visible or invisible for preview and output, you must access the Color spreadsheet while the Post Process spreadsheet is active. When the Post Process spreadsheet is active, the visibility settings apply only to what you see in the previewer, and consequently in your output; the selections do not affect the graphical display of your board in the design process.

7 In the Color spreadsheet, select the item that you want to make visible.

**Tip** If the item that you want to select is not listed in the Color spreadsheet, choose Insert from the Color spreadsheet pop-up menu. In the Add Color Rule dialog box, select the item that you want to add, indicate the layer that you want it to appear on, and choose the OK button.

**Note** Hatched lines on the color spreadsheet indicate that the object or layer is currently defined as invisible.

8 From the Color spreadsheet pop-up menu, choose the toggling Invisible command.
9. In the Post Process spreadsheet, choose Save Colors from the pop-up menu to save this setting and choose Preview from the pop-up menu to redraw the screen. The item should now be visible on the layer preview.

10. Repeat Steps 7, 8, and 9 for each item that is invisible, but should be visible.

**Note** As the Invisible option on the Color spreadsheet is a toggling command, you can also make unwanted visible items invisible using steps 7, 8, and 9.

11. Repeat this process for each layer in the Post Process spreadsheet.
Moving the drill chart

The drill chart is automatically generated and includes the current counts of all of the existing drill sizes on the board. The drill chart comes with 20 graphical symbols (11-20 are smaller representations of 1-10) and 26 additional scalable alpha characters. A drill symbol is assigned to each drill size found. The symbols used for each drill and the text inside the drill chart are defined in the Drill Chart spreadsheet. You can manipulate the size of the drill chart and move it to the location that is best for your design.

To view the drill chart spreadsheet

Choose the spreadsheet button on the toolbar and select Drill Chart.

The Drill Chart spreadsheet.

The drill chart as it appears on the PCB.

To change the size of the drill chart

1. Choose Move Drill Chart from the Tool menu.
2. From the Edit menu, choose Drill Chart Properties.
3. Enter the text height and line width for the drill chart.
4. Choose the OK button.
To move the drill chart

1. Choose Move Drill Chart from the Tool menu.
   The cursor changes to a small cross.

   **Note** The drill chart is automatically created and kept current at all times, as long as you have a layer named DRLDWG, or nicknamed DRD.

2. Click on the screen at the location that you want to place your drill chart (the cursor represents the upper left corner of the drill chart). The drill chart moves to that position.

3. Press the **ESC** key.
   or
   Choose End Command from the pop-up menu.

   **Tip** If the chart is not visible, choose the Initialize Color toolbar button and change the color for DRL to a color that contrasts with your background color.
Restoring the original view of the design

You can easily exit preview mode and return to design mode using the Restore Colors command.

To restore your original view of the design

- From within the Post Process spreadsheet, choose Restore original colors from the pop-up menu.
  or
  Choose Reset All from the Window menu.
Chapter 15  Post processing

Modifying the output

In addition to Gerber and extended Gerber output, Layout offers DXF output for mechanical CAD compatibility, and HPGL output using the Windows print manager for printers and plotters. You may choose to use another output medium for one or more layers in your design depending on your needs.

See  For information on Auto CADD, see the OrCAD Layout for Windows Auto CADD User's Guide.

To change output settings

1  In the Post Process spreadsheet, choose Modify from the pop-up menu.
   The Post Process Setup dialog box displays.
2  Edit the options as desired.
3  Choose the OK button to close the Post Process Setup dialog box.

The Post Process Setup dialog box

Plot Title  The title for the output (for description only).
Format  The target output medium. You can choose from Gerber, DXF, Print Manager, and Extended Gerber.
Options  If you choose Gerber or Extended Gerber as the output medium, choosing this button displays the Gerber Setup dialog box.

Xsize and Ysize. Specify the desired size of the Gerber plot area. Enter the desired width in the Xsize text field and enter the desired height in the Ysize text field. The value reflects the units that you specified in the Display Units dialog box, available from the Options menu.

Incremental. Select the Incremental check box to allow Layout to use incremental Gerber mode.

CR after each block. Select the CR after each block option to insert a carriage return after each block of code (results in a more readable output).

End of block character. Define a character for dividing Gerber commands in the end-of-block character text field.

Output Resolution. There are two options for output resolution: 2.3 format (mils) or 3.4 format (tenth mils). Not all photoplotters support the 3.4 format, but it is required to generate true arcs. Otherwise arcs are simulated using line segments.

Shift  Select the Center check box to tell Layout to automatically center the artwork. Deselecting the Center check box allows you to shift the artwork on the sheet from the board datum 0,0 to the Gerber table 0,0 (X Shift for horizontal, and Y Shift for vertical).

Note  The Gerber table is the plot area that will be output to Gerber. This area may include the board and peripheral items such as the drill chart or comments.

Output  The name of the output file in the File Name text field. If you select the Keep drill holes open option, the drill holes will be visible on the output; otherwise, the holes will be solid on the output.

Translation  The desired degree of board rotation from the Rotation drop list. Rotation can be at 0, 90, 120, and 180 degrees. In the Scale text field, enter any positive ratio of scale. If you want the output to appear as in a mirror’s reflection, select the Mirror check box.

Enabled  Include or omit certain reports in batch post processing generation.
Running batch post processing

The Run Batch command automatically creates all plot files that you have specified and enabled in the Post Process spreadsheet. Before you choose the Run Batch command, you may choose to generate the standard artwork files that are enabled in the Post Process spreadsheet. Or, you may choose to add files to the standard list, or delete files from the list.

Batch post processing creates a special design file (board_name.GTD) that is pre-configured for GerbTool. GerbTool reads and writes all standard Gerber formats and IPC-350, features automatic tear-dropping, panelization, venting and thieving, and removal of unused pads and silkscreen on pads (Layout Ltd. includes Gerber plotting and viewing capabilities only).

You can start GerbTool by choosing GerbTool and Open from the Tools menu in the session frame. Choose board_name.GTD to use GerbTool with your board design.

To generate batch output

1. Choose the Post Proc. button on the toolbar.
2. From the menu that displays, choose Run Batch.

Layout displays a dialog box containing the full paths to the output files. Output files are created for each layer (board_name.TOP, and so on). If the chosen output is Gerber, two additional files are created: board_name.APP (the aperture file) and board_name.GTD (the Gerber design file). If the chosen output is Extended Gerber (274X), only one additional file is created, board_name.GTD.

The output boardjlame.GTD is supplied as input to GerbTool for both regular and extended Gerber.

Note In Extended Gerber, the aperture files are embedded in each layer file.

See For information on GerbTool, see the OrCAD Layout for Windows GerbTool User's Guide.
To add files to the output list

1. Choose the Post Proc. button on the toolbar.
2. From the menu that displays, choose Setup Batch.
   The Post Process spreadsheet displays.
3. Select the layer for which you want to create an additional output file.
4. From the pop-up menu, choose Insert.
   An additional output file is added at the bottom of the list. Modify this file as needed using the instructions in "Modifying the output" in this chapter.

Note: Attempting to generate Gerber output using spreadsheet device settings of both Gerber and Extended Gerber will generate a warning and will fail to produce any output.

To delete files from the output list

1. Choose the Post Proc. button on the toolbar.
2. From the menu that displays, choose Setup Batch.
   The Post Process spreadsheet displays.
3. Select the layer that you want to delete.
4. From the pop-up menu, choose Delete.
   The output file is deleted.
Editing apertures

You can edit the apertures in your design using the Edit Aperture dialog box.

1. Choose the spreadsheets toolbar button.
2. Select the Apertures option from the drop list.
   The Apertures spreadsheet displays.
3. Double-click on the aperture that you want to edit.
   The Edit Apertures dialog box displays.
4. Edit the aperture as desired and choose the OK button.
   Your changes are reflected in the spreadsheet and on the design.

The Edit Aperture dialog box

![Edit Aperture dialog box]

'D' Code  Specifies the Gerber 'D' code for the aperture. The range of values for
           the 'D' code is from 10 to 500.

Width    Specifies the aperture diameter in the horizontal direction.

Height   Specifies the aperture diameter in the vertical direction.

Shape    You have a choice of eight aperture shapes: Draw, Square, Oblong, Oval,
          Round, Rectangle, Thermal Relief, and Annular.
Printing and plotting

Using the Print View dialog box, you can print a spreadsheet or graphic image of your board file to a printer.

The Screen Plot command spools the screen image to any of the Layout-supported devices including Gerber, Extended Gerber, Print Manager, and DXF. The purpose of this command is to create a single plot of the current screen image. Any items that are currently visible on the screen appear on the plot; those that are not currently visible do not appear on the plot.

See You should use Setup Batch and Run Batch to spool the entire design. For information on plotting the whole design, see Running batch post processing in this chapter.

To print a spreadsheet or graphic image of the board

1 Make the window (design, spreadsheet, or other) active by clicking on the title bar.

2 Zoom in or zoom out to view the desired area to print.

3 From the File menu in the design window, choose Print.
   or
   Choose the Post Proc. toolbar button, and select Print from the drop list.

   The Print View dialog box displays.

4 To print the image that you see on the screen, choose the OK button to accept the default settings.
   or
   To print a scaled image, select the Scaled Plot option, and enter a plotting ratio in the Plotting Ratio text box.

To send the screen image to a plotter

1 Zoom in or zoom out to view the desired area to plot.

2 From the File menu in the design window, choose Screen Plot.
   or
   Choose the Post Proc. toolbar button, and select Screen Plot from the drop list.

   The Post Process Setup dialog box displays.

3 Edit the options as described in Modifying the output in this chapter, and choose the OK button.

   Layout plots the image shown on the screen according to the specifications in the Post Process Setup dialog box.
Generating a drill tape

When you choose the Drill Tape command, Layout produces drill tape files, \textit{file\_name}.TAP in Excellon format and places them in the working directory. During the manufacturing process, the drilling machine reads these files to determine the size and location of the drill holes on the board.

For a through-hole component, Layout outputs a file, THRUHOLE.TAP. In addition, Layout automatically generates drill tape files for each layer pair that shares a blind or buried via. For example, for a blind via that runs from the top layer of the board to the third layer of the board, Layout would create a file called 1\_3.TAP, for a buried via that runs from layer 2 to layer 3, Layout would create a file called 2\_3.tap, and so on.

Unless you shift the output in the Post Process Setup dialog box (in the Shift group box), the drill tape coordinates match the coordinates that you see in the design window.

\textbf{Note} If you want to keep drill tape files, rename them to avoid replacing them with newly generated tapes.

\textbf{To generate a drill tape}

1 Choose the Post Proc. button on the toolbar.
2 From the menu that displays, choose Drill Tape.
   Layout creates drill tape files in Excellon format.
Generating reports

In Layout, you can generate a variety of reports, including part lists, customizable component lists, netlists, and rename reports. You choose which reports you want to produce in the Generate Reports dialog box.

To generate reports

1. Choose the Post Proc. toolbar button.
2. From the menu that displays, choose Reports.
   
   The Generate Reports dialog box displays.
3. Select the reports you want to generate by clicking on them with the left mouse button. You can deselect selected lines by clicking on them.

The Generate Reports dialog box

![Generate Reports dialog box]

The reports generated include the following:

**Parts List (Generic) (.PRT)**  A list of part numbers (derived from the design schematic), and part types (also derived from the schematic), followed by a list of all components using each combination of part number and part type. The list is alphanumerically sorted by part number. Layout assigns the .PRT extension to the list file. In the LAYOUT.INI file, this list is referred to as PARTLIST.

**Component Insertion List (.INS)**  A special version of the user-defined Component list predefined to show component insertion locations. Layout assigns the .INS extension to the list file. In the LAYOUT.INI file, this list is referred to as INSTLIST.

**Cross reference list (.CRF)**  A cross reference list of component pins and the net attached to each pin. This list also includes pin locations for testing purposes. Layout assigns the .CRF extension to the list file. In the LAYOUT.INI file, this list is referred to as NETLIST2.
Net length list (.NL3) A list of nets with net length information. Layout assigns the .NL3 extension to the list file. In the LAYOUT.INI file, this list is referred to as NETLIST3.

Connection List (.CON) A list of point-to-point connections in each net for testing point-to-point connectivity. Layout assigns the .CON extension to the list file. In the LAYOUT.INI file, this list is referred to as CONNLIST.

Unused Pins List (.UNU) A list of unused pins on each component. Layout assigns the .UNU extension to the list file. In the LAYOUT.INI file, this list is referred to as UNUSDLST.

Rename/Swap List (.REN) A list of all component renames and gate and pin swaps, used for documentation purposes and for manual back-annotation for non-supported schematics. If a back-annotation was performed, this list may appear empty. Layout assigns the .REN extension to the list file. In the LAYOUT.INI file, this list is referred to as RENAMES.

TestPoints List (.TSP) A list of test points and their locations. Layout assigns the .TSP extension to the list file. In the LAYOUT.INI file, this list is referred to as TPLIST.

Drill List (.DRL) A human-readable drill list. You can generate the Excellon drill tape file by choosing the Post Process tool, then the Drill Tape command. Layout assigns the .DRL extension to the list file. In the LAYOUT.INI file, this list is referred to as DRILLIST. Blind and buried vias are listed first, broken down by their defining layer pair. Then through-hole components are listed.

Surface Mount Top (.CM1) A list of SMT components on the top layer of the design, along with their associated part numbers, part names and footprints. Layout assigns the .CM1 extension to the list file. In the LAYOUT.INI file, this list is referred to as COMPSTOP.

Surface Mount Bottom (.CM2) A list of SMT components on the bottom layer of the design, along with their associated part numbers, part names and footprints. Layout assigns the .CM2 extension to the list file. In the LAYOUT.INI file, this list is referred to as COMPSBOT.

Through Hole Top (.CM3) A list of unreflected through-hole components, along with their associated part numbers, part names and footprints. Layout assigns the .CM3 extension to the list file. In the LAYOUT.INI file, this list is referred to as COMPTTOP.

Through Hole Bottom (.CM4) A list of reflected through-hole components on the bottom layer of the design, along with their associated part numbers, part names and footprints. Layout assigns the .CM4 extension to the list file. In the LAYOUT.INI file, this list is referred to as COMPTBOTTOM.

Note By definition, through-hole components are not confined to the top or bottom layers; however, they can be reflected or unreflected as described by the reports Through Hole Top and Through Hole Bottom.
**Unroute List (.UNR)**  A list of unconnected tracks in the design. This report also lists the X, Y coordinates of each terminal point in the unconnected routes. Layout assigns the .UNR extension to the report file. In the LAYOUT.INI file, this list is referred to as UNROULST.

**Padstack List (.THR)**  A report of all padstacks in the design, along with their size and shape, and the footprints and components that employ them. Layout assigns the .THR extension to the report file. In the LAYOUT.INI file, this list is referred to as THRULIST.

**Drill Layer Pair List (.DRL)**  A report of all blind and buried vias that exist between any two specified layers. The data in this report includes the drill size, drill tool, and the X and Y coordinates for the via. For example, 2_5.DRL would report data for all vias that exist on or between layers 2 and 5 in the design. Layout assigns the .DRL extension to the report file. In the LAYOUT.INI file, this list is referred to as DRLAYLST. Through-hole drills have their own file named THRUHOLE.DRL.

**Attribute test listing, comps (.CAT)**  Sample report that illustrates the use of Capture properties in a Layout report. You can use this report as a template for creating custom reports that use Capture properties.

**Attribute test listing, nets (.NAT)**  Sample report that illustrates the use of Capture properties in a Layout report. You can use this report as a template for creating custom reports that use Capture properties.

The two user-definable reports are listed below.

**Component List (Generic) (.CMP)**  A list of components in alphanumeric order, one per line. Information pertaining to each component can be included to the right of the component name. Layout assigns the .CMP extension to the list file. In the LAYOUT.INI file, this list is referred to as COMPLIST.

**Net List (Generic) (.NET)**  A list of nets in alphanumeric order, one per line. Information pertaining to the net can be included to the right of the net name. Layout assigns the .NET extension to the list file. In the LAYOUT.INI file, this list is referred to as NETLIST.

Two kinds of information may be included in a COMPLIST or NETLIST report: a FIELD or a ATTR.

- A FIELD is a Layout design field that can be defined in Layout, and is independent of the schematic input (although it may have been originally defined there).
- An ATTR is a schematic attribute and cannot be defined or changed in Layout.

In addition, you can use Layouts report generation capability to back annotate your design to your Capture schematic:

**OrCAD Backannotation File**  This file provides back annotation information for your Capture schematic. Layout assigns the .NET extension to the file. To complete the back annotation, you need to open Capture on the design and use the .SWP file as input to the Gate and Pin Swap tool.
Using Layout with other applications

Part Five explains how to use Layout with OrCAD Capture for Windows and with third-party printed circuit board applications, such as PADS and CadStar.

Part Five includes the following chapters:

*Chapter 16: Using Layout with OrCAD Capture for Windows* describes how to use intertool communication and AutoECO to pass design data between Capture and Layout. It describes how to forward annotate schematic netlist data, how to back annotate changes from Layout to Capture, and how to use cross probing to enhance design and board analysis.

*Chapter 17: Importing and exporting files* describes how to import a design from a printed circuit board application other than Layout, place and route the design using Layout, then export the board back to the original third-party printed circuit board application.
Capture and Layout are tightly integrated, providing an easy solution for design annotation. Layout has the ability to communicate interactively with OrCAD Capture for Windows and other schematic design tools. This chapter explains how to use Layout and OrCAD Capture for Windows together to perform annotation and cross probing.

Layout’s AutoECO (automatic Engineering Change Order) utility automatically forward annotates all schematic attributes, component information, and netlist changes to a board from Capture. And, when you make changes to your board, you can back annotate the information to your schematic.

You can also perform cross probing with Capture and Layout. Using cross probing, you can select a part, component, or net on a Capture schematic or Layout board, to highlight the corresponding object in the other application.

Moving a design from Capture into Layout is a three-part process:

- Create a valid Capture design with footprints that Layout supports.
- Generate a netlist in the Layout format.
- Create a Layout board file. You can also transmit information concerning nets and parts by creating specially-named properties on the nets or parts.

See Layout also accepts netlist (.MNL) files from other vendor’s software. For information on netlist translation, see Chapter 17: Importing and exporting files.
Preparing your Capture design for use with Layout

To prepare a Capture design for use with Layout, you must first create the schematic design, assigning special properties and Layout-supported footprints. The tables in this section list the properties and footprints supported by Layout.

To prepare your Capture design for use with Layout

1. Create a schematic design using Capture. In order to have the ability to use intertool communication successfully between Capture and Layout, you will need to annotate, check design rules, and create a netlist in physical view. Normally, this is only necessary for complex hierarchical designs. However, even if you are creating a simplified hierarchy or flat design, you must choose Physical from the View menu before annotating the design.

2. To transfer part or net information from the schematic to the board, add a user-defined property with a name from the property tables below, and assign a value to the property. The property name must be in uppercase, as shown in the tables.

<table>
<thead>
<tr>
<th>Property name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FPLIST</td>
<td>Comma-delimited list of alternate footprints.</td>
</tr>
<tr>
<td>COMPLOC</td>
<td>Part location on the board as X and Y coordinates. Use the following format: [X, Y] where X and Y represent the coordinates. Both must be integers in mils or microns.</td>
</tr>
<tr>
<td>COMPROT</td>
<td>Part rotation in degrees and minutes from the orientation defined in the Layout library. Use a period (.) to separate degrees and minutes.</td>
</tr>
<tr>
<td>COMPGROUP</td>
<td>An integer value that assigns the part to a group for placement.</td>
</tr>
<tr>
<td>COMPKEY</td>
<td>The value &quot;YES&quot; assigns the highest priority for autoplacement within the group.</td>
</tr>
<tr>
<td>COMPFIXED</td>
<td>If value is &quot;YES,&quot; the part (such as an edge connector) is permanently fixed to the board.</td>
</tr>
<tr>
<td>COMPSIDE</td>
<td>Determine the side of the board that the components are mounted on.</td>
</tr>
<tr>
<td>COMPOLOCKED</td>
<td>If value is &quot;YES,&quot; the part is temporarily locked in position.</td>
</tr>
</tbody>
</table>

See For information about creating a design in Capture, see the *OrCAD Capture for Windows User's Guide* and online help.
### Property name | Description
---|---
**ROUTELAYERS** | Comma-delimited list assigning net to specific layers.
**PLANELAYERS** | Comma-delimited list assigning net to specific plane layers.
**NETWEIGHT** | Integer between 1 and 100 assigning relative priority to the net; default value is 50.
**VIAPERNET** | Via types allowed for net.
**WIDTH** | Value is assigned to the MINWIDTH, MAXWIDTH and CONNWIDTH properties unless overridden.
**CONNWIDTH** | Sets the track width.
**MINWIDTH** | Sets the minimum track width.
**MAXWIDTH** | Sets the maximum track width.
**WIDTHBYLAYER** | Net width for one or more layers, for example, `TOP=6, BOT=12`.
**SPACINGBYLAYER** | Net spacing for one or more layers, for example, `TOP=13, BOT=8`.
**RECONNTYPE** | Specifies the reconnect rules for each type of reconnect. Values may be STD, HORZ, VERT, MIN, or ECL.
**TESTPOINT** | If value is "YES," test point is automatically assigned to the net.
**HIGHLIGHT** | If value is "YES," net is highlighted.

**User-defined net properties that can be transferred to Layout.**

3 Assign PCB footprints to each of your schematic parts. Use only Layout-compatible footprints, choosing from those shown in the *OrCAD Layout for Windows Footprint Libraries* document, or those in your custom footprint libraries.

4 If you are using parts from non-Layout libraries, such as discrete parts and custom footprints, check that the pin numbers of your schematic part match the pad numbers of your Layout footprint. You may need to work with Capture’s part editor or Layout’s footprint libraries. In addition, you need to make sure that each pin in the Capture schematic has a pin number, as well as a pin name.

**Note** Layout doesn’t accept PCB footprint names or part values that include spaces or tabs. Use the Capture spreadsheet editor to eliminate space or tab characters in the property values.

5 Choose Physical from the View menu, then use Capture’s Design Rules Check tool to check for design rule violations.
Creating a netlist in OrCAD Capture for Windows

After you have prepared your design in Capture, and it is free from design rule violations, you are ready to create a netlist (.MNL) file for use with Layout. A LAYOUT.INI file must exist in the Windows directory for Capture to generate a netlist.

Tip You must save your Capture design before creating a netlist.

To create a .MNL netlist for use in Layout

1. Open the Capture for Windows schematic design.
2. Choose Physical from the View menu.
3. In Capture, choose Create Netlist from the Tools menu.
   The Create Netlist dialog box displays.
4. In the Create Netlist dialog box, choose the Layout tab.
5. In the PCB Footprint group box, accept the default {PCB FOOTPRINT} in the Combined Property String text box.

See For information about combined property strings, see Capture’s online help.

6. Ensure that the full path to the netlist file appears in the Netlist File text box. The netlist assumes the name of the Capture design file, but adds a .MNL extension.
7. In the Options group box, select the Run ECO to Layout option.

Tip Select the Run ECO to Layout option in Capture (in the Create Netlist dialog box) to automatically communicate schematic modifications to Layout. If the board file is open when you update the netlist file, Layout automatically displays a dialog box asking if you want to load the new netlist file. If the board file is not open when the netlist changes, Layout prompts you to load the modified netlist when you reopen the board file.

8. Choose the OK button to process the netlist.
   Capture creates the .MNL file and saves it in the directory you specified.

Note If Capture is unable to create an .MNL file, the errors are written to the Capture session log and to the .ERR file in the target directory for the .MNL file.

Note You may choose to exit Capture at this time. It is not necessary to run Capture and Layout simultaneously to take advantage of forward annotation; you must have a minimum of 16 MB of RAM to run Capture and Layout at the same time.
Using AutoECO

AutoECO selectively communicates information from Capture to Layout, or from one printed circuit board to another.

When bringing data into Layout from Capture, you can choose the appropriate AutoECO option to annotate only the schematic data that has changed. This way, you can avoid inadvertently overriding board data that you do not want to change.

You can also choose from two AutoECO options that communicate information between printed circuit boards.

To choose an AutoECO option

- From the Tools menu in the Layout session frame, choose one of the flavors of AutoECO as described in this section.

The AutoECO options are listed below. The first four options transfer data from Capture to Layout during forward annotation. The last two (AutoECO/DXF and AutoECO/Net Attrs) communicate information between printed circuit boards.

**AutoECO** This option adds and deletes components and nets, but does not override board attributes. This version is executed when Layout runs AutoECO automatically.

**AutoECO/Override** This option creates a new board or merges new components and connections with an existing board. It overrides all of the attributes in an existing board.

**AutoECO/Add Only** Add components and nets, but do not override the board attributes.

**AutoECO/Add Override** Add components and nets and update component and net properties.

**AutoECO/DXF** This option transfers obstacles and text from one board to another.

**AutoECO/Net Attrs** This option transfers net attributes such as width, weight, spacing per layer, width per layer, and reconnection type from one board to another.
The following table summarizes the capabilities of each type of AutoECO that communicates data from Capture to Layout (.MNL to .MAX) during forward annotation:

<table>
<thead>
<tr>
<th></th>
<th>Auto ECO</th>
<th>Override</th>
<th>Add Only</th>
<th>Add Override</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Components</strong></td>
<td>Match schematic</td>
<td>Match schematic</td>
<td>Match schematic</td>
<td>Match schematic</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>except deletes</td>
<td>except deletes</td>
</tr>
<tr>
<td><strong>Nets</strong></td>
<td>Match schematic</td>
<td>Match schematic</td>
<td>Match schematic</td>
<td>Match schematic</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>except deletes</td>
<td>except deletes</td>
</tr>
<tr>
<td><strong>Obstacles</strong></td>
<td>No changes</td>
<td>No changes</td>
<td>No changes</td>
<td>No changes</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>No changes</td>
<td>No changes</td>
<td>No changes</td>
<td>No changes</td>
</tr>
<tr>
<td><strong>Placement</strong></td>
<td>No changes</td>
<td>Match schematic</td>
<td>No changes</td>
<td>Match schematic</td>
</tr>
<tr>
<td></td>
<td>except new</td>
<td></td>
<td>except new</td>
<td>except deletes</td>
</tr>
<tr>
<td><strong>Component Properties</strong></td>
<td>No changes</td>
<td>Match schematic</td>
<td>No changes</td>
<td>Match schematic</td>
</tr>
<tr>
<td></td>
<td>except new</td>
<td></td>
<td>except new</td>
<td>except deletes</td>
</tr>
<tr>
<td><strong>Net Properties</strong></td>
<td>No changes</td>
<td>Match schematic</td>
<td>No changes</td>
<td>Match schematic</td>
</tr>
<tr>
<td></td>
<td>except new</td>
<td></td>
<td>except new</td>
<td>except deletes</td>
</tr>
</tbody>
</table>

The following table summarizes the capabilities of each type of AutoECO that communicates data between printed circuit boards during translation:

<table>
<thead>
<tr>
<th></th>
<th>DXF</th>
<th>Net Attrs</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Components</strong></td>
<td>No changes</td>
<td>No changes</td>
</tr>
<tr>
<td><strong>Nets</strong></td>
<td>No changes</td>
<td>No changes</td>
</tr>
<tr>
<td><strong>Obstacles</strong></td>
<td>Add/replace from new board</td>
<td>No changes</td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Add/replace from new board</td>
<td>No changes</td>
</tr>
<tr>
<td><strong>Placement</strong></td>
<td>No changes</td>
<td>No changes</td>
</tr>
<tr>
<td><strong>Component Properties</strong></td>
<td>No changes</td>
<td>No changes</td>
</tr>
<tr>
<td><strong>Net Properties</strong></td>
<td>No changes</td>
<td>Match original board where possible</td>
</tr>
</tbody>
</table>
Match schematic  All existing data on the PCB in this category is made to match the schematic, including additions and deletions.

Match schematic except deletes  All existing data on the PCB in this category is made to match the schematic, including additions, but not deletions.

No changes except new  All existing data on the PCB in this category remains the same, except additions are made from the schematic.

No changes  All data in this category in PCB remains the same.

Add/replace from new board  Any matches to existing data on the old PCB are replaced from new PCB design, including additions, but not deletions.

Match original board where possible  Any matches to existing data on the old PCB are replaced from new PCB design, but no additions or deletions are made.
Chapter 16 Using Layout with OrCAD Capture for Windows

Forward annotating Capture schematic data into Layout

This section demonstrates how to bring netlist data into a board design from OrCAD’s Capture for Windows.

You can bring Capture netlist information into Layout in two ways. You can choose one of the AutoECO options to merge the netlist with the board file, or you can select the Run ECO to Layout option in Capture (in the Create Netlist dialog box) to automatically communicate schematic modifications to Layout. If the board file is open when you update the netlist file, Layout automatically displays a dialog box asking if you want to load the new netlist file. If the board file is not open when the netlist changes, Layout prompts you to load the modified netlist when you reopen the board file.

**Note** LAYOUT.INI must exist in the WINDOWS directory in order for Capture to perform a forward annotation to Layout.

To forward annotate schematic data into Layout from Capture

1. From the Tools menu in the session frame, choose ECOs and one of the AutoECO options as described in *Using AutoECO* in this chapter.
   The File A (original components and nets) dialog box displays.

2. Select the original board file (.MAX) to which you want to add the new schematic information and choose the Open button.
   The File B (new components and nets) dialog box displays.

3. Locate and select the netlist (.MNL) that you updated and choose the Open button.
   The Output report dialog box displays.

4. Enter a name for the output report (usually `design_name.LIS`), and select a target location. Choose the Save button.
   The output report opens in a text editor and the Merged Output Binary dialog box displays.
5 Name the file and select a target location.

Layout merges the files based on the type of AutoECO you have chosen.

**See** If AutoECO finds errors, it displays an .ERR file with explanations of the errors. To correct pin problems, you may return to Capture and change pin numbering, then repeat this entire procedure. If Layout is unable to find a designated footprint, a dialog box allowing you to link footprints with components displays. For information on using this dialog box, see *Resolving AutoECO Errors in Chapter 3: Getting started*.

**Note** If part and net information does not appear in the Layout design, check that the property names are uppercase and identical to those in the part and net property tables in this chapter, and that the LAYOUT.INI file is in the directory in which Windows is installed.

*Or, if the Run ECO to Layout option is enabled in Capture*

1 In the design manager, choose Open and Board from the File menu.

The Load Board dialog box displays.

2 Select the board design that you want to open and choose the OK button.

Layout tells you that the schematic netlist for the board file has changed and asks if you want to load the updated file.

3 Choose the Yes button to load the updated netlist.
Chapter 16 Using Layout with OrCAD Capture for Windows

Back annotating board information to Capture from Layout

In Layout, you can back annotate board changes automatically to OrCAD Capture for Windows using the OrCAD Backannotation File (.SWP).

Or, to back annotate to a schematic capture application other than Layout, you can generate a file called Rename/Swap, and use it as a reference to update your schematic manually.

To back annotate your Capture schematic

1. Choose the Post Proc. toolbar button.
2. Choose Reports from the drop list. The Generate Reports dialog box displays.
3. If you have reannotated the names of parts, select OrCAD Backannotation File (.SWP), then choose the OK button.

**Note** Once the .SWP file is created, the current Layout design file no longer contains the .SWP information. A copy of the design is saved as BACKANNO.MAX. This file contains all of the swap information.

4. If it is not already open, start OrCAD Capture for Windows and open your schematic.
5. From Capture’s View menu, choose Physical.
6. From Capture’s Tools menu, choose Gate and Pin Swap.
7. In the dialog box that displays, choose the Browse button.
8. Locate and select the report you created in Layout, design_name.SWP which should be in the same directory as your design. Choose the OK button.

The Layout design information is back annotated to the schematic in Capture automatically.

To back annotate to your non-Capture schematic

1. Choose the Post Proc. toolbar button.
2. Choose Reports from the drop list. The Generate Reports dialog box displays.
3. Select Rename/Swap List (.REN), then choose the OK button.
4. Use the file manually to update your schematic.
Using cross probing

Using cross probing, you can select an object in Layout or Capture, and have the corresponding object highlighted in the other application. For example, you can select a net on your schematic and see the corresponding net highlighted in Layout.

Note It is necessary to run Capture and Layout simultaneously to use cross probing. You must have a minimum of 16 MB of RAM to run Capture and Layout at the same time.

Enabling ITC between Capture and Layout

To use cross probing, you must open the same design in Layout as in Capture. In Capture you must be in physical view, and you must enable ITC. It is not necessary to enable ITC in Layout, as cross probing is always active in Layout.

Tip You can use Layout’s Half Screen command (available from the Window menu) to tile the Capture and Layout windows so that you can view both on your screen.

To enable ITC in Capture

1. From Capture’s Options menu, choose Preferences.
   
   Capture displays the Preferences dialog box.

2. Choose the Miscellaneous tab.

3. Select Enable intertool communication, then choose the OK button.
Cross probing from Capture to Layout

When ITC is enabled in Capture and you select certain items on your schematic page, cross probing highlights the corresponding components in Layout. If you select a part or gate in a multipart package in Capture, cross probing highlights the corresponding module in Layout. If you select a wire segment or net in Capture, cross probing highlights the corresponding net (in its entirety) in Layout.

**Note**  Capture must be in physical view when cross probing.

Any action you perform to select an object on your Capture schematic (selecting using the mouse, using the Find command, or by performing a browse of parts) causes the corresponding object in Layout to be highlighted. For more information, see the following table.

<table>
<thead>
<tr>
<th>Selecting this in Capture</th>
<th>Highlights this in Layout</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part</td>
<td>Corresponding module</td>
</tr>
<tr>
<td>Gate (multiple parts per package)</td>
<td>Corresponding module</td>
</tr>
<tr>
<td>Wire segment</td>
<td>Entire net</td>
</tr>
<tr>
<td>Net</td>
<td>All routes for the net</td>
</tr>
<tr>
<td>Pin on part</td>
<td>Corresponding module</td>
</tr>
</tbody>
</table>

**Note**  When you use block selection in Capture, cross probing only highlights the last item selected in the block. There is no way to predict the order in which items are selected in a block selection.

**To select an object in Capture for cross probing with Layout**

1. Open a Capture schematic and a matching Layout design.
2. Choose Half Screen from the Layout Window menu and resize the application windows to view the Capture schematic and Layout board side-by-side.
3. In Capture, choose Physical from the view menu.
4. Also in Capture, choose Preferences from the Options menu. Choose the Miscellaneous tab, select Enable intertool communication, and choose the OK button.
5. Select an object in Capture.

The corresponding object is highlighted on the board in Layout.
Cross probing from Layout to Capture

When ITC is enabled in Capture, selecting objects in Layout causes Capture to highlight the corresponding modules in the schematic page editor. Selecting a module (or a module pad) causes Capture to highlight all the schematic parts included in that module. Selecting a track or net causes Capture to highlight the corresponding schematic net on the open page.

Any action you perform to select an object on your Layout board (selecting using the mouse, using query, or using the Find command) causes the corresponding object on the Capture schematic to be highlighted. For more information, see the following table.

<table>
<thead>
<tr>
<th>Selecting this in Layout</th>
<th>Highlights this in Capture</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module</td>
<td>All parts in the package</td>
</tr>
<tr>
<td>Track</td>
<td>Corresponding wire connection</td>
</tr>
<tr>
<td>Net</td>
<td>Corresponding nets</td>
</tr>
<tr>
<td>Pad on module</td>
<td>Corresponding part (If the Manual Route tool is selected in Layout, the net is highlighted)</td>
</tr>
</tbody>
</table>

To select an object in Layout for cross probing with Capture

1. Open a Capture schematic and a matching Layout design.
2. Choose Half Screen from the Layout Window menu and resize the application windows to view the Capture schematic and Layout board side-by-side.
3. In Capture, choose Physical from the view menu.
4. Also in Capture, choose Preferences from the Options menu. Choose the Miscellaneous tab, select Enable intertool communication, and choose the OK button.
5. Select an object in Layout.
   The corresponding object is highlighted on the schematic in Capture.

Note In Capture, the schematic automatically opens and displays the schematic page on which the corresponding symbol is located. Scroll the window until the highlighted symbol is visible.
Importing and exporting files

Layout uses powerful translation tools to provide an easy solution for easy board and netlist translation.

In the Layout session frame, the Import option on the File menu provides access to netlist and printed circuit board translators that convert your schematic netlist or PCB into Layout format. The Export menu contains PCB translation programs for use with Layout when you are using it as a placement and routing tool.

Using the Import and Export translators, you can import a design from a printed circuit board application other than Layout, place and route the design using Layout, then export the board back to its original printed circuit board application. For example, a board created in PADS can be imported into Layout for placing and routing, then exported back to PADS.

You cannot import a board created in one application, such as PCAD, place and route it using Layout, then export it to an application other than PCAD—the import application must be the same as the export application.

Layout supports the following netlist formats:

- MAX ASCII netlist
- OrCAD PCB II netlist
- Futurenet netlist
- PCAD netlist

Layout supports the following printed circuit board formats:

- MAX Interchange (.MIN) board files
- OrCAD PCB 386+ board files
- CadStar printed circuit board
- PADS printed circuit board
- PCAD printed circuit board
- Protel printed circuit board
- Tango printed circuit board
- DXF board file
Netlist translators

MAX ASCII files

If you have a schematic capture program that creates an ASCII netlist file in the Layout format, you can import the file into Layout to create a new design. You can also create the ASCII netlist using a text editor.

To export a Layout netlist file (.MNL) to ASCII

1. Open the Layout session frame.
2. Choose Export from the File menu, and then choose MNL to MAX ASCII (.ASC). The MAX Netlist Binary Input dialog box displays.
3. Find and select the .MNL file you want to export to ASCII, then choose the Open button. The MAX ASCII dialog box displays.
4. Enter the filename and directory of the new ASCII file, then choose the Save button. Layout exports the .MNL file to ASCII.

To import an ASCII file as a Layout netlist file

1. Open the Layout session frame.
2. Choose Import from the File menu, then choose MAX ASCII to MNL. The MAX ASCII dialog box displays.
3. Find and select the ASCII file (.ASC) file you want to import to Layout, then choose the Open button. The MAX Netlist dialog box displays.
4. Enter the filename and directory of the new .MNL file, then choose the Save button. Layout creates the .MNL file.
MAX ASCII file format

You can create an ASCII netlist file (.ASC) from scratch and import it into Layout as a Layout netlist file (.MNL). The format for such files is shown below.

General format
MAX ASCII files use the following general format:

*MAX
*USER user-param
*INCH inch-param
*METRIC metric-param
*START
File data
Package and Symbol data
Component data
Net data
*END

User-param
Specifies the number of base units or microns equal to one user unit. The default value for this parameter is 60 (one user unit = 60).

Inch-param
Specifies the default granularity of the design, and is the base unit size used by the METRIC.TCH file. The default value for this parameter is 0.00001666666666666667.

Metric-param
Specifies use of metric units. If set to YES, Layout uses metric units. The default value for this parameter is NO.
File data format

File data provides information about the design file. These lines are not required. Layout generates these lines when you export an .MNL file to ASCII. File data uses the standard attribute data format.

Package and Symbol data

Package data provides pin information for each device. Symbol data match footprint pins with pins that appear in the netlist and pins that appear in the package.

Component data

Component data provides component information. One component is specified in a single line, with optional attribute lines immediately after.

Net data

Net data provides net information. A single net is specified on one or two lines, with optional attribute lines immediately after.
The following is an example of a Layout ASCII netlist file (.ASC):

```
*MAX*USER 60
*INCH 0.00001666666666666667
*METRIC NO*START*ATTR Key="SourceFile" "Count" 100 "Count" 1
"C:\ORCADWIN\CAPTURE\DESIGN\SDT\FIG_B-01.DSN" 813922584
*ATTR Key="SourceModeAttr" "Count" 100 "Count" 0
"C:\ORCADWIN\CAPTURE\DESIGN\SDT\FIG_B-01.DSN" 1*PACKAGE 1
"74LS00"
1 "A" "I0" 1 0 LOAD
2 "A" "I1" 1 0 LOAD
3 "A" "O" 1 0 SOURCE
4 "B" "I0" 1 0 LOAD
5 "B" "I1" 1 0 LOAD
6 "B" "O" 1 0 SOURCE
7 "C" "I0" 1 0 LOAD
8 "C" "I1" 1 0 LOAD
9 "C" "O" 1 0 SOURCE
10 "D" "I0" 1 0 LOAD
11 "D" "I1" 1 0 LOAD
12 "D" "O" 1 0 SOURCE*SYMBOL 1 "74LS00"
1 "1"
2 "2"
3 "3"
4 "4"
5 "5"
6 "6"
7 "9"
8 "10"
9 "8"
10 "12"
11 "13"
12 "11"*PACKAGE 2 "C:\ORCADWIN\CAPTURE\DESIGN\SDT\FIG_B-01.OLB/74LS00"
1 "A" "I0" 1 0 LOAD
```
Chapter 17 Importing and exporting files

2 "A" "11" 1 0 LOAD
3 "A" "O" 1 0 SOURCE
4 "B" "I0" 1 0 LOAD
5 "B" "11" 1 0 LOAD
6 "B" "O" 1 0 SOURCE
7 "C" "I0" 1 0 LOAD
8 "C" "11" 1 0 LOAD
9 "C" "O" 1 0 SOURCE
10 "D" "I0" 1 0 LOAD
11 "D" "11" 1 0 LOAD
12 "D" "O" 1 0 SOURCE*SYMBOL 2
"C:\ORCADWIN\CAPTURE\DESIGN\SDT\FIG_B-01.OLB/74LS00"
1 "1"
2 "2"
3 "3"
4 "4"
5 "5"
6 "6"
7 "9"
8 "10"
9 "8"
10 "12"
11 "13"
12 "11"*PACKAGE 3 "74LS32"
1 "A" "I0" 1 0 LOAD
2 "A" "11" 1 0 LOAD
3 "A" "O" 1 0 SOURCE
4 "B" "I0" 1 0 LOAD
5 "B" "11" 1 0 LOAD
6 "B" "O" 1 0 SOURCE
7 "C" "I0" 1 0 LOAD
8 "C" "11" 1 0 LOAD
9 "C" "O" 1 0 SOURCE

OrCAD Layout for Windows User's Guide
Chapter 17 Importing and exporting files

10 "D" "I0" 1 0 LOAD
11 "D" "I1" 1 0 LOAD
12 "D" "O" 1 0 SOURCE*SYMBOL 3 "74LS32"

1 "1"
2 "2"
3 "3"
4 "4"
5 "5"
6 "6"
7 "9"
8 "10"
9 "8"
10 "12"
11 "13"
12 "11"*COMP U1 "74LS00" Footprint="DIP14" MFootprint="" Package=1
*ATTR Key="GateUIDAttr" "Comp" 1 "IoErr" 1 "" 21
*ATTR Key="GateUIDAttr" "Comp" 1 "IoErr" 2 "" 27*COMP U2 "74LS32"
Footprint="DIP14" MFootprint="" Package=3*NET "OUT" NETLEV:65535
*NET "OUT" U2."3"*NET "B" NETLEV:65535
*NET "B" U1."4"*NET "N00040" NETLEV:65535
*NET "N00040" U2."1" U1."8"*NET "A" NETLEV:65535
*NET "A" U1."9" U1."10"*NET "Q" NETLEV:65535
*NET "Q" U1."1" U1."6" U2."2"*NET "VCC" NETLEV:65535
*NET "VCC" U1."14" U1."14" U2."14" U1."14"*NET "GND" NETLEV:65535
*NET "GND" U1."7" U1."7" U2."7" U1."7"*NET "N00036" NETLEV:65535
*NET "N00036" U1."3" U1."5"*NET "CLOCK" NETLEV:65535
*NET "CLOCK" U1."2"*END
Chapter 17  Importing and exporting files

**PCB II Netlist**

The PCB II netlist command translates a PCB II netlist file (.NET) into a Layout netlist file (.MNL).

**To translate a PCB II netlist into a Layout netlist**

1. In the Layout session frame, choose Import and PCB II Netlist from the File menu.
2. In the OrCAD netlist input file dialog box, select a PCB II netlist file (.NET) and choose the Open button.
3. In the MAX Netlist Output dialog box, enter a name for the Layout netlist with a .MNL extension and choose the Save button.
Futurenet Netlist

The Futurenet Netlist command translates a Futurenet netlist file (.NET) into a Layout netlist file (.MNL).

To translate a Futurenet netlist into a Layout netlist

1. In the Layout session frame, choose Import and Futurenet Netlist from the File menu.
2. In the Futurenet input file dialog box, select a Futurenet netlist file (.NET) and choose the Open button.
3. In the MAX Netlist dialog box, enter a name for the Layout netlist with a .MNL extension and choose the Save button.
4. When the dialog box appears displaying the message “Processing completed,” choose the OK button to dismiss it.
**PCAD Netlist**

The PCAD Netlist command translates a PCAD netlist file (.PDF) into a Layout netlist file (.MNL).

**To translate a PCAD netlist into a Layout netlist**

1. In the Layout session frame, choose Import and PCAD Netlist from the File menu.
2. In the PCAD PDIF dialog box, select a PCAD netlist file (.PDF) and choose the Open button.
3. In the MAX Netlist dialog box, enter a name for the Layout netlist with a .MNL extension and choose the Save button.
4. When the dialog box appears displaying the message “Processing completed,” choose the OK button to dismiss it.
Board translators

Layout translators support several printed circuit board formats including PCB 386+, Futurenet, PADS, PCAD, Protel, and Tango. The Import and Export commands are available on the File menu in the session frame. When using third-party CAD tools, you must also ensure that the layers map properly from one application to another.

Layer mapping

When translating boards between applications, you should make sure that the layers are mapped properly in the LAYOUT.INI file. The layer mapping assignments are kept in the LAYOUT.INI file, and are user-editable. LAYOUT.INI should be located in the WINDOWS directory. However, use caution when editing the LAYOUT.INI file. If you vary from the correct syntax or layer nicknames, you may have unpredictable results. There is no error checking for layer mapping, so you should check your board afterward, to make sure the layers mapped correctly.

There are mapping strategies for each CAD tool already in place in the LAYOUT.INI file. The strategies are based on the default layer structure specific for each tool. P-CAD, Protel, and Tango users will probably need only one copy of LAYOUT.INI, because the layers on those systems are named, and usually have a one-to-one correspondence to similar layer names in Layout. For instance, the TOP layer in Layout is usually named COMP in P-CAD, and TOP in Protel and Tango. The INNER1 and INNER2 layers in Layout are named INT1 and INT2 in P-CAD, and MID1 and MID2 in Protel and Tango. The BOTTOM layer in Layout is usually named SOLDER in P-CAD, and BOT in Protel and Tango.

CadStar and PADS users will probably need more than one copy of LAYOUT.INI, because the layers are numbered, and sometimes mean something different in every job. The TOP layer in Layout is usually LAYER1 in both CADSTAR and PADS, and the BOTTOM layer in Layout is usually LAYER16 in CADSTAR. However, the BOTTOM layer in Layout might be LAYER2, LAYER4, LAYER6, or LAYER8 in PADS, depending on the number of routing layers on the PADS board.

You do not have to be concerned about mapping the documentation layers in Layout, other than for reference, if you want to see the component outlines. However, you need to bear in mind that the documentation layers might also be on different numbered layers on different jobs, so you should adjust the LAYOUT.INI for these jobs accordingly.
Each layer mapping section within the LAYOUT.INI file is used as follows:

**[PCADXMAPPING]** Matches P-CAD layer names to Layout layer names. Used during import of a P-CAD design to Layout.

**[PCADBMAPPING]** Matches Layout layer names to P-CAD layer names. Used during export of a Layout design to P-CAD.

**[TANGOXMAPPING]** Matches Tango layer names to Layout layer names. Used during import of a Tango design to Layout.

**[TANGOBMAPPING]** Matches Layout layer names to Tango layer names. Used during export of a Layout design to Tango.

**[CADSTARXMAPPING]** Matches CADSTAR layer numbers to Layout layer names. Used during import of a CADSTAR design to Layout.

**[CADSTARBMAPPING]** Matches Layout layer names to CADSTAR layer numbers. Used during export of a Layout design to CADSTAR.

**[PROTELXMAPPING]** Matches Protel layer names to Layout layer names. Used during import of a Protel design to Layout.

**[PROTELBMAPPING]** Matches Layout layer names to Protel layer names. Used during export of a Layout design to Protel.

**[PADSXMAPPING]** Matches PADS layer names to Layout layer names. Used during import of a PADS design to Layout.

**[PADSBMAPPING]** Matches Layout layer names to PADS layer names. Used during export of a Layout design to PADS.

If you edit the LAYOUT.INI file to match your standard layer usage, and then keep it in the WINDOWS directory, it will apply to all of your designs. If you keep a local copy of the edited LAYOUT.INI in a separate job directory, the LAYOUT.INI in your local directory will be used for the designs in that directory.

**Tip** If you edit the LAYOUT.INI in the WINDOWS directory, you should also keep a copy of it under a different name (such as LAYOUT.USR), so that if you receive a new shipment of Layout with its new LAYOUT.INI, you will be able to "cut and paste" your naming conventions from LAYOUT.USR to the new LAYOUT.INI, thus saving you the effort of retyping them.
Layer mapping examples

[PCADXMAPPING]
COMP = TOP
SOLDER = BOT
INT1 = IN1...

[PCADBMAPPING]
TOP = COMP
BOT = SOLDER
IN1 = INT1...

[TANGOXMAPPING]
TOP = TOP
BOTTOM = BOT
POWER = PWR...

[TANGOBMAPPING]
TOP = TOP
BOT = BOTTOM
PWR = POWER...

Note  PCAD, CadStar, and PADS, you can specify copper layers using the keyword COPPER.
Chapter 17  Importing and exporting files

**MAX Interchange**

Layout can read an ASCII Layout board file (.MIN) and write a binary board file (.MAX). It can also read a Layout board file (.MAX) and write an ASCII Layout board file.

**To import a MAX Interchange file (.MIN) into a Layout board file (.MAX)**

1. Choose MAX Interchange from the Import menu in the session frame.
2. When the MAX Interchange Notation Input dialog box appears, select a file with a .MIN extension and choose the Open button.
3. When the MAX Board Output dialog box appears, enter a file name with a .MAX extension, and choose the Save button.
4. When the .MIN to MAX Extractor dialog box appears and displays the message, “Processing completed,” choose the OK button to dismiss the dialog box.

**To export a Layout board file (.MAX) to a MAX Interchange file (.MIN)**

1. Choose MAX Interchange from the Export menu in the session frame.
2. When the MAX Board Input dialog box appears, select a file with a .MAX extension and choose the Open button.
3. When the MAX Interchange Notation Output dialog box appears, enter a file name with a .MIN extension, and choose the Save button.
4. When the Options dialog appears, select the items that you want to include in the exported file and choose the OK button.
5. When the dialog box appears displaying the message, “Processing completed,” choose the OK button to dismiss the dialog box.

**Tip** If you suspect that your design file is corrupt, you can export the file to an ASCII board file, remove the incorrect data to fix the problem, and then read it back into Layout. The export process must be executed from the command line using the executable MAXMIN.EXE. Read it back into Layout using the process described in **To import a MAX Interchange file (.MIN) into a Layout board file (.MAX)** above.
PCB 386+

You can easily move a design or library between PCB 386+ to Layout. Layer mapping occurs automatically when using this translator.

In a translated library file, the module insertion point is set for use by pick-and-place machines, and the module angle is set to zero. The layer colors of the translated file will match those of the PCB 386+ library if the files 386LIB.SF and 386LIB.TCH are in the DATA directory, and are used to create the new library file.

To translate a PCB 386+ board

1. In the session frame, choose Import and PCB 386+ from the File menu.
2. In the PCB 386 to MAX Translator dialog box, enter the name and path of the existing PCB 386+ file, or use the Browse button to locate the file.
3. Enter the path and file name for the translated file or use the Browse button to point to the location.
4. If you want Layout to prompt you before overwriting an existing board file with the same name as the output file, ensure that there is no check in the Overwrite existing files check box.
5. Choose the Translate button.

To translate a PCB 386+ library

1. In the session frame, choose Import and PCB 386+ from the File menu.
2. In the PCB 386 to MAX Translator dialog box, enter the name and path of the existing PCB 386+ file, or use the Browse button to locate the file. If you use the Browse button, you may need to choose .MLB in the Use Files of Type drop list.
3. Enter the path and file name for the translated file or use the Browse button to point to the location. The extension of a Layout library file is .LLB.
4. If you want Layout to prompt you before overwriting an existing board file with the same name as the output file, ensure that there is no check in the Overwrite existing files check box.
5. Choose the Translate button. When the translator reads the .MLB extension, it prompts you to use the 386LIB.SF and 386LIB.TCH.
6. Choose the Yes button.

Note The files 386LIB.SF and 386LIB.TCH set up the appropriate colors for the library. For example, they make the component outlines more visible, and the drill drawing legend invisible. If you have special circumstances, you may want to load custom strategy files and technology templates.
You can translate a CadStar or a MAXI/PC file with a .CDI extension into an Layout board file with a .MAX extension. After placement and routing, you can export the Layout board file back out to a CadStar board.

Layout supports CadStar .CDI files up to v.7.0. CadStar users with v.8.0 or higher must output in v.7.0.

**To import a CadStar file into Layout**

1. In the CadStar or MAXI/PC software, save your file as an ASCII file with a .CDI extension.
2. In the Layout session frame, choose Import from the File menu, and select CadStar PCB from the ensuing list.
3. When the CadStar ASCII Input dialog box appears, select the file with the .CDI extension, then choose the Open button.
4. When the MAX Board Output dialog box appears, enter a filename with a .MAX extension, then choose the Save button.
5. When the Board Template File dialog box appears, select the DEFAULT.TCH file, then choose the Open button. DEFAULT.TCH is located in the DATA directory.
6. When the CadStar Extractor dialog box appears and displays the message "Processing completed," choose OK to dismiss the dialog box.

**To export a Layout board file back to CadStar**

1. In the Layout session frame, choose Export from the File menu, and select CadStar PCB from the ensuing list.
2. When the MAX Board dialog box appears, select the Layout board file (.MAX) that you want to export back to CadStar, then choose the Open button.
3. When the Original CadStar CDI dialog box appears, select the original CadStar file, then choose the Open button.
4. When the CadStar Routes dialog box appears, enter a name and select a destination for the output file (.ROU) and choose the Save button.
You can translate a PADS-PCB, a PADS-2000, or a PADS-PERFORM file with an .ASC extension into an OrCAD binary file with a .MAX extension.

**To import a PADS file into Layout**

1. In the PADS software, choose "Basic units" before you generate an output file.
2. In the PADS software, choose "All" from the ASCII output selection box.
3. In the PADS software, save your file as an ASCII file with an .ASC extension.
4. In the Layout session frame, choose Import from the File menu, then choose PADS PCB from the ensuing list.
5. When the PADS-PCB ASCII Input dialog box appears, select the file with the .ASC extension, then choose the Open button.
6. When the MAX Board dialog box appears, enter a filename with a .MAX extension, then choose the Save button.
7. When the Board Template File dialog box appears, select the PADS.TCH file, then choose the Open button. PADS.TCH is located in the DATA directory.
8. When the PADS-PCB Extractor dialog box appears and displays the message "Processing completed," choose OK to dismiss the dialog box.

**To export a Layout board file back to PADS**

1. In the Layout session frame, choose Export from the File menu, and select PADS PCB from the ensuing list.
2. When the MAX Board dialog box appears, select the Layout board file (.MAX) that you want to export back to PADS, then choose the Open button.
3. When the Original PADS-PCB ASCII file dialog box appears, select the original PADS file, then choose the Open button.
4. When the PADS-PCB ASCII Output dialog box appears, enter a name and select a destination for the output file (.ROU) and choose the Save button.
You can translate a PCAD file with a .PDF extension into an Layout binary file with a .MAX extension. To use this translator, you must have both an input .PDF file and an input .MDF file.

A .MDF file (such as GENERIC.MDF, which is supplied with Layout) defines the padstacks associated with each pin type in an input PDIF file. When Layout translates the PCAD file, it uses the aperture list to get the padstack information. If any pin or type definition was not included in the .PDF file, the program will attempt to get the padstack information from the .MDF file. You can create the .MDF file to specify the undefined pin type or definition.

**Note** OrCAD recommends using GENERIC.MDF.

### To import a PCAD file into Layout

1. In the PCAD software, load your padstack definitions into your design and output them with your PDIF file.
   
   Layout interprets this information and automatically creates the correct padstack definitions. If you are unable to load your definitions, you can use the GENERIC.MDF file's default, which is that any undefined padstack is 50 mils round.

2. When configuring PDIFOUT, answer Yes to the prompt "Scan and Tag Reserve Characters?"

3. When configuring PDIFOUT, answer No to the prompt "Include Pin Numbers in Sub-Component Section?"

4. When configuring PDIFOUT, answer Compressed to the prompt "Compressed or indented format".

5. When configuring PDIFOUT, save your file as an ASCII file with a .PDF extension.

6. In the Layout session frame, choose Import from the File menu, then choose PCAD PCB from the ensuing list.

7. When the PCAD PDIF dialog box appears, select the file with the .PDF extension, then choose the Open button.

8. When the OrCAD Definitions File dialog box appears, select GENERIC.MDF or User-defined MDF, then choose the Open button.

9. When the MAX Board dialog box appears, enter a filename with a .MAX extension, then choose the Save button.

10. When the Board Template File dialog box appears, select the DEFAULT.TCH file, then choose the Open button. DEFAULT.TCH is located in the DATA directory.

11. When the dialog box appears displaying the message "Processing completed," choose OK to dismiss the dialog box.
To export a Layout board file back to PCAD

1 In the Layout session frame, choose Export from the File menu, and select PCAD PCB from the ensuing list.

2 When the MAX Board dialog box appears, select the Layout board file (.MAX) that you want to export back to PCAD, then choose the Open button.

3 When the Original PCAD PDIF dialog box appears, select the original PCAD file, then choose the Open button.

4 When the PCAD PDIF Output dialog box appears, enter a name and select a destination for the output file (.ROU) and choose the Save button.
Protei

You can translate a Protei Autotrax file or a Protei for Windows file with a .PCB extension into an OrCAD binary file with a .MAX extension.

To import a Protei board into Layout

1. In the Protei for Windows software, save your file as an ASCII file with a .PCB extension.
2. In the Layout session frame, choose Import from the File menu, then choose Protei PCB from the ensuing list.
3. When the Protei PCB dialog box appears, select the file with the .PCB extension, then choose the Open button.
4. When the MAX Board dialog box appears, enter a filename with a .MAX extension, then choose the Save button.
5. When the Board Template File dialog box appears, select the PROTEL.TCH file, then choose the Open button. PROTEL.TCH is located in the DATA directory.
6. When the Protei Extractor dialog box appears and displays the message "Processing completed," choose OK to dismiss the dialog box.

To export a Layout board file back to Protei

1. In the Layout session frame, choose Export from the File menu, and select Protei PCB from the ensuing list.
2. When the MAX Board dialog box appears, select the Layout board file (.MAX) that you want to export back to Protei, then choose the Open button.
3. When the Original Protei dialog box appears, select the original Protei file, then choose the Open button.
4. When the Protei Output dialog box appears, enter a name and select a destination for the output file (.ROU) and choose the Save button.
You can translate a Tango Series II file or a Tango-PCB PLUS file with a .PCB extension into an OrCAD binary file with a .MAX extension.

To import a Tango board into Layout
1. In the Tango Series II or Tango-PCB PLUS software, save your file as an ASCII file with a .PCB extension.
2. In the Layout session frame, choose Import from the File menu, then choose Tango PCB from the ensuing list.
3. When the Tango Input PCB dialog box appears, select the file with the .PCB extension, then choose the Open button.
4. When the MAX Board dialog box appears, enter a filename with a .MAX extension, then choose the Save button.
5. When the Board Template File dialog box appears, select the DEFAULT.TCH file, then choose the Open button. DEFAULT.TCH is located in the DATA directory.
6. When the Tango Extractor dialog box appears and displays the message "Processing completed," choose OK to dismiss the dialog box.

To export a Layout board file back to Tango
1. In the Layout session frame, choose Export from the File menu, and select Tango PCB from the ensuing list.
2. When the MAX Board dialog box appears, select the Layout board file (.MAX) that you want to export back to Tango, then choose the Open button.
3. When the Original Tango File dialog box appears, select the original Tango file, then choose the Open button.
4. When the Tango Output dialog box appears, enter a name and select a destination for the output file (.ROU) and choose the Save button.
Chapter 17  Importing and exporting files

DXF import and export

Layout can translate files in and out of mechanical CAD (MCAD) systems, such as OrCAD Visual CADD and AutoCAD. The MAXDXF program was written to do three things:

- Translate a mechanical drawing in DXF format to Layout MAX format to define board outlines, component keep-out areas, component height restriction areas, and mounting holes.
- Translate a complex component definition in DXF format to Layout MAX format to define component outlines, net attributed obstacles (a track that takes the netname from the pin to which it is attached), copper obstacles (a custom pad shape or a component shield).
- Translate a Layout MAX file to DXF format to create customizable assembly drawings and customizable drill drawings.

Note  Since neither the copper pour nor thermal reliefs are included in the DXF output, the translated DXF should not be used to create artwork for your copper layers. It is possible for Layout to create DXF output which can be input to a CAD program to create copper layer artwork. This is accomplished in the Post Process Setup dialog box. For more information see Chapter 15: Post Processing.

MAXDXF.INI

You manage the MAXDXF process using the MAXDXF.INI file, which should be installed in the DATA subdirectory (where your DEFAULT.TCH technology template is located). The MAXDXF.INI file defines the layer setup and the actual mapping of text and obstacle layers during the translation.

The file can be edited with any ASCII editor. The software that parses the file will tolerate extra blank lines and extra spaces or tabs as long as you follow a few rules:

- Section names are enclosed in square brackets as in: [VERSION].
- One section or definition per line.
- An equal sign separates each definition into two pieces: A LAYOUT LAYER = AN MCAD LAYER.
- There are also lines defining system control variables as NAME OF VARIABLE = VALUE. These control variables may be repeated as often as needed. In theory, you could specify new control values before every layer.

The MAXDXF INI file itself contains comments introduced by a semicolon to document the system control variables.
Chapter 17  Importing and exporting files

The default MAXDXF.INI file is located in the DATA directory. This way, you can keep custom MAXDXF files in the directories that Layout looks in first, so that they will be used instead of the default. Layout searches for MAXDXF.INI in the following order:

- The current directory
- The directory in which MAXDXF.EXE is located
- The Windows directory
- The Layout DATA directory

**Expanded layer mapping**

When MAXDXF converts a Layout MAX file to DXF format, the 30 original layers in the MAX file explode to more than 100 layers in the DXF file. The MAXDXF.INI file specifies how Layout objects and layers are mapped to DXF layers to allow easy customization of the DXF.

For instance, if you translated a 30-layer board from Layout onto 30 AutoCAD layers, you could not easily create an assembly drawing showing component outlines, pads, the board outline, component reference, and component value, while omitting the tracks and vias. But, by splitting our objects across multiple layers, you can create a custom assembly drawing by turning the Layers on and off in AutoCAD.

Consider the following example. To create an assembly drawing for the TOP layer of a board, you would start by making all of your AutoCAD layers invisible. Then, you would make the TOP layer visible so you could see the pads, the TEXT_ASYTOP layer visible so you could see the component text, and the OBS_ASYTOP layer visible so that you could see the component outlines. Then, you could print or plot.

📖 See  For information on troubleshooting MAXDXF, see *Troubleshooting* in the Layout online help.

**To translate a DXF file into Layout**

1. Check the MAXDXF.INI file to ensure that the layer names used in MCAD map properly to the layer names used in Layout.
2. From the session frame File menu, choose Import and DXF to MAX.
3. Fill in the dialog with the names of your DXF file, technology file, and .INI file.
4. Choose the Translate button.
To translate a Layout board file (.MAX) into DXF

1. From the session frame File menu, choose Export and MAX to DXF.
2. Fill in the dialog with the names of your MAX file and .INI file.
3. Press the Translate button.

When all DXF entities are on the default layer 0

1. Create a MAXDXF.INI file which uses the AutoCAD layer 0 twice: once to translate all the polygons in the DXF file into obstacles and once to translate the circles into holes. For example:

   [OBSTACLE]
   TOP = 0

   [MECHANICAL]
   UNPLATED_MOUNTING_HOLES = 0

   The polygons will all be on the TOP layer along with one extra obstacle for each hole.

2. Select and then edit the obstacles in Layout to move them to the proper layer and change them to the appropriate Obstacle type: either board outline or keep-out.
To merge separate DXF files into a single Layout layer

1 Make a copy of your MAXDXF.INI file in the project directory under a different name. For example: copy MAXDXF.INI temp.

2 Edit the temporary file (in this example, "temp") and delete everything but the lines for the definitions and sections you need:

```
[MECHANICAL]
BOARD_OUTLINE = file1.dxf
COMP_KEEPOUT_ALL = file2.dxf
PLATED_MOUNTING_HOLES = file3.dxf
```

3 When MAXDXF prompts you for the name of the input DXF file, give it the temporary file name (in this case, "temp") instead. MAXDXF will read the three files listed in the example and translate them into the appropriate Layout objects within your output MAX file.

To import metric DXF files and create metric Layout board files from them

1 In your MAXDXF.INI file set the UNITS_DIVISOR to 25.4:

```
UNITS_DIVISOR=25.4
```

2 When you are prompted for a technology template, select a technology template which is in millimeters.

To interpret AutoCAD traces

1 Edit the [COPPER] section of your MAXDXF.INI file to include those layers that have AutoCAD traces you want to define as polygons.

2 Edit the [OBSTACLE] section of the file to include the layers that have AutoCAD traces you want to define as lines.

Note If a layer contains both polygon and line AutoCAD traces, you must reference that layer twice (in both the [COPPER] and [OBSTACLE] sections) and then delete the undesired objects from within Layout.
Understanding the files used with Layout

Appendix A: Understanding the files used with Layout describes the various files used with Layout, including board files, technology templates, and strategy files.
Understanding the files used with Layout

Layout uses a variety of files, some that you can modify, and some that store vital project resources. This chapter describes the files, including their contents, function, and how to access them.

**Note** .MAX, .TCH, and .LLB files use the same binary format. The different extensions reflect their different purposes.

**System files**

**LSESSION.INI** The LSESSION.INI manages access to other applications through the session frame. When you install Layout, you may have to edit the path in the LSESSION.INI to include the correct path to OrCAD Capture for Windows. LSESSION.INI is found in the Layout directory.

You can access LSESSION.INI by choosing Edit App Settings from the Tools menu in the session frame. The file opens in a text editor. Scroll to the bottom of the file, edit the paths to point to the directories where the applications are located (for example, C:\ORCADWIN\) and save and close the file. Then, choose Reload App Settings from the Tools menu. Layout immediately recognizes the paths without exiting Layout or rebooting.

**LAYOUT.INI** The LAYOUT.INI file contains vital information about Layout and your design. During installation, the LAYOUT.INI is placed in the Windows directory; a copy of the LAYOUT.INI file must be located in the Windows directory in order for OrCAD Capture for Windows to generate a netlist or perform forward annotation to Layout. It is recommended that you edit this file only if necessary. The LAYOUT.INI includes set up information for the following areas:

- User preference settings for the PCB translators
- The list of currently available libraries
- Properties that are passed from Capture to Layout
- Post processing
- Custom reports
- Default net colors by weight (priority for routing)
**SYSTEM.PRT**  SYSTEM.PRT is an ASCII file that contains information regarding the correspondence between part names (the electrical part description, such as 74LS00 or .01UF) and footprints (the physical description of the part, such as DIP14 or SM/CCHIP/0805). That is, the file acts as a back-up to map parts to footprints if they are not defined in the schematic.

Caution  You should not modify SYSTEM.PRT. Layout provides a customizable version of this file called USER.PRT.

**USER.PRT**  USER.PRT is a copy of the SYSTEM.PRT file that you can customize. The USER.PRT file is located in the LAYOUT\DATA directory.

USER.PRT is automatically updated during the ECO process. Each time an electrical part description is encountered and ECO is unable to match it to a footprint, ECO will prompt the user to enter a footprint name from the browser, once the footprint is selected, ECO enters the reference into USER.PRT.

Note  Capture does not allow you to create a netlist with a missing footprint.
Design files

**Board templates**

Board templates consist of a board outline and basic design rules. They are a foundation upon which to build a design. When starting a new design, you are asked to load a template as the first step in board creation. Layout's board templates offer 70 board outlines which are illustrated in the document *OrCAD Layout for Windows Footprint Libraries*. The board outlines use the same design rules as Layout's technology template DEFAULT.TCH which is described in the section *Technology templates* in this chapter.

**Tip** You can create custom templates. See *Creating custom templates* in Chapter 5: *Setting up the board*.

**Technology templates**

Technology templates enable designers to set design standards for their boards quickly and easily. It may be easiest to think of a technology template as a printed circuit board without physical objects or net information.

Technology templates can contain anything that can be defined and included in a board design, except the netlist. At the highest level, technology templates specify the manufacturing complexity of the design, and set the rule up for the component type used most predominantly on the board. In particular, technology templates can define the board layer structure, default grids, spacing, track widths, padstack descriptions, and default colors. A technology template can also include Gerber output settings.

Some objects on the board must be flagged as non-electric in a technology template, or they are deleted during Layout's AutoECO process. These include tooling holes or mounting holes, stiffeners, and mechanical parts, and any other parts on the board that are not defined in the schematic.

You can load a technology template at any time.
When you load a technology template into a design, the template replaces certain settings in the design, and ignores others. It replaces the following information:

- Placement strategy
- Routing strategy
- Number of defined layers, layer names, layer properties (such as spacing)
- Grids
- Padstacks

The following information is ignored when you load a new technology template:

- Colors
- Packages
- Symbols
- Components
- Nets
- Connections
- Obstacles
- Text
- Everything else is ignored
With a technology template, you establish the level of manufacturing complexity your design requires. There are three levels of manufacturing technology defined (per IPC-D-275). They provide three levels of set up, placement, and routing rules that reflect increased sophistication of tooling, materials, or processing, and ultimately cost.

**Level A (General Design Complexity. Preferred manufacturing.)**  This technology allows one track between standard DIP IC pins.

**Level B (Moderate Design Complexity. Standard manufacturing.)**  This technology allows two tracks between standard DIP IC pins.

**Level C (High Design Complexity. Reduced ease of manufacturing.)**  This technology allows three tracks between standard DIP IC pins.

The technology templates included with Layout are described below.

**1BET_ANY.TCH**  Based on Level A as described above, one track is allowed between standard DIP IC pins; a standard DIP IC pin has 62 mil pads and 38 mil drills; routing and via grids are 25 mils; placement grid is 100 mils; route spacing is 12 mils.

**2BET_THR.TCH**  Based on Level B as described above, 2BET_THR.TCH is used for through-hole boards; two tracks are allowed between standard DIP IC pins; a standard DIP IC pin has 54 mil pads and 34 mil drills; routing and via grids are 20 mils; placement grid is 100 mils; route spacing is 8 mils.

**2BET_SMT.TCH**  Based on Level B as described above, 2BET_SMT.TCH is used for surface-mount or mixed-technology boards; two tracks are allowed between standard DIP IC pins; a standard DIP IC pin has 54 mil pads and 34 mil drills; routing and via grids are 8½ mils; placement grid is 50 mils; route spacing is 8 mils.

**3BET_ANY.TCH**  Based on Level C as described above, 3BET_ANY.TCH uses standard DIP IC pin has 50 mil pads and 34 mil drills; routing and via grids are 12½ mils; placement grid is 50 mils; route spacing is 6 mils.

**CERAMIC.TCH**  Used to set up ceramic chip modules.

**DEFAULT.TCH**  Default technology template for typical designs. Also used for board translators. Based on Level A as described above, one track is allowed between standard DIP IC pins; a standard DIP IC pin has 62 mil pads and 38 mil drills; routing and via grids are 25 mils; placement grid is 100 mils; route spacing is 12 mils.

**HYBRID.TCH**  Used for hybrid chips.

**JUMP5535.TCH**  Single-layer boards, 55 mil vias with 35 mil drills.

**JUMP6035.TCH**  Single-layer boards, 60 mil vias with 35 mil drills.

**JUMP6238.TCH**  Single-layer boards, 62 mil vias with 38 mil drills.

**MCM.TCH**  Used for setting up multichip modules.

**METRIC.TCH**  Metric boards. If you are designing a board that is using metric units, you should start with the METRIC.TCH technology template to achieve the best precision.
**Netlist files**

MAX netlist files (.MNL) are Layout binary netlists created by the Import Netlist commands on the session frame’s Import menu or OrCAD Capture for Windows. They are used by AutoECO to create or modify printed circuit boards.

**MAX files**

.MAX files are Layout binary board files. The AutoECO process creates a .MAX file by combining the binary schematic netlist (.MNL) and the board or technology template (.TCH) you specify when you create a new design.
Strategy files

There are two types of strategy files in Layout: placement strategy files and routing strategy files.

Used for autoplacement, placement strategy files determine the placement of components based on different priorities, such as whether clusters are used, whether gates and pins are to be swapped, or whether you want the fastest placement.

Used for autorouting, routing strategy files determine which default routing layers to use, when to use vias, which direction tracks should travel, which colors to use for routes, and the size of the active routing window.

Predefined strategy files come with Layout for Windows. The files are optimized for specific types of boards based on the type of components on the board, the number of layers enabled for routing, and the preferred track direction on the top layer. When creating your own strategy file, it is easiest to modify one of the existing files.

If you attempt to load two strategy files, the old strategy file is automatically overwritten by the new one. For example, if you load a placement strategy file, and then when it is time to route the board, you load a routing strategy file, the routing strategy is recognized by Layout.

The routing strategy files provided with Layout are listed below. Note that the number of board layers given indicates the number of routing layers (not total layers) on a board.

See For information on placement strategy files and for a list of the placement strategy files included with Layout, see Chapter 2: Using autoplacement in the OrCAD Layout for Windows Autoplacement User's Guide.
STD.SF is the standard strategy file that is automatically loaded into each board design as it is translated into Layout's binary format. All other strategies are derived from this one. It exists as a separate file in the DATA directory and must be present in the directory in order to translate a board into Layout. You can also load this strategy file and use it with boards that were not translated.

The SM1 strategy files should only be used for multilayer surface-mount or mixed-technology boards with active components on the component side only. The SM2 strategy files should only be used for multilayer surface-mount or mixed-technology boards with active components on the component and solder sides.

- A 2, 4, 6, or 8 indicates the number of routing layers (not total layers) on a board.
- THR is for through-hole boards.
- SMD is for two-layer, single-sided, or double-sided surface mount, or mixed-technology boards.
- SM1 is for single-sided surface mount boards. Use these strategy files for multilayer SMT or mixed-technology boards with active components on the component side only.
- SM2 is for double-sided surface mount boards. Use these strategy files for multilayer SMT or mixed-technology boards with active components on the component and solder sides.
- An H indicates a horizontal primary direction of routing on layer one; a V indicates a vertical primary direction of routing on layer one.

Note: The strategy files included with Layout have been optimized to route typical surface-mount technology (SMT) or through-hole boards of two to eight routing layers. For boards with more than eight routing layers, modify an eight-layer strategy file, keeping the same pattern.

**2_SMD_H.SF** Used for a two-layer single-sided or double-sided surface-mount or mixed-technology board, with layer one horizontal.

**2_SMD_V.SF** Used for a two-layer single-sided or double-sided surface-mount or mixed-technology board, with layer one vertical.
Appendix A  Understanding the files used with Layout

2_THR_H.SF  Used for a two-layer through-hole board, with layer one horizontal.

2_THR_V.SF  Used for a two-layer through-hole board, with layer one vertical.

4_SM1_H.SF  Used for a four-layer single-sided surface-mount or mixed-technology board, with layer one horizontal.

4_SM1_V.SF  Used for a four-layer single-sided surface-mount or mixed-technology board, with layer one vertical.

4_SM2_H.SF  Used for a four-layer double-sided surface-mount or mixed-technology board, with layer one horizontal.

4_SM2_V.SF  Used for a four-layer double-sided surface-mount or mixed-technology board, with layer one vertical.

4_THR_H.SF  Used for a four-layer through-hole board, with layer one horizontal.

4_THR_V.SF  Used for a four-layer through-hole board, with layer one vertical.

6_SM1_H.SF  Used for a six-layer single-sided surface-mount or mixed-technology board, with layer one horizontal.

6_SM1_V.SF  Used for a six-layer single-sided surface-mount or mixed-technology board, with layer one vertical.

6_SM2_H.SF  Used for a six-layer double-sided surface-mount or mixed-technology board, with layer one horizontal.

6_SM2_V.SF  Used for a six-layer double-sided surface-mount or mixed-technology board, with layer one vertical.

6_THR_H.SF  Used for a six-layer through-hole board, with layer one horizontal.

6_THR_V.SF  Used for a six-layer through-hole board, with layer one vertical.

8_SM1_H.SF  Used for an eight-layer single-sided surface-mount or mixed-technology board, with layer one horizontal.

8_SM1_V.SF  Used for an eight-layer single-sided surface-mount or mixed-technology board, with layer one vertical.

8_SM2_H.SF  Used for an eight-layer double-sided surface-mount or mixed-technology board, with layer one horizontal.

8_SM2_V.SF  Used for an eight-layer double-sided surface-mount or mixed-technology board, with layer one vertical.

8_THR_H.SF  Used for an eight-layer through-hole board, with layer one horizontal.

8_THR_V.SF  Used for an eight-layer through-hole board, with layer one vertical.
Appendix A  Understanding the files used with Layout

**FAST_H.SF** Used for quickly checking on a particular placement, with layer one horizontal.

**FAST_V.SF** Used for quickly checking on a particular placement, with layer one vertical.

**JUMPER_H.SF** Used for boards with jumper layers, with layer one horizontal.

**JUMPER_V.SF** Used for boards with jumper layers, with layer one vertical.

**STD.SF** Used for the default routing strategy. It is automatically loaded into each board’s design if the board is translated into Layout’s binary format. You can also use this strategy file with boards that are not translated.

**VIARED_H.SF** Used for a via-reduce sweep on a completely routed board, with layer one horizontal.

**VIARED_V.SF** Used for a via-reduce sweep on a completely routed board, with layer one vertical.

📖 See For information on modifying the parameters set in strategy files, see Chapter 3: Using routing strategy files in the OrCAD Layout for Windows Autorouter User’s Guide.
Library files

Library files are Layout footprint libraries that contain the component templates that are used to design a printed circuit board. Layout provides over 3000 footprints in its libraries. You may also create new footprints and custom libraries. Library files are located in the LAYOUT\LIBRARY directory and have .LLB extensions.

See For information on using footprint libraries, see Part III: Libraries.

Report files

Layout generates two files that report Layout session information.

.LOG LAYOUT.LOG, also called the session log, keeps track of all session-related activity while in Layout. New session information is appended to previous session information, so you may want to delete LAYOUT.LOG occasionally, as the file becomes very large over time.

.LIS .LIS files are output error listings and activity lists. In the LIBRARY directory, these files list the footprints in each library.
active layer  In Layout, the design layer that is currently selected or visible on the screen. The active layer is the layer that appears in the toolbar’s layer drop-down list.

algorithm  A procedure for solving a problem, usually mathematical.

analog circuit  A circuit comprised mostly of discrete components (resistors, capacitors, transistors) that produces data represented by physical variables such as voltage, resistance, or rotation.

annular ring  A circular strip of conductive material that surrounds a hole on the printed circuit board.

ANSI  Acronym for American National Standards Institute, an organization formed by industry and the U.S. government to develop trade and communication standards. Internationally, ANSI is the American representative to the ISO (International Standards Organization). See also ASCII.

anti-copper  A zone that defines an area within a fill zone that is not to be filled with copper.

aperture  A hole, similar to the aperture of a camera, that is used for photoplotting. Apertures are available in various sizes and shapes.

aperture list  A text file containing the dimensions for each of the apertures used to photoplot printed circuit board artwork.

arc  A segment defined as an arc (one-quarter of a circle).

ASCII  Acronym for American Standard Code for Information Interchange; a seven-bit code—based on the first 128 characters of the ANSI character set—that assigns numeric values to letters of the alphabet, the ten decimal digits, punctuation marks, and other characters such as Backspace, Carriage Return, and Line Feed. ASCII is the most widely used character-coding set, and as such enables different applications and computers to exchange information. See also ANSI.

assembly drawing  A document that relates information pertaining to the manufacture of a printed circuit board. This information may include the board outline, component outlines and reference designators, part values, and other documentation.

attribute  See property.

autodimension  In Layout, a tool for automatically measuring and documenting the dimensions of your printed circuit board design. See also automatic dimensioning.

AutoDFM  Acronym for automatic design for manufacturability. When you execute AutoDFM, Layout checks the board to ensure that it meets manufacturability requirements.

AutoECO  Acronym for automatic engineering change order. Layout’s AutoECO command translates schematic netlist information from OrCAD Capture for Windows into Layout. See also forward annotation.

automatic component placement  Software that automatically optimizes component placement on a printed circuit board.
Glossary

**automatic dimensioning**  A computer-aided drafting function that automatically generates dimensions, leaders, arrowheads, and other similar items that make up a complete set of documented dimensions. *See also* autodimension.

**autorouting**  Automatic routing performed by a computer application based on a set of rules.

**axial leads**  Leads coming out the ends and along the axis of a resistor, capacitor, or other axial part, rather than out the side.

**back annotate**  In Layout, to transmit data, such as component renames and gate and pin swaps, back to the schematic. *See also* forward annotate.

**BGA**  Acronym for *Ball Grid Array*. Leadless array packaging technology in which solder balls are mounted to the underside of the package and are flowed for attachment to printed circuit boards.

**blind via**  A via that reaches only one surface layer on one side of a multilayered printed circuit board. *See also* via, buried via.

**block**  A specific portion of the design that is marked and manipulated as a single entity.

**board template**  A file that contains a board outline and some design rules. It may also contain drawing formats, dimensions, preplaced components, and tooling holes. *See also* technology template.

**bulletin board system**  A computer system used for electronically sending and receiving bulletins, messages, and files through modems. Abbreviated *BBS*.

**buried via**  A via that does not reach a surface layer on either side of a multilayered printed circuit board. That is, the via transcends only inner layers of the printed circuit board. *See also* via, blind via.

**CAD**  Acronym for *computer-aided design*. Software used for general or specialized design uses for architectural, mechanical, or electrical design.

**CAE**  Acronym for *computer-aided engineering*. Software for analyzing designs created on a computer or elsewhere and entered into the computer. Engineering analysis includes, but it not limited to, structural or electronic circuit analysis.

**CAM**  Acronym for *computer-aided manufacturing*. Software used in all development phases of an information system including analysis, design and programming.

**clusters**  A group of components that are interrelated. Components in a cluster are placed in close proximity on the board. This keeps the connections on the printed circuit board short so that the board is easier to work with.

**COB**  Acronym for *chip on board*. Component packaging technology in which bare integrated circuits are attached directly to the surface of a substrate and interconnected to the substrate most often by means of microscopic wires.

**component**  A set of primitives (tracks, pads, text) that comprise a single entity. Each component is identified with a unique reference designator on a printed circuit board. Printed circuit board assemblies consist of components affixed to a common surface and connected by copper tracks. *See* footprint.

**component density**  The quantity of components on a unit area of a printed circuit board.

**component hole**  A hole in the printed circuit board that corresponds to a pin or wire of a component. This hole serves the dual function of attaching the component to the board, and establishing the electrical connection between the pin or wire and the remainder of the board circuitry.
component library  A Layout file that contains the footprint patterns for a number of components.

component side  The surface layer of a board on which most components are placed. Component side is also referred to as the top side of the board. See also solder side.

connection  An unrouted, partially routed, or completely routed path between two pads. In a net with \( n \) pads, there are exactly \( n-1 \) connections.

copper zone  An area on a board designed to be covered with copper when the board is manufactured. Also known as a “metal zone.”

cross hatching  The breaking up of large conductive areas by the use of a pattern of lines and spaces in the conductive material.

cross probing  When intertool communication is enabled in Capture, selecting objects in Capture causes the corresponding objects to be highlighted in Layout. Also, selecting objects in Layout causes the corresponding objects to be highlighted in Capture. Both applications must be open. See also intertool communication.

current layer  See active layer.

datum  A specific location (a point) that serves as a reference to locate a printed circuit board pattern or layer for manufacture.

default  In Layout, a parameter whose value is preset by OrCAD.

density  On a printed circuit board, the degree to which components are packed on the board. Generally, the density is given as the number of square inches per equivalent IC; a lower number indicates a more dense board.

design rule  A guideline that specifies any of a number of parameters for the printed circuit board. These may include minimum clearance between items that belong to different nets, or connection rules. Also, these rules may include specifications for track width to carry a given current, maximum length for clock lines, termination requirements for signals with fast rise and fall times, and so on.

Design Rules Check (DRC)  A feature that checks the printed circuit board layout for violations of pad and track isolations.

design-rule checking  The use of an algorithm to perform continuity verification of all conductor routing in accordance with appropriate design rules.

DFM  Acronym for Design for Manufacture. See AutoDFM.

discrete components  Components with three or fewer electrical connections (for example, resistors, or capacitors).

dispersion  See fanout.

DRC  Acronym for design rules check. See Design Rules Check.

drill chart  A table that appears on the DRLDWG layer of the board showing the current counts, locations, and sizes of the holes to be drilled into the printed circuit board.

drill diameter  The actual size of the drill body.

DXF  A graphics format created by AutoCAD. This is an acronym for Drawing Interchange File.
Glossary

**E**

**ECL** Acronym for *Emitter-Coupled Logic*. A type of bipolar transistor that has extremely fast switching speeds.

**EDA** Acronym for *Electronic Design Automation*. Software and hardware tools used to ascertain the viability of an electronic design. These tools perform simulation, synthesis, verification, analysis, and testing of the design.

**EDIF** Acronym for *Electronic Design Interchange Format*. A standard published by the EIA (Electronic Industries Association) that defines the semantics and syntax for an interchange format that communicates electronic designs.

**EIC** Acronym for *Equivalent Integrated Circuit*. A standard method for determining the number of components on a board. The EIC is determined by taking the number of component pins on the printed circuit board and dividing by 16.

**electrical check** The process of checking the printed circuit board to ensure that the connections thereon match those specified in the netlist.

**Extended Gerber** See Gerber (274-X).

**fanout** The process of creating dispersion vias for SMT devices on your printed circuit board. The dispersion vias are connected to SMT devices by via stringers.

**feed-through hole** See via.

**fill zone** A zone that defines an area to be filled by copper. See also copper pour.

**footprint** The physical description of a component. It consists of three elements: padstacks (thrucodes), obstacles, and text.

**forward annotate** The process of sending netlist data in the form of an .MNL file from OrCAD Capture for Windows (or other schematic capture application) to Layout.

**FPGA** Acronym for *Field Programmable Gate Array*. A logic chip that is programmable and has a high density of gates.

**FTP** Acronym for *File Transfer Protocol*. A highly reliable file transfer protocol that is used almost exclusively over the internet. FTP should be used for both binary and ASCII transfers. However, data files should be transferred in binary format.

**gate swap** The exchange of identical gates in order to decrease route lengths.

**Gerber (274-D)** A file format that can be read by Gerber and other photoplotter systems that require separately or previously defined aperture lists.

**Gerber (274-X)** A file format that can be read by Gerber photoplotters that accept embedded aperture lists. Also known as *Extended Gerber*.

**Gerber data** A type of data that consists of aperture selection and operation commands and dimensions in X- and Y-coordinates. The data is generally used to direct a photoplotter in generating photoplotted artwork.

**Gerber photoplotting** A method of transferring printed circuit board design information to film.

**Gerber table** The Gerber table is the plot area that will be output to Gerber. This area may include the board and peripheral items such as the drill chart or comments.

**global layer** When you load a netlist file, Layout places all connections in the netlist on a global layer.
grid  In Layout, all design elements are placed on the board according to five grids: routing, via, dot, place, and detail. A grid is a set of orthogonal lines that define areas of the board and facilitate component and routing feature placement.

ground plane An area on the printed circuit board, usually an entire layer, that provides a common ground connection for all component ground pins and other ground connections.

heatsink A mechanical device that is made of a high thermal-conductivity material that dissipates heat generated by a component or assembly.

heuristics A method of routing that consists of repeatedly attempting to apply very simple routing patterns to unrouted connections in order to complete the routing quickly and cleanly. Typically, heuristics are used for memory and short point-to-point routing.

highlight Graphical emphasis that is given to text, components, or other objects when they are selected for an action.

hole legend See drill chart.

HP-GL Acronym for Hewlett-Packard Graphics Language, which is a plotter protocol developed by Hewlett-Packard.

HP-GL2 An extension of HP-GL that supports polygon fills, wide lines, and other methods of plotting complex shapes.

IGES Acronym for initial graphic exchange specification, which is a graphics format for transferring CAD/CAM information.

interactive routing Routing in which individual connections are entered into the database manually by the user with the aid of information such as ratsnests, DRC rules, or DFM rules.

intertool communication A capability that allows OrCAD EDA tools to share information for display and transfer.

isolation The clearance around a pad, track, zone, or via that defines the nearest approach allowed by conductors of another signal set.

IPC Acronym for Institute for Interconnecting and Packaging Electronic Circuits. An association in the printed circuit board industry that provides standards to enhance commonality of designs.

ITC Acronym for intertool communication. See intertool communication. See also cross probing.

jumper wire A discrete electrical component or wire that is used to make electrical connections between points for which copper etch does not exist due to board density or some other factor.

keep-out An area fill within which no routing is allowed.
land  In Layout, the copper pad needed for a surface mount pin.

layer  One in a series of levels in a printed circuit board design on which tracks are arranged to connect components. Vias connect tracks and zones between layers. Layout allows a maximum of 30 layers, 16 of which can be copper.

layer marker  An object on a board layer that indicates the layer’s physical number as counted from the top layer. Used for copper layers only.

layout  A scale drawing of a printed circuit board, its components, and its electromechanical connections.

LCC  Acronym for Leaded Chip Carrier. A chip carrier that is square and contains pin connectors on all four sides. Implementations include the PLCC (plastic LCC) and CLCC (ceramic LCC).

library  In Layout, a collection of footprints or templates designed to facilitate printed circuit board design creation.

MNL  Acronym for MAX netlist. This is the netlist format that is accepted by Layout.

mounting hole  A hole used for the mechanical attachment of components to a printed board.

multilayer board  A printed circuit board that has multiple layers, separated by dielectric material, with connectivity between layers established by vias or through-holes. This term usually refers to a board with more than two layers.

net  A logical construct that originates in a schematic and is transferred to a board to describe required electrical connections. The connections may be completed using vias, tracks, or zones. See also track.

netlist  A file that lists the interconnections of a schematic diagram by the names of the signals, modules, and pins to be connected together on a printed circuit board. The nodes in a circuit.

manual routing  Individual connections, in the form of vertices, arcs, etc., are entered manually into the printed circuit board design without the aid or requirement of information such as ratsnests.

matrix  In Layout, a tool that creates a structure on the board that can be divided into cells used for the efficient placement of footprints.

MCAD  Acronym for Mechanical Computer Aided Design. CAD software specific to mechanical engineering.

mixed component-mounting technology  A component-mounting technology that uses both through-hole and surface-mounting technologies on the same printed circuit board.
pad  On a printed circuit board, a copper etch shape on one or more layers (there may be a hole and an isolation surrounding the copper) used for connecting a component pin to the printed circuit board. The pad indicates where pins of a component are placed.

padstack  A numbered list of padstack or via stack descriptions. Each description contains a pad or via definition, including layer, style, drill diameter, size, offset, and solder mask guard width.

pan  In Layout, the screen automatically scrolls to display successive sections of the board when you move the mouse to the screen edge.

PCB  An acronym for printed circuit board.

PGA  Acronym for Pin Grid Array. A chip package with a high density of pins that is used for large amounts of I/O.

pin  The portion of a component to which an electrical connection can be made.

pin swap  The exchange of identical pins in order to decrease route lengths.

pin-to-pin spacing  The physical spacing between pins on a device.

placement  The position of components on a printed circuit board. The process of selecting where components will reside on a printed circuit board.

plane layer  A layer of copper that may have pads and holes that connect to it or pass through it. Typically used for the power and ground layers, CAD tools output the Gerber file for a plane layer in a negative form, meaning that the areas without copper are identified. Regular copper layers are output in positive form, meaning that the areas with copper are identified.

plated through-hole  A through-hole that establishes an electrical connection between layers of a printed circuit board by way of a metal deposition on the inner surface that defines the hole.

polar placement  The process of placing printed circuit board components using polar coordinates referenced from a user-define pole. Typically, this is used for test fixtures.

post processing  A term used to collectively describe the processes performed after the board has been routed in order to produce manufacturing information (silkscreens, reports, drill tapes, assembly drawings, and so on).

power plane  A copper layer usually dedicated to a single signal that is considered to be a power supply. The ground plane is a power plane that supplies the ground potential.

property  A characteristic of an object that can be edited. A property consists of a name and a value. Examples of property names are part value and color. Their respective property values can be something such as capacitor and red.

query  When you select an object on the screen, Layout displays the object properties for viewing or editing. You can use Layout’s query tool to inquire about object properties.

radial lead  A lead extending out the side of a component, rather than from the end.

ratsnest  A straight-line connection between two or more pads that indicates an electrical connection in the netlist. Ratsnests serve as a reminder that the pads must be connected, and that, currently, there is no track on the board to make that connection.

reference designator  A character string denoting the type of component and a number that is specific to that component.

registration  The alignment of a pad on one side of the printed circuit board (or layers of a multi-layer board) to its mating pad on the opposite side.
routing  Placing conductive interconnects between components on a printed circuit board layout. The process of turning nets into tracks.

scale  To enlarge or reduce a printed circuit board representation when printing or plotting.

schematic  A graphical description of an electrical circuit.

screen coordinates  The X and Y coordinates reporting the location of the cursor on the screen.

segment  The partial track that exists between two adjacent vertices or between a vertex and a pin. (Sometimes the track between two pins is called a segment, although it is usually called a connection.)

signal  An electrical impulse of a predetermined voltage, current, polarity, and pulse width.

silkscreen  Text or outlines (in ink) on the solder mask, on the top, and sometimes on the bottom of a board. Used for component identification and placement on a printed circuit board.

SMD  Acronym for surface mounted device. A component that is mounted on a surface layer of a printed circuit board, without penetrating the board. See also surface mount.

SMT  Acronym for surface mount technology. Printed circuit board technology in which the leads on the chips and components are soldered on top of the board as opposed to through it. The use of SMT results in smaller and faster printed circuit boards.

solder mask  A negative plot of pads with a guard band around the pads. Also, a lacquer applied to prevent solder from adhering to unwanted areas on the printed circuit board.

solder paste  In Layout, a pattern that serves as a template for solder paste application when the board is manufactured.

solder side  The printed circuit board surface opposite the one on which most components are mounted. Also, the bottom layer of the board.

strategy file  A file that contains either placement or routing parameters for a specific type of board with a specific layer structure.

surface mount  A component mounting technology in which holes are not required for pins.

technology template  A file that contains placement and routing strategies, specifies the number of layers (including their names and properties), and specifies the various grids, number of defined vias, and padstacks for the board.

test point  A special point of access to an electrical circuit that is used for electrical testing purposes.

thermal relief  A means of connecting a pad to a larger copper area while minimizing the amount of copper available to conduct heat during the soldering process.

thieving  The process of balancing the amount of copper on both sides of a board so that through-hole plating is consistent from top to bottom during board fabrication.

through-hole technology  The process and components associated with producing a printed circuit board that employs traditional through-hole components.

through-hole via  A via that connects the surface layers on a printed circuit board. See also via.

thrucode  See padstack.

tooling-hole  A tooling feature in the form of a hole in a printed board of fabrication panel.

trace  See track.
track  The copper trails in the printed circuit board and the onscreen representation of that copper.

venting patterns  Patterns etched in the board that allow gases formed during fabrication to escape.

vertex  A logical point at which a track is ended and restarted. A vertex is located at each change of direction on the track.

via  A hole connecting layers of a printed circuit board. A through-hole via connects surface layers of a board. On multilayer boards, a via not reaching a surface layer on one side is called a blind via, and a via not reaching a surface layer on either side is called a buried via.

via stack  An object that represents all of the via elements. A via stack definition. See also padstack.

via stringer  The copper etch that exists between an SMT pad and a corresponding fanout via. See also fanout.

X axis  The horizontal or left-to-right direction in a two-dimensional system of coordinates. (This axis is perpendicular to the Y axis.)

Y axis  The vertical or bottom-to-top direction in a two-dimensional system of coordinates.

zero-length connection  An unrouted connection between layers where the end points in the connection have the same X- and Y-coordinates. In Layout, these connections are flagged with yellow triangles.

zone  An area on a printed circuit board layer designated as copper or anti-copper. Copper zones may have net names, while anti-copper zones may not. See also copper pour.

zoom  To change the view of a window, making objects appear larger or smaller. When you zoom out, objects are smaller. When you zoom in, objects are larger.
absolute dimension 199
Add Color Rule dialog box 43
Add Component dialog box 52, 121
Allow component editing on board command 27
alternate footprints 119
Alternate Layer command 144
annotation
  back 232
  forward 227, 230
anti-copper obstacle 74
Apertures spreadsheet 32
apertures, editing 214
Arc command 82, 160
arcs, creating 82, 160
area selection 37
arrow keys xi
Assign Via per Net command 61
Auto Pan 40
Auto Path tool 27
Auto Select 36, 37, 40
AutoCAD 258-261
autodimension
  absolute 199
  deleting objects and text 200
  relative 199
Autodimension command 199
Autodimension Options dialog box 199
AutoECO 14
  options 227
  resolving errors 17
AutoECO command 227
AutoECO/Add Only command 227
AutoECO/Add Override command 227
AutoECO/DXF command 227
AutoECO/Net Attrs command 227
AutoECO/Override command 227
autorouting, SmartRoute 8

B
back annotation 232
BACKANNO.MAX file 232
batch output, generating 212
Board AutoCDE 167
Board AutoDFM 168
Board Design Check 163
board files 270
  Board AutoCDE 167
  Board AutoDFM 168
  Board Design Check 163
  Board Space Check 166
closing 21
creating 47, 48
opening 13-16
saving 20
translators
  CadStar 252
  MAX Interchange 250
  MAXDXF 258-261
  PADS 253
  PCAD 254
  PCB386+ 251
  Protel 256
  Tango 257
Window AutoCDE 167
Window Design Check 165
Window Space Check 166
board outlines 9, 13, 48, 74
  creating 51
  editing 51
  verifying before component placement 92
  verifying before routing 124
Board Space Check 166
board templates 13, 48, 267
  creating custom 49
  selecting 13
Browse Footprints dialog box 52, 120
Index

C

CadStar translator 252
Capture
  creating a Layout-supported netlist in 224, 226
  preparing your Capture design for use with 
  Layout 224
  properties for use with Layout 224, 225
Change Color command 138
Change Via command 142
Change Width command 141
circular placement 112, 113
Circular Placement dialog box 114
closing
  board files 21
  designs 21
Color spreadsheet 32, 41
color-coding nets 95
colors
  adding objects and layers to Color
  spreadsheet 43
  deleting objects and layers from Color
  spreadsheet 43
  determining object and layer visibility 42
  editing 42
  Initialize Color command 28
  nets 62, 138
  setting for display 41
commands
  Allow component editing on board 27
  Alternate Layer 144
  Arc 82, 160
  Assign Via per Net 61
  Autodimension 199
  AutoECO 227
  AutoECO/Add Only 227
  AutoECO/Add Override 227
  AutoECO/DXF 227
  AutoECO/Net Attrs 227
  AutoECO/Override 227
  Change Color 138
  Change Via 142
  Change Width 141
  Connection edit 146
  Database Spreadsheets 151
  Delete 29, 108
  Design Rules Check 27
  Disconnect Pin from Netlist 146
  DRC Box 127
  Drill Chart Properties 207
  Drill Tape 216
  Enable<->Disable 102
  Exchange ends 81, 144
  Exit 21
  Find 28
  Finish 51, 73
  Fix Comps 98
  Force Width by Layer 141
  Grids 55
  Help 26
  Initialize Color 28, 41
  Initialize Query 28, 33
  Insert 29, 108, 121, 140
  Insert Via 141
  Library Manager 24, 27
  Load Strategy 101, 128
  Load Template File 48
  Lock Comps 98
  Lock Track 144
  Matrix Place 110
  Mincon 107
  Mirror 81, 138
  Modify 29, 38, 78, 155, 158, 186, 191, 210
  Move Drill Chart 207, 208
  Move On/Off 108
  New 16, 26
  Open 16, 26
  Opposite 81, 109
  Preview 153, 203
  Reconnect Enabled 27
  Refresh Copper Pour 28, 162
  Remove Center Partial 139
  Remove Partial Track 139
  Remove Track 139
  Remove Unlocked Track 139
  Restore original colors 209
  Ripup Conn 139
  Ripup Net 139
  Ripup Segment 139
  Rotate 80, 109
  Run Batch 212
  Save 20
  Save As 20
  Segment 81, 140
  Select Any 106
  Select Criteria 103
  Select Next 105
  Setup Batch 201
Swap 108
Tack Conn 143
Text Editor 25
Thermal Reliefs 150
Undo 38
Units 54
Unlock Track 144
User Preferences 39
View whole board 28
Zoom In 28
Zoom Out 28, 51
Component Attachment dialog box 77
component group keep-ins 75, 100
component group keep-outs 75, 100
component height keep-ins 40, 75, 100
component height keep-outs 40, 75, 100
Component Selection Criteria dialog box 103, 106
Component tool 27, 52
component value, displaying on board 86
components
adding to design 121
attaching text to 88
ing 117.
fixed 118
group number 118
locked 118
mirroring 109
non-electric 118
placing 91-122
renaming 198
rotating 109
swapping 108
Components spreadsheet 17, 31
computer-aided design (CAD), Visual CADD 9
computer-aided manufacturing (CAM),
GerbTool 8
Connection edit command 146
connections, duplicate 137
Control key xi
coordinates (X,Y), viewing current 29
copper area obstacles 74
copper pour 157
anti-copper 157
attaching nets to 159
clearance 76, 158
copper area 157
creating 158
creating circular 160
Edit Obstacle dialog box 158
hatch pattern 76, 161
isolate all routes 158
obstacles 74
reducing redraw time 40
refreshing 162
rules 76
seed point 76, 157, 158
copying
components 108
obstacles 79
tracks 140
Create New Footprint dialog box 182
creating
board designs 47-70
board outlines 51
custom footprint libraries 179
custom templates 49
DRC Box 127
footprints 182
nets 145
obstacles 71, 72
padstacks 59
cross probing 233
Capture to Layout 234
Layout to Capture 235
Curve Route tool 136
custom footprint libraries, creating 179
custom properties, displaying on board 87
D
Database Spreadsheets command 151
Delete command 29, 108
deleting components 108
deselection 37
design flow, Layout 3-5
Design Rules Check command 27
Design Rules dialog box 164
design window 23
opening the library manager 176
designs
Board AutoCDE 167
Board AutoDFM 168
Board Design Check 163
Board Space Check 166
closing 21
creating 47, 48
opening 13-16
saving 20
Index

Window AutoCDE 167
Window Design Check 165
Window Space Check 166
detail grid 56
detail obstacles 75
dialog box
  Add Color Rule 43
  Add Component 52, 121
  Autodimension 199
  Browse Footprints 52, 120
  Circular Placement 114
  Component Attachment 77
  Component Selection Criteria 103, 106
  Create New Footprint 182
  Design Rules 164
  Display Units 54
  Drill Chart Properties 207
  Edit Aperture 214
  Edit Color 42
  Edit Component 17, 117
  Edit Footprint 155, 186
  Edit Layer 53
  Edit Net 63, 95, 130
  Edit Obstacle 51, 72, 74, 78, 124, 158
  Edit Pad 186, 190
  Edit Padstack 59, 60, 147, 151, 191, 192
  Edit Padstack Layer 156, 191
  Edit Spacing 57, 58
  Enabling Layers for Routing 130
  Generate Reports 217, 232
  Hatch pattern 76, 161
  Layers Enabled for Routing 66
  Link Footprint to Component 17, 18
  Load Netlist source 16
  Load Strategy File 101, 128
  Load Template File 16, 48
  Modify Connections 146
  Net Spacing By Layer 70
  Net Widths By Layer 67
  Open Board 16
  Post Process Setup 210
  Reconnection Type 68
  Rename Direction 198
  Save MAX Board 16
  Select Criteria 104
  Select Data Window 151
  Select Footprint 119
  System Grids 55, 56, 60, 94
  Text Edit 85, 86

Thermal Reliefs 150
User Preferences 39
Zoom Layer 79, 80, 152
dimensioning, in Layout 199
disabling nets for routing 102, 132
Disconnect Pin from Netlist command 146
Display Units dialog box 54
dot grid 56
Dot Matrix printer, output to 202
drafting, Visual CADD 9
drawing, Visual CADD 9
DRC see Design Rules Check command
DRC Box command 127
drill chart
  changing the size of 207
  moving 207, 208
Drill Chart Properties command 207
Drill Chart Properties dialog box 207
Drill Chart spreadsheet 32, 207
Drill Tape command 216
drill tape, generating 216
duplicate connections 137
DXF 202, 203
  import and export 258-261

E

Edit Aperture dialog box 214
Edit Color dialog box 42
Edit Component dialog box 17, 117
Edit Footprint dialog box 155, 186
Edit Layer dialog box 53
Edit Net dialog box 63, 95, 130
Edit Obstacle dialog box 51, 72, 74, 78, 124
  using to create a copper pour obstacle 158
Edit Pad dialog box 186, 190
Edit Padstack dialog box 59, 60, 147, 151, 191, 192
Edit Padstack Layer dialog box 156, 191
Edit Spacing dialog box 57, 58
editing
  apertures 214
  board outlines 51
  colors 42
  components 117
  footprints 189
  net information 62, 63
  objects 38
  obstacles 71, 78
  padstacks 191, 192
pins 189
spreadsheet information 32
Enable<->Disable command 102
enabling
   layers for routing 66
   nets for routing 130
Enabling Layers for Routing dialog box 130
Error Markers spreadsheet 31
Error tool 27, 169
errors, querying 169
Escape key "x"
Exchange ends command 81, 144
Exit command
   design window 21
   session frame 21
exiting Layout 21
exporting 237-261
   board translators 247-261
   DXF 258-261

F
fast fill copper pour 40
files
   .LIS 275
   BACKANNO.MAX 232
   board (MAX) 13-16, 270
   board template (TPL) 13-16, 48, 267
   custom templates 49
   Layout 265-275
   LAYOUT.INI 265
   LAYOUT.LOG 25, 275
   library 275
   LSESSION.INI 265
   MAX 270
   MNL 270
   netlist (MNL) 13-16, 270
   strategy 271
   swap files 232
   SYSTEM.PRT 266
   TCH 267
   technology template (TCH) 13-16, 48, 267, 269
   TPL 267
   USER.PRT 266
Find command 28
Finish command 51, 73
Fix Comps commands
   overriding 99
   setting 98
footprint editor 24, 176
   creating new footprint in 182
footprint libraries 173
   custom 179
   managing 175
footprint name, displaying on board 87
footprints 174
   adding pins to 183
   adding to libraries 180
   alternate 119
   assigning padstacks to footprint pins 185
   attaching obstacles to 187
   attaching text to 88, 89
   copying between libraries 180
   creating 182
   creating a custom library 179
   creating obstacles for 187
   deleting from libraries 180
   editing footprint pins 189
   labeling 188
   Link Footprint to Component dialog box 17, 18
   missing 17
   selecting 120
   setting grids for 181
   viewing in the library manager 178
Footprints spreadsheet 31, 155
Force Width by Layer command 141
forced thermal reliefs 154, 155
forward annotation 227, 230
free text, displaying on board 86
free track obstacles 74
Futurenet netlist 245

G
gates, checking before component placement 96
Generate Reports dialog box 217, 232
gerber 202, 203
   GerbTool 8
   preview 203
GerbTool 8
   OrCAD Layout for Windows GerbTool
      User’s Guide 8
GND
   enabling for routing 130
   routing 129
      on SMT boards 129
      on through-hole boards 129
   verifying connection to plane layer 131
Index

Grid command 55
griddless autorouting, SmartRoute 8
Griddless Route tool 135

grids
  detail 56
  dot 56
  options 56
  place 56
  routing 56
  setting 55, 56
  setting for footprint pins 181
  verifying routing grid before routing 125
  via 56
  viewing current setting in toolbar 29

Group option 65

Groups, placing components in 106

H

hatch pattern 76, 161
Hatch pattern dialog box 76, 161
Help command 26
help, online 30
Highlight option 64
highlighting nets 95
Hole Legend see Drill Chart
hollow pads 40
HP Laser, output to 202
HPGL output 202

I

importing 237-261
  board translators 247-261
  DXF 258-261
  netlist translators 238-246
Initialize Color command 28, 41
Initialize Query command 28, 33
Insert command 29, 108, 121, 140
Insert Via command 141
insertion origin
  centering 193
  moving 193
insertion outlines 75
  verifying before component placement 92
intertool communication
  enabling in Capture 233
  enabling in Layout 233
  in design flow 3, 5
  using 233
invisble, making layers 42
ITC see intertool communication

K

keep-ins 9, 75, 100
keep-outs 9, 75, 100
keyboard keys xi

L

labeling components 85
layers
  defining layer stack 53
  determining visibility 42
  drop list on toolbar 29
  editing 53
  enabling for routing 66
  library 94
  mapping 247
  mirror 94
  net spacing on 70
  placing text on 88
  preview for post processing 203
  setting net widths on 67
Layers Enabled for Routing dialog box 66
Layers spreadsheet 31, 53, 94
layers, zoom 152
Layout
  exiting 21
  features 6
  files used by 265-275
  product family 6
  session frame 11
  starting 11
Layout Limited, features 6
Layout Plus, features 6
LAYOUT.INI file 265
LAYOUT.LOG file 25, 275
Learning Layout 30
libraries
  adding footprints 180
  copying footprints to 180
  custom 173, 179
  deleting footprints from 180
  files 275
  library manager 173
  making available to Layout 177
  making unavailable to Layout 177
  managing 175
library layers 94
library manager 24, 173, 175-180
  creating a custom library 179
  footprint editor 176
  starting 176
  viewing footprints 178
Library Manager command 24, 27
  lines, setting preferences for 40
Link Footprint to Component dialog box 17, 18
Load Netlist Source dialog box 16
Load Strategy command 101, 128
Load Strategy File dialog box 101, 128
Load Template File command 48
Load Template File dialog box 16, 48
loading
  placement strategy file 101
  routing strategy file 128
  technology template 48
Lock Comps commands
  overriding 98
  setting 98
Lock Track command 144
locked components, overriding 98
LSESSION.INI file 265

M
manual fanout of SMDs 129, 131
Manual Route tool 28, 133, 134
  determining behavior 39, 40, 134
Manual Route with Shove tool 28
manual routing 141
  changing layers during routing 144
  changing the widths of tracks 141
  changing via types 142
  copying tracks 140
  creating duplicate connections 137
  Curve Route tool 136
  Exchange Ends command 144
  Gridded Manual Route without Shove tool 133
  Gridless Route tool 135
  inserting via types 141
  locking tracks 144
  Mincon command 138
  mincon mode 40, 134
  moving segments on tracks 140
  Remove Center Partial command 139
  Remove Partial Track command 139
  Remove Track command 139
  Remove Unlocked Track command 139
reroute mode 39
Ripup Conn command 139
Ripup Net command 139
Ripup Segment command 139
segment mode 40
Tack Conn command 143
vertex mode 39
manufacturability
  ensuring 163
  GerbTool 8
mapping layers 247
matrices, using 110, 111
Matrix Place command 110
MAX ASCII netlist 238
  example 240
  file format 239
MAX files 270
MAX Interchange 250
Max Width option 65
MAXDXF 258-261
measurement, units of 54
Min Width option 65
Mincon command 107, 138
mincon mode 40, 134
minimizing connections 107
Mirror command 81
mirror layers 94
MNL files 270
  creating in Capture for use with Layout 224, 226
Modify command 29, 38, 78, 155, 158, 186, 191, 210
Modify Connections dialog box 146
Modify/Create Nets tool 27, 145
mounting holes
  adding to board 52
  disappearing during AutoECO 17
Move Drill Chart command 207, 208
Move On/Off command 108
moving
  components 108
  DRC Box 127
  drill chart 207, 208
  obstacles 80
  obstacles to other layers 80
text 89
Index

N
net attributes, setting 62, 63
Net Spacing By Layer dialog box 70
Net Widths By Layer dialog box 67
netlists 13, 226, 270
  contents 14
  part numbers do not match pad names in Layout 17
preparing in Capture for use in Layout 224
translators
  Futurenet 245
  MAX ASCII 238
  PCAD 246
  PCB II 244
nets
  adding test points 147
  assigning vias to 61
  attaching to copper pour 159
  attaching to obstacles 76
  changing the color of 138
  color-coding 95
  colors 62
  connection order 62
  creating 145
  disabling 102, 130, 132
  disconnecting pins from 146
  enabling 62, 130
  highlighting 95
  priority for routing 62
  properties in routing 62
  properties in Capture for use with Layout 225
  spacing by layer 70
  splitting 145
  verifying connection to plane layer 131
  weighting 95
  width by layer 67
  widths 62
Nets spreadsheet 31, 61, 62, 63, 95, 102, 130
New command 16, 26
no via obstacles 75
non-electrical components 17

O
Obstacle tool 27, 51, 72, 158
obstacles
  anti-copper 74
  attaching nets to 76
  attaching to component 76
  attaching to footprint 187
  attaching to pin 76, 187
  board outlines 51, 74
  circular 82, 160
  component group keep-ins 75, 100
  component group keep-outs 75, 100
  component height keep-ins 75, 100
  component height keep-outs 75, 100
  copper area 74
  copper pour 74
  copying 79
  copying to other layers 79
  creating 71, 72
  creating for footprints 187
  deleting 83
  detail 75
  Edit Obstacle dialog box 74
  editing 71, 78
  exchanging the ends of 81
  free track 74
  insertion outline 75
  moving 80
  moving segments 81
  no via 75
  place outline 75
  reflecting 81
  rotating 80
  route keep-outs 75
  selecting 78
Obstacles spreadsheet 31, 93
online help 30
online tutorial 30
opaque graphics 40
Open Board dialog box 16
Open command 16, 26
opening
  board files 13-16
  designs 13-16
Opposite command 81, 109
OrCAD Layout for Windows GerbTool User’s Guide 8
OrCAD Layout for Windows SmartRoute User’s Guide 8
OrCAD Layout for Windows Visual CADD
User's Guide 9

outlines
- board 51
- insertion 75
- place 75

output
- batch 212
- specifying target device 202

P

package name, displaying on board 87
Packages spreadsheet 31, 96
pads
- hollow 40
- solid 40
PADS translator 253
padstacks
- assigning to footprint pins 185, 186
- changing the drill size 191
- creating 59
- editing 191, 192
Padstacks spreadsheet 59, 147, 151, 156, 191
painting, setting preferences for 40
parts, properties in Capture for use with Layout 224
PCAD
- board translator 246, 254
- netlist translator 246
PCB II netlist 244
PCB386+ translator 251
Pin tool 27, 183, 186
pins
- adding and deleting 146
- adding to footprints 183
- assigning padstacks to 185, 186
- attaching obstacles to 187
- checking before component placement 96
- disconnecting from nets 146
- editing 189
Place Design Check 122
place grid 56, 94
place outlines 75
- verifying before component placement 92
placing components 91-122
- description 4
- grid 56
- in a matrix 110
- in design flow 3

in groups 106
manually 101
minimizing connections 107
on a round board 112, 113
one at a time 103, 104
preparing the board for 92
preparing pre-placed components on board 98
selecting the next component for placement 105
using circular placement 112, 113
plane layers 149
- verifying connection of nets to plane layers 131
plotting 215
- specifying target device 202
polar placement, using 112, 113
pop-up menus
- accessing 35
- description 35
Post Proc see Post Processing
Post Process Setup dialog box 210
Post Process spreadsheet 32, 197, 201
- previewing thermals using 153
post processing 153, 197
- accessing commands 28
- adding and deleting files to output 213
- editing apertures 214
- in design flow 3, 5
- preview 203

POWER
- enabling for routing 130
- routing 129
- on SMT boards 129
- on through-hole boards 129
- verifying connection to plane layer 131
pre-placed components, securing on board 98
preferences, setting user 39
- graphics 40
- lines 40
- manual route behavior 39
- object selection 40
- pads 40
- painting 40
- panning 40
- reducing redraw time for tracks 40
- reducing the redraw time for copper pour 40
- saving preference settings 40
- toolbar 40
- preferred thermal reliefs 154, 155
Index

Preview command 153, 203
preview, post processing 203
   modifying output 210
   restoring original view 209
printing 215
ProteI translator 256

Q
Query window 33
Query, using with spreadsheets 34
querying flagged errors 169

R
ratsnest
   description of 128
   zero-length connection 128
Reconnect Enabled command 27
Reconnection Type dialog box 68
reference designator, displaying on board 86
Refresh Copper Pour command 28, 162
relative dimension 199
Remove Center Partial command 139
Remove Partial Track command 139
Remove Track command 139
Remove Unlocked Track command 139
Rename Direction dialog box 198
renaming components 198
reports
   custom 217
   generating 217
reroute mode 39, 40
Restore original colors command 209
Retry Enabled option 63
Ripup Conn command 139
Ripup Net command 139
Ripup Segment command 139
Rotate command 80, 109
round board, placing components on 112, 113
route keep-outs 75
Route Spacing spreadsheet 57
routing 123-148
   changing layers during routing 144
   changing the widths of tracks 141
   changing via types 142
   copying tracks 140
   creating duplicate connections 137
description 4
   Exchange Ends command 144
   forcing a net width on a layer 141
   grid 56, 126
   in design flow 3
   insert via types 141
   locking tracks 144
   making vias available for 60
   manual 133-136
   Mincon command 138
   mincon mode 40, 134
   moving segments on tracks 140
   power and ground nets 129
      on a board with no plane layers 131
      on SMT boards 129
      on through-hole boards 129
   preparing the board 124
      Place Design Check 122
   process 123
   Remove Center Partial command 139
   Remove Partial Track command 139
   Remove Track command 139
   Remove Unlocked Track command 139
   reroute mode 39
   Ripup Conn command 139
   Ripup Net command 139
   Ripup Segment command 139
   segment mode 40
   statistics 148
   Tack Conn command 143
   unlocking tracks 144
   using Curve Route tool 136
   using Gridded Manual Route without Shove tool 133
   using Gridless Route tool 135
   vertex mode 39
Routing Enabled option 63
routing grid 56
Run Batch command 212
Run ECO to Layout 231

S
Save As command 20
Save command 20
Save MAX Board dialog box 16
saving
   board files 20
designs 20
schematics 4
netlists 13
Index

creating custom 49
 technology 13, 48, 267, 269
Test Point option 64
test points
 generating interactively 147
text
 as used in this manual xii
 character aspect 88
 character rotation 88
 Component Value 86
 creating 85
 Custom Properties 87
deleting 89
 editing 85
 Footprint Name 87
 Free 86
 labeling footprints 188
 location 88
 mirrored 88
 moving 89
 Package Name 87
 radius 88
 Reference Designator 86
 rotation 88
 size 88
 strings 86
 Text Edit dialog box 86
 width of text line 88
Text Edit dialog box 85, 86
 Text Editor command 25
text editors 25
 Text spreadsheet 31
 Text tool 27, 85, 89
 thermal reliefs 129, 149-156
 creating 149
 defining 150
 forced 154, 155
 large, assigning 151
 pads 149
 preferred 154, 155
 previewing 152-153
 rules that apply to creating 154
 using padstacks to create 156
 Thermal Reliefs command 150
 Thermal Reliefs dialog box 150
toolbars
design window
 Allow component editing on board command 27
Auto Path tool 27
 Component tool 27
 Delete command 29
 Design Rules Check command 27
 Error tool 27
 Find command 28
 Initialize Color command 28, 41
 Initialize Query command 28
 Insert command 29
 layer drop list 29
 Library Manager command 27
 Manual Route tool 28
 Manual Route with Shove tool 28
 Modify command 29
 Modify/Create Nets tool 27
 Obstacle tool 27
 Pin tool 27
 Post Processing 28, 153
 postage stamp viewer 29
 Reconnect Enabled command 27
 Refresh Copper Pour command 28
 Spreadsheets 28, 53
 Text tool 27
 View whole board command 28
 viewing grid setting 29
 viewing object coordinates 29
 Zoom In command 28
 Zoom Out command 28
 enabling or disabling tooltips 40
 session frame
 Help command 26
 New command 26
 Open command 26
 setting preferences for 39
tools
 Auto Path 27
 Component 27, 52
 Curve Route 136
 Error 27, 169
 Griddless Route 135
 Manual Route 28, 133, 134
 Manual Route with Shove 28
 Modify/Create Nets 27, 145
 Obstacle 27, 51, 72, 158
 Pin 27, 183, 186
 Text 27, 85, 89
tooltips 40
tracks
 copying 140
Index

reducing redraw time 40
routing manually 133-136
translators
board 247
  CadStar 252
  MAX Interchange 250
  MAXDXF 258-261
  PADS 253
  PCAD 254
  PCB386+ 251
  Proti 256
  Tango 257
netlist
  Futurenet 245
  MAX ASCII 238
  PCAD 246
  PCB II 244
tutorial, Layout online 30

U
Undo command 38
undoing actions 38
Units command 54
units of measurement 54
Unlock Track command 144
Use all via types option 60
User Preferences command 39
User Preferences dialog box 39
USER.PRT files 266

V
vertex mode 39, 40
via grid 56
vias 154
  assigning to nets 61
  making available for routing 60
  verifying before routing 125
View whole board command 28
visible, making layers 42
Visual CADD 258
  OrCAD Layout for Windows Visual CADD
    User’s Guide 9

W
Weight option 65
weighting nets 95
widths of nets 67

Window AutoCDE 167
Window Design Check 165
Window Space Check 166
windows
  design 23
  footprint editor 24
  library manager 24
  Query 33
  session log 25
  setting preferences for 40
  spreadsheets 31

Y
yellow triangles in ratsnest 128

Z
Zoom In command 28
Zoom Layer dialog box 79, 80, 152
Zoom Out command 28, 51
zoom, layers 152